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CCDciel is a free image capture software intended for the amateur astronomer.

CCDciel has all functionality required for advanced imaging of celestial objects including sequences for fully
automated unattended operation. But it is also easy to use to make simple capture in a manual way.

For devices connection it uses the INDI, Alpaca and ASCOM standards drivers. It can control the CCD/CMOS
camera, focuser, filter wheel, rotator and telescope mount and uses image resolving software such ASTAP for
accurate positioning. It can serve both the beginner astro photographer as the advanced who can take a nap
while the equipment is imaging.

You can use CCDciel on Windows, macOS or Linux.
To install the program, look a the installation instruction for your computer and download from SourceForge for
the platform you need, always get the latest version as it is frequently improved!
The program is still in beta version but it is now stable and run smoothly on every platform.
If you need to test the very latest code you can also install the nightly build.

A copy of the program documentation in pdf format is included with the program.

You can ask the user group for any question about the software usage.

In any case I will appreciate your help for testing this software and reporting any bug or other problem you may
encounter.

The source code is available from GitHub

Contact

http://www.indilib.org/
https://www.ascom-alpaca.org//
http://ascom-standards.org/
http://sourceforge.net/projects/ccdciel/files/
https://vega.ap-i.net/pub/ccdciel/daily_build
https://www.ap-i.net/ccdciel/_detail/en/ccdciel.png?id=en%3Astart
https://groups.io/g/ccdciel
https://www.ap-i.net/mantis/set_project.php?project_id=3
https://github.com/pchev/ccdciel
https://www.ap-i.net/ccdciel/en/contact
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CCDciel features

Supported devices

Any ASCOM, Alpaca or INDI camera, filter wheel, focuser, rotator, telescope mount, dome, switch,
weather station, observing condition device, safety monitor
ASCOM driver can be a classic local driver or a remote Alpaca device
ASCOM Alpaca devices can be used on Linux and macOS
Device connection can be a mix of local and remote devices using different protocols
NO native support for any device

Program features

Easy to use configurable interface
Translated in your language
Separate settings for preview and capture
Can start a quick capture without the need to parameter a full sequence
Quick and easy polar alignment procedure
Collimation aid
Parameters for saved files include options for the capture folder name and the file name
Improve the preview image display with predefined histogram truncation and gamma
Predefined zoom level or free zoom with the mouse wheel
Add bull eye to the preview image
Show saturation on the preview image
Image magnifier at mouse position
Debayer the preview for color sensors
Can stack preview images with single star alignment and dark subtraction
Show a reference image on screen to help to manually recenter a frame
Can set a bad pixel map to remove hot pixel in auto-focus and plate-solving preview images
Select subframe with the mouse
Camera temperature control
Select camera readout mode depending on the frame use.
Automatic sky flat
Automatic panel flat
Choose from 4 different auto-focus method the one that best work with your equipment
Can auto-focus with field stars or by slewing to a bright star
Support for filter offset and exposure factor
Focuser temperature compensation
Options for periodic refocusing during capture
Automatic meridian flip with many options
Connection to multiple switch devices
Show selected star profile with HFD and FWHM
Image inspector show stars HFD, sensor tilt and field curvature
Simple photometry measurement
Message log with severity filter
Video control and recording with supported INDI camera, including DSLR LiveView
Powerful scripting function using Python or Pascal language
Custom image type with activation by script
Run automated action if the conditions are not safe.
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Plate solving

Automatic precision Goto using plate-solving
Precision Goto can Sync the mount or use a local offset
Can use a separate finder camera if the main camera is not suitable
Automatically recenter a target that drift during a sequence.
Slew to any point of solved image
Rotator calibration and rotation from plate-solving
Plot DSO in solved images
Arrow show North direction, or mark the position of the Pole if in the image frame.
Show solved image in planetarium
Show solved image frame in planetarium

Auto-guiding

Use of internal guider or connection to external software
Automatically manage the guiding start/stop/pause during the different operations
Options for automatic auto-guider dithering
Backlash compensation
Specific options for spectrograph
Show guiding graph and statistics
Recovery from auto-guiding problem

Automated sequences

Automated sequences with many sequential targets
Sequence contain a list of target and can indicate a start/stop time and repetition options
Target is defined by a name, coordinates, rotator angle, start/end time
Target coordinates can be set from the planetarium
Import mosaic from the planetarium.
Import Cartes du Ciel observing list.
A moving target can have it's coordinates updated from the planetarium at the time of the observation
Target option include plate-solving Goto, auto-focus position, skip or wait if the observing condition are
not reach
Use horizon profile for objects rise/set time
Every target use a predefined plan to not have to type everything again
Plan are multi-steps, with number and type of frame, exposure time, gain, binning, filter, auto-focus and
dither options
A target can also be a script or an automated sky flat at dusk or dawn
Restart an interrupted sequence at the last check point
Pause the sequence if the observing condition are not optimal
Get the program status in a web browser
Receive notifications by email

Interface with other software

Interface with four different local plate-solving software (Astrometry.net, Astap, Platesolve2, Elbrus)
Interface with two auto-guiding software (Phd2, Linguider)
Interface with two planetarium software (Cartes du Ciel, Hnsky)
Interface with any SAMP application (Aladin, Topcat, …)
Interface with processing software (Siril)
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Tutorial 1. The program screen

When you start the program you see the following screen:

On the top you have the standard menu: File, Edit, Tools, Image, Display, Help, and four menus with a icon:
Connect, Focus, Capture and Sequence. The four menus with icons are the same as on the right tabbed menus.

These four tabbed menus are used for connecting the equipment, focusing the camera, take a capture or run a
sequence of operation.

On the bottom left there is the visualisation control for the picture preview and on the right a text log with
activity messages.

The taken or loaded images will be displayed in the middle.
The plate solving functions are available from the image right click menu.

The layout is customizable under the Display menu for either a small monitor or laptop. You can uncheck the
Tools you not use, but this is done automatically to remove the tools for the devices not present in the current
profile. The minimal screen size is 1024×600
At the bottom of the menu is a selection to reset the default settings, using either one or two column layout.
You can drag and drop every tool to another part of the screen. Just hold left mouse button down and drag the
tool title to one of the screen border and drop it by releasing the mouse button.

https://www.ap-i.net/ccdciel/_detail/en/documentation/default_screen.png?id=en%3Adocumentation%3Athe_program_screen
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If you have a large monitor, you can make all the controls visible at the same time without using the tabs. You
can also adjust the width of the right panel with the mouse depending on your screen size.

Next tutorial >>

https://www.ap-i.net/ccdciel/_detail/en/documentation/all_control.jpg?id=en%3Adocumentation%3Athe_program_screen
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Tutorial 2. Connecting the equipment

When you are a first time user, you have to select first the correct equipment drivers and set some settings.
The first time it is run the program will automatically open the Edit→devices setup menu.

Create a new profile for your equipment.
All the devices and all the program options will be stored in this profile, allowing to have completely different
settings for your different equipment or locations.

The devices can be connected locally to your computer, or remotely via a INDI or ASCOM Alpaca. You can mix
devices using different protocol and managed by different server.

For INDI it is important the INDI server with all the driver is running before you can click the Get button to list
the available devices. You can use IndiStarter for that.

https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup1.png?id=en%3Adocumentation%3Aconnecting_the_equipment
https://sourceforge.net/projects/indistarter/
https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_indi.png?id=en%3Adocumentation%3Aconnecting_the_equipment
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For ASCOM it is important you install the ASCOM platform and every required driver before to start CCDCiel.
ASCOM can also be connected remotely from CCDciel running on Linux or macOS.

 

Be sure to select the mandatory camera driver and other equipment like mount or focuser but that can also be
done later.

Click okay and program will create a new default profile for your equipment. You could later create an additional
profile with different settings, equipment or location.

Next menu will show the default options. The first thing to do is to set the capture folder to something like like in
Linux to /home/username/capture which or for windows from the default C:\ to something like C:\CCDciel

When ready click the OK button.

Select the left tab (pointer icon) and locate the Connect button at the top. The red dot indicates no connection
to any device. Below the connect button you will see the mandatory camera, mount if selected and any other
equipment.

Click on Connect and after a few seconds the light should change to green if all listed equimpment is connected.

In the connection phase, the indication light will first turn orange and finally green if all equipment is
successfully connected. In case of a connection failure or if an error occurs, the indication light will turn red. All
program activities and errors will be logged, so in case of device connection problem have look to the log for an
error indication.

Devices with a connection problem could be disabled temporary in Edit→devices setup menu. As a bare
minimum only an imaging camera is required to operate.

Next tutorial >>

https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_ascom.png?id=en%3Adocumentation%3Aconnecting_the_equipment
https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_ascomremote.png?id=en%3Adocumentation%3Aconnecting_the_equipment
https://www.ap-i.net/ccdciel/_detail/en/documentation/connect1.png?id=en%3Adocumentation%3Aconnecting_the_equipment
https://www.ap-i.net/ccdciel/_detail/en/documentation/connect2.png?id=en%3Adocumentation%3Aconnecting_the_equipment
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Tutorial 3. Global configuration

You access the global configuration from the menu Edit→Preferences.

All this options will be stored in the current profile.

There are a number of options for every part of the program and many can be examined later.

 

To start it is essential you set:

a valid folder for the captured images.1.
be sure the temporary folder path contain only ASCII characters.2.
your observatory latitude and longitude since they are used in several program functions.3.
It is also important the right observatory coordinates are set in the mount.

Next tutorial >>

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref1.png?id=en%3Adocumentation%3Aglobal_configuration
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref2.png?id=en%3Adocumentation%3Aglobal_configuration
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Tutorial 4. Focusing

Manual focus

Point your telescope somewhere high in the sky and set the Preview exposure time and binning. Click on the
Loop button.

If you are way out of focus start first with a long 10-15 seconds exposure time to see some large out of focus
stars disk and move the focuser to reduce the size. If you near the correct focus reduce the exposure time to 1
seconds less.

Leave the preview looping and click on the Focus tab to show the focuser and star profile

Double click on a star in somewhere the middle of the captured image. Check the recorded star intensity for
saturation or have look to the star profile. The intensity value should be smaller then the sensor maximum value
of typically 65535. In case of saturation select a fainter star or reduce the exposure time. Checkmark the
“Manual focus aid” to magnify the star image.

Use the focuser buttons or manually adjust the focuser to make the star image as small and bright as possible.
It could be beneficial to use a very short exposure time to reduce the seeing and have a quick visual feedback.

When ready uncheck “Manual focus aid”.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_preview.png?id=en%3Adocumentation%3Afocusing
https://www.ap-i.net/ccdciel/_detail/en/documentation/focusing.png?id=en%3Adocumentation%3Afocusing
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Auto-focus

To configure the auto-focus use the Tools→focuser calibration wizard to help you set the different parameters
specific to your setup.

Later you can refine them in the auto-focus preferences.

Next tutorial >>

https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal1.png?id=en%3Adocumentation%3Afocusing
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Tutorial 5. Simple capture

Open the Capture tab and set the required options:

The exposure time
The binning
The name of the object
The number of exposures to take
Be sure the type is Light, other setting may let the shutter closed!

You can also choose to dither between exposures and to regularly adjust the auto-focus.

Dither introduces a small artificial cyclic drift typically required for CMOS sensors when imaging very faint
objects. It helps to smoothen out unequal sensitivity of the individual pixels. Leave his option off in the
beginning

Binning combines pixels if they are too small to record any details and reduces noise. Typically you set this on
1×1 or for large sensors on 2×2.

If you have a filter wheel you can specifiy the filter to use.

You can specify the frame dimensions if you don't want to use the full sensor surface.

If you have a rotator the green/red light indicate if it is calibrated or not. Then you can set the rotation angle.

And if you can control the CCD temperature enter the desired value in Setpoint, and click the Set button.

When all settings are correct click on the START button to start capturing.

The telescope box will indicate the telescope position, the park and tracking status and the remaining time to
reach the meridian.

https://www.ap-i.net/ccdciel/_detail/en/documentation/capture.png?id=en%3Adocumentation%3Asimple_capture
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The status bar shows the image number (count) in progress and the remaining exposure time

After each exposure is finished, the image is shown and the file is saved according the settings. A message in
the status bar indicates the last saved file

it will continue for the number of exposures (=count) set.

After finishing you could change the filter and start the next series. Or automate it fully using a sequence.

Next tutorial >>

https://www.ap-i.net/ccdciel/_detail/en/documentation/status_exp.png?id=en%3Adocumentation%3Asimple_capture
https://www.ap-i.net/ccdciel/_detail/en/documentation/status_save.png?id=en%3Adocumentation%3Asimple_capture
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Tutorial 6. Plate solving

Many function in CCDciel rely on plate solving so it is important this is correctly set.

If not already done install a plate solving software now.

Because we want the solving time to be just a few seconds we must help the solver software by giving the most
accurate information about the image to prevent a blind solving that can long for many minutes.
But wrong information is even worst, in most case it make the solving to fail.

The important points to check in the configuration are:

The camera pixel size in microns in the camera options. It is important to check the driver return the
correct size, if not you can override the value.
The telescope focal length in millimeter in the astrometry options. This must be the effective focal length
taking account for any corrector or focal reducer. Do not trust any label on the equipment, the best way
to get the real focal length is to do a blind plate solving, look at the result for “Pixel scale” and use the
formula:
Focal_Length = 206.265 * Pixel_Size / Pixel_Scale.
The telescope must return good enough coordinates to use as the starting point. The astrometry options
“Maximum search radius” must be large enough for any error in the initial position.

Then select the software to use and set any of it's specific options.

When all is ready take a preview image that show enough stars, right click and select Resolve.
Wait until it complete, in case of success it show a message with information about the image position and size.
The solved image is loaded in the viewer, an arrow indicate the direction of North and East and moving the
mouse over the image show the RA/DEC coordinates.

In case of error you can right click and select View last resolver log.
The content depend on the selected software, some are very verbose but with other you just get the command
line used by CCDciel.
This command line let you try the solve command in a terminal window out of CCDciel to check what is wrong.

When your images are reliably solved you can look at the next configuration tab, Slew. This set additional
options to automatically position the telescope with a given precision.

Next tutorial >>

http://nova.astrometry.net/
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Tutorial 7. Automated sequence

A sequence allows you to fully automate the imaging. At the sequence tab you can specify all the steps required
for unattended operation.
This sequence example will first image the objects M13 and M92, then wait for dawn to take some sky flat.

Attached to the M13 and M92 objects is the same LRGB-4H plan specifying 24 images using a luminance filter
(L), 8 images using a red filter (R) and finally 8 images using a blue filter (B). All images with an exposure of 300
seconds and the total duration of the plan is around 4 hours.

After that it wait for the dawn to take a series of sky flat.

When all is finished it can park the telescope and warm the camera or run other script to close the dome and
power off the observatory.

Running this sequence should keep the equipment unattended busy for around 8 hours.

The current implementation support only sequential processing of the targets, with options for repeating or
skipping some target.

To take full advantage of this automation you need to configure and test individually:

all the previous tutorial pages
the global sequence options
the camera options
the astrometry resolver for plate solving and the slewing options
the focuser and autofocus options and calibration

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_sequence.png?id=en%3Adocumentation%3Aautomated_sequence
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the rotator connection and calibration.
the autoguider connection and preferences
the planetarium connection to help to set the object coordinates
the automated meridian flip options
the flat automatic exposure options
the weather station options
the safety monitor options

And most important you must be sure your telescope mount and all the equipment include a way to
protect themselves against an unwanted operation. This include hardware slew and tracking limit
on the mount.

You can read more on how to edit a sequence in the specific sequence page.

Next tutorial >>
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Tutorial 8. Video tutorial

Han Kleijn prepared a set of video tutorial to show you the operation of the software.

The basic operation of the program (30 min):
https://youtu.be/Uq_Rb9AdjrA

Introduction to the program configuration (18 min):
https://youtu.be/13sZL0gY4zs

Polar alignment without seeing the celestial pole:
https://youtu.be/vfZd_FeJv5U

Introduction to sequences (30 min):
https://youtu.be/mKluORA3I1Q

Demonstration of automatic object selection (12 min):
https://www.youtube.com/watch?v=F-u_mOs27nw

Demonstration of preview live stacking (3 min):
https://www.youtube.com/watch?v=A2YZnAaxReY

Autofocus on the Moon:
https://youtu.be/8eWxTQTmYBk

Imaging of CTB1 supernova remnant using a sequence:
https://youtu.be/iImgJN6HWmA

Imaging of a comet using a sequence:
https://www.youtube.com/watch?v=7XQcfgbr0dg

Live session recording using CCDCiel, Skychart, PHD2 and INDI by Linux Astro:
https://youtu.be/rt1AiAucOFw

https://youtu.be/Uq_Rb9AdjrA
https://youtu.be/13sZL0gY4zs
https://youtu.be/vfZd_FeJv5U
https://youtu.be/mKluORA3I1Q
https://www.youtube.com/watch?v=F-u_mOs27nw
https://www.youtube.com/watch?v=A2YZnAaxReY
https://youtu.be/8eWxTQTmYBk
https://youtu.be/iImgJN6HWmA
https://www.youtube.com/watch?v=7XQcfgbr0dg
https://youtu.be/rt1AiAucOFw
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FAQ

Can you add support for my device?

With CCDciel you can use any device with a ASCOM, INDI or Alpaca driver.
The program is made to be totally independent of the device itself and only use the standard properties
published by this drivers. This ensure the developement I make using my devices will work with any device that
use a ASCOM or INDI driver.
As an application developer I cannot develop driver for every existing device because I not have the time and I
not own them to make any testing.
You must check before to buy if the device include the required ASCOM, INDI or Alpaca driver. This is the only
way you can ensure the device will work with any software.

I cannot connect my ASCOM device

Beware many ASCOM driver work only with 32bit application, even on Windows 64bit.
CCDciel must show an explicit message in this case, and the ASCOM Chooser can show an error with:
“System.BadImageFormatException”, “Incorrect format”.
The solution is to ask the device manufacturer for a 64bit or universal driver. In the mean time you can install
the 32bit version of CCDciel as a work around.

Can I change the gain for the camera?

You can set the gain and offset in CCDciel, in Preview, Capture and Sequence step.
But to avoid unwanted effect this setting is hidden by default, in this case the gain always remain what you set
in the driver. This is the recommended way to use the camera.
If you really want to set the gain in CCDciel you have to check “Manage the Gain and Offset if available” in the
camera preference.
Beware you must be sure to configure the gain/offset to use for the different operation in the program. You must
also fully understand all the effect of this setting before to use it for other purpose than camera testing.

Are DSLR supported?

Yes CCDciel support DSLR using INDI or ASCOM driver.
For ASCOM see ASCOM.DSLR - ASCOM driver for dslr cameras (Canon, Nikon, Pentax, Sony)
For INDI, CCDciel support image type of FITS or native RAW or JPEG, you must set it in the INDI panel with all the
other option you need, then save the setting in the Option tab. Sure use JPEG only for preview.
See: Indi DSLR documentation
To reload this settings every time you connect the camera to CCDciel you have to check “Load configuration on
startup” for the INDI camera
In every case CCDciel save the image file in FITS format to take advantage of the information stored in the
header. Most EXIF tags are recorded as FITS keywords.
To be able to change the ISO in CCDciel you have to unlock the Gain setting.
LiveView is supported by the Video tool.

Camera image is very slow to download from remote computer

This problem is typically encountered when the camera is connected by INDI to a Raspberry Pi and CCDciel run

https://www.cloudynights.com/topic/707662-ascomdslr-ascom-driver-for-dslr-cameras-canon-nikon-pentax-sony/
https://www.indilib.org/devices/cameras/gphoto.html


CCDciel documentation

24

on another computer. The same issue can be expected with Alpaca camera.
The network speed is the critical point in this case, specifically with big sensors. Remember a 20Mpx camera will
produce a 40MB FITS file to transfer over the network. And this network time is added to the “USB time” to
transfer the image from the camera to the RPi.
This is very critical when using a WiFi connection, in this case it can take about 8 seconds if the signal is very
good but can take up to 40 seconds if it fallback to 11Mbps, and even more if retries are necessary.
The best solution in this case is to replace the WiFi connection by a direct Ethernet cable between the RPi and
the computer, just configure a static IP address in the same range on both computer. No router is required so
this work fine even in the field.
With this cable you can expect a download time of 3-4 seconds for the same image.
If using a DSLR you can set the image type to native RAW, this make the data size two or three time smaller
than FITS.

How to change the telescope park position

This is normally not to the imaging application to do that, but if you not have another solution process as follow.
With INDI use the options in the “Site management” tab to set this position.
With ASCOM create a script named for example setpark.js with notepad and add the following content after
replacing My.ASCOM.Telescope.Driver by the name of the driver for your telescope:

var driver = "My.ASCOM.Telescope.Driver";
var telescope = new ActiveXObject(driver);
telescope.SetPark();

Orient the telescope at the desired position and double click to run this script. After that a Park command will
return to this position. You only need to do it once and it changes the parking positions permanently.
If you want to run it from CCDciel create an internal script with the following content:

begin
  run('C:\Windows\System32\cscript.exe
C:\Users\username\Documents\scripts\setpark.js');
end.

The telescope do not slew at the coordinates I asked

The object coordinates set in the sequence must be ICRS/J2000 because this is the standard with current
catalog. This way the sequence is not dependent of the date, you can reuse the same sequence file next year or
in 10 years without problem.
But the real sky is not J2000, it is represented by the Local coordinate system that depend on the current date
because the Earth orientation change with the time and so the polar axis of the telescope mount.
The main difference between J2000 and the Local system are because of the precession, nutation and
aberration.
Most of the telescope use naturally the Local system so the program automatically convert the coordinates from
J2000 to Local to slew the telescope. This make the number for RA and Dec you see in the log to be different to
what you setup, but this ensure the telescope is finally pointed at the right position.

Plate solved slew do not converge

There is two possible case:

You set a too small value for the target precision that cannot be reached by your mount because of backlash,
flexion, or other mechanical problem.
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You use a pointing model using N stars alignment and the weight of the new point you sync near the target is
insufficient to influence the pointing result. When using plate solving it is best to disable this pointing model, or
at least make the new points to not be added to the model but used as an offset.

For Eqmod ASCOM:
In the Alignment/Sync box click the two button with a red cross “clear align data” and “clear sync data”.
For User Interface select “dialog based”, for Alignment Behavior select “nearest point”.

For Eqmod INDI:
In the Sync tab set “sync mode=standard sync” and click “clear sync delta”.
In the Align tab for “manage list” click “clear list” and set “alignment mode=nearest point”.

My device do not work with CCDciel

First read again the documentation from your device manufacturer and how to set the device configuration and
preferences in CCDciel.
Also be sure you installed the latest version for any required driver.

Many devices issues are because of bad cable or insufficient USB power. Be sure to test with a different cable,
with and without a powered USB-hub, and by connecting only this device to the computer.

We can never exclude a device failure, try with another software, on another computer. With INDI you can
exercise all the device functions with a simple INDI client.

Try the same operation in CCDciel with a simulator, this is the first thing to do to isolate the problem. Both
ASCOM and INDI have many simulator drivers for all kind of devices. If you can reproduce the error with the
simulator please open directly a new issue in the CCDciel bug tracker, otherwise see below.

If you think there is compatibility issue between the device and CCDciel do the following depending on the kind
of driver you use:

ASCOM driver:

Install the ASCOM conformance checker: https://ascom-standards.org/Downloads/DevTools.htm
Connect the device to the computer.
Start Conform from the Windows main menu under ASCOM Platform.
If your driver work only in 32bit, open the menu Options, Conformance options, and check “Run as 32bit
on 64bit OS”. It restart and you see “32bit mode” on the first line.
Open the menu Option and select the type of device you want to test (telescope, camera,…).
Open the menu Option, Select driver. Select in the list and click OK.
Open the menu File, Check conformance. Beware this will move/activate the device, be particularly
careful when testing the telescope or dome.
After it complete, right click in the text, Select All, Copy.
If the result show an error message you must contact the device manufacturer for a fix.
If there is no error, create a new issue in the CCDciel bug tracker, give a description of the issue, and past
the Conform result in the Additional information box, this report give me very important information
about your device.

INDI driver:

Connect the device to the computer.
Start the INDI server with the option -vvv, for example: indiserver -vvv indi_qhy_ccd
Start a INDI client GUI, click Connect for the device.
In a terminal type the command: indi_getprop
Launch CCDciel and repeat the failed operation.
Create a new issue in the CCDciel bug tracker, give a description of the issue, and past the indi_getprop

https://ascom-standards.org/About/ProblemSolving.htm
https://www.ap-i.net/mantis/set_project.php?project_id=3
https://ascom-standards.org/Downloads/DevTools.htm
https://www.ap-i.net/mantis/set_project.php?project_id=3
https://www.ap-i.net/mantis/set_project.php?project_id=3


CCDciel documentation

26

result and the console log from the indiserver in the Additional information box.

I want to run CCDciel as administrator

You must not run this software or any other astronomy application with administrator right. CCDciel will refuse
to start if you try, this is to help new user to do it right from the start.
If you are currently running your astronomy software in administrator mode it is time to change because this is
totally useless and create many unwanted issues.
The important point is you run all your software with the same user. But running all with the standard user is
much simpler and better than running all in administrator!

I need black colors as I can see in some screenshot here

The program use the system theme color, so change them to a dark theme.
But there is some subtleties and you may need the following.

On Linux: Use a dark Qt theme, for example Breeze-dark. When using a GNOME desktop you need to use
qt5ct to set the theme, and set the environment variable QT_QPA_PLATFORMTHEME=qt5ct
On macOS: Since macOS 10.14 you can set a dark theme in the preferences.
On Windows:

Open the Windows settings, search “night light”, turn it on and adjust the color.
Or download a compatible dark theme, for example GreyEveTheme. Extract the zip and double
click on the .theme file

https://www.deviantart.com/eversins/art/GreyEveTheme-FINAL-Windows-10-High-Contrast-Theme-643504863
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Edit Menu

The Edit menu contain the configuration settings:

Devices Setup
Preferences

INDI settings

ASCOM settings
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Device setup

Open this window from the menu Edit → Device setup to configure the devices to use with the program.

Interface

The first tab “Interface” let you select the profile you want to use.

All the devices and all the program preferences will be stored in this profile, allowing to have completely
different settings for your different equipment or locations.

The Copy button copy the current profile to a new one, allowing to change a piece of the equipment but keep
the other settings.
The New button create a totally empty profile, with no equipment and no options. This can be use to create a
profile for another observatory and be sure to not left behind an incompatible option.
Use the Delete button to remove a profile you no more need.

Next you can define the default server host name or IP and port for the INDI server and ASCOM Alpaca server
and apply this settings for all the corresponding devices.

You can use IndiStarter to start the INDI server automatically. Check Start Indistarter and select the
corresponding profile.

The ASCOM Remote server is assumed to be already running and configured with the drivers you need.
Click the “ASCOM Remote” icon in the Start menu of the remote computer.

You can search for Alpaca server and devices on your local network by using the button Discover. This require
that discovery and management interface are active in the Alpaca server. You can adjust the discovery port if
you change this value in the server configuration.
When the discovery fail a new button Scan this server appear, this allow to search for devices in a server not
in the broadcast range, for example across the Internet.

You can use at the same time devices connected to different server and using different protocol. For example
the camera using a local ASCOM driver, the mount connected by INDI to a Raspberry PI and the focuser to a
remote ASCOM Alpaca server.

https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup1.png?id=en%3Adocumentation%3Adevices_setup
https://www.indilib.org/about/discover-indi.html
https://github.com/ASCOMInitiative/ASCOMRemote/releases
https://github.com/pchev/indistarter/wiki
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INDI devices

Select the INDI tab for each INDI device you want to use and check the server host name or IP address is right. If
need you can set a different server for every device.
Then click the Get button to fill the Device list with the corresponding drivers running on the server.
Select the device you want in the list.
You can select to load the device configuration just after the device is connected and if not already
connected in INDI. This is the same as the INDI client Options/Configuration/Load button, be sure you saved the
right configuration from the INDI panel.

ASCOM devices

Select the ASCOM tab for each local ASCOM device you want to use. This tab is available only if CCDciel is
running on Windows.
Click the Choose button open the ASCOM Chooser to select the driver to use.
The Setup button let you configure the options specific for this driver.
The About button show information about the driver.

https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_indi.png?id=en%3Adocumentation%3Adevices_setup
https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_ascom.png?id=en%3Adocumentation%3Adevices_setup
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ASCOM Alpaca devices

Select the ASCOM Alpaca tab for each ASCOM Alpaca remote device you want to use. You can use a ASCOM
Alpaca device also from Linux and macOS.
If you click the button Discover on the first tab you can select the devices from the top drop-down list.
Check the protocol, normally http: if not using a proxy, and the server host name or IP address is right. If need
you can define a different server for every device. The user name and password can be used for authentication
when using a proxy service.
Then enter the remote device number to use for the device type. This is for example the “Device Number” you
configured in the ASCOM Remote Server configuration.

Camera

Select the camera to use with CCDciel, a camera is mandatory so you cannot leave this page unconfigured.

ASCOM, ASCOM Alpaca:
You can select if you want the image to be flipped vertically when it is read from the ASCOM driver. Checked
from compatibility with Linux version, uncheck for compatibility with many Windows software.
Select if you want the DATE-OBS keyword to be from the ASCOM driver. Beware some camera do not respect
the UTC rule.
When Try to fix pixel range is selected the program will try to recover the original pixel value depending on
the CMOS camera bit depth. For example with a 12bit camera the pixel are stored with a range from 0 to 4095.
This revert the multiplication by 16 done by the driver.

INDI:
The Sensor field, visible when a SBIG camera is selected, is to select the sensor to use for dual-chip camera,
you probably always want “Main sensor” here.

https://www.ap-i.net/ccdciel/_detail/en/documentation/devsetup_ascomremote.png?id=en%3Adocumentation%3Adevices_setup
https://www.ap-i.net/ccdciel/_detail/en/documentation/ascom_remote1.png?id=en%3Adocumentation%3Adevices_setup
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Guide Camera

Select the guide camera to use with the CCDciel internal guider.
Let this unselected if you use an external guider software.

Finder Camera

Select a camera to be used for plate solving if this cannot be done with the main camera.
Typical use is when the main camera is behind a spectrograph, but this can also be used for planetary imaging
with very long focal length.
It is possible to use the same camera than the Guide camera because both are never used at the same time.
Just specify the same driver here.
You can change between finder and main camera at any time from the Slewing preferences.

Filter wheel

After selecting the driver, check “Use filter wheel”.
Select “In camera” if the filter wheel is commanded by the camera driver.
Select “Manual” to use a manual filter wheel.

Enter the number of slot and the name for each filter.
The program will pause and ask you to change the filter when required.

Focuser

After selecting the driver, check “Use focuser”.

If a ASCOM weather station is configured and report the temperature, you can check Temperature from
weather station to use it as the focuser temperature.

Rotator

After selecting the driver, check “Use rotator”.

https://www.ap-i.net/ccdciel/_detail/en/documentation/manual_wheel.png?id=en%3Adocumentation%3Adevices_setup
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Mount

After selecting the driver, check “Use mount”.
You can set the following options at your convenience depending on your environment. For example if the
mount include a GPS or if you synchronize the site location across different software.

Set mount time from computer: send the time from the computer to the mount.
Set mount site long/lat from configuration: send the site from the configuration to the mount.
Get site long/lat from the mount: update the configuration site coordinates by the one set in the mount.

Dome

After selecting the driver, check “Use dome”.

CCDCiel do not position the dome by itself but rely on the available software.
Before to setup here, the dome must be configured using the INDI Dome settings, the ASCOM Device Hub or any
other specific dome software.
Be sure the mount is also set to a compatible driver so the dome slaving can be managed.
When using the ASCOM Device Hub it is mandatory to use both ASCOM.DeviceHub.Telescope and
ASCOM.DeviceHub.Dome instead of the real drivers.

The Dome preference let you manage the park/unpark function along with the telescope mount park/unpark.

Weather station

After selecting the driver, check “Use weather station”.
For ASCOM and ASCOM Remote, you can select if you want to use a ObservingConditions or SafetyMonitor
driver.
You can define the ObservingConditions limits in the Preferences. If using a SafetyMonitor be sure the limits in
the driver are set to ensure good observing condition, for example no clouds.

For INDI the limits are the Warning level of the weather driver.

When the observing condition are not good the sequence is paused until they are good again.
The equipment is NOT put in safety, if required see the Safety monitor below.

If available, the temperature, humidity and pressure are used to improve the atmospheric refraction
computation.
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Safety monitor

After selecting the driver, check “Use safety monitor”.
For ASCOM and ASCOM Remote, be sure the SafetyMonitor driver limits are set to ensure safe operation. For
example no rain.

For INDI the limits are the Alert level of the weather driver.

You can define the action to take when the condition are not safe in the Preferences.
Beware that by default it do nothing!

Watchdog

Check “Use watchdog”, select the INDI driver and set the threshold value in minutes.

The watchdog is a specific INDI driver that can park the mount and the dome if the connection is lost with
CCDciel for more than the threshold time limit. There is no similar function when using ASCOM drivers.

Switch

Check “Use switch”.
Select the number of different switch driver you want to connect. This add the corresponding number of tab
where you can define the connection to the different switch.
Be sure to add a nickname for each switch, this is this name that identify the switch later in the program.

Click OK after you complete your setting.

http://www.indilib.org/support/tutorials/154-securing-remote-observatories.html
https://www.ap-i.net/ccdciel/_detail/en/documentation/setup_switch.png?id=en%3Adocumentation%3Adevices_setup
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Preferences

From the menu Edit → Preferences. Set the global preferences and options for the program.

Preferences

Language
You can change the program language from the list.

Select if you want to use Celsius or Fahrenheit temperature scale in the program.

Journaling
The program record all the messages to a file. You can look at the log using the function in the Help menu. It
also save the images in the case the auto-focus fail to find stars or when plate solving fail, they can be used
later to help to adjust the parameters.
The log file and failed auto-focus images are conserved for a period of 30 days, then they are automatically
removed.
In case of problem with a device driver you can get more detailed information by checking Verbose device
log.
By default the program show hint text over the buttons, you can disable this option here.

Python command
Set the command to start a Python script. You can use a specific Python installation by changing the default
value.

TCP/IP server port
Set the port the TCP/IP server will listen on. Use the default unless it is already taken by another program or if
you run multiple instance of CCDciel.

Log folder
The location to save the session log.

Sequence folder
The location to save and load the sequence files. This can be modified for a more simple file access location.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref0.png?id=en%3Adocumentation%3Apreferences
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Temporary folder
Normally you not need to change the temporary file folder. This is only required on Windows if the default path
based on your user name contain accentuated non-ASCII characters. Be sure you specify a path with only ASCII
characters.
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Files

Capture folder
The base capture folder should be specified. The other configured sub-folder are created under this one.

File and folder name
You can specify how the image files are named and if they are stored in named folders. A typical imaging
session will produce a great number of files, so this help to select files in the processing software.

One way of working is to make subfolders based on object name and select for file names all details; object
name, the filter, a date sequence, exposure time, binning.

For folder name you have the choice between two date. One to make a folder with the same UT time as for the
file name, the other is based on local time and change at noon to allow to put all the files for a given night to
the same folder.

For file name, if Date/Sequence is checked the UT date and time is appended, otherwise a sequence number is
appended. You can select a fixed sequence length or let unchecked for variable length.
You can reorder the different elements with a mouse drag and drop of the sequence number column.

Select the separator character you want between the fields, and the length of numeric sequence. It is also
possible to remove space from the object name if your processing software has difficulties with that.

The file format can be FITS or Astro-TIFF, a 16bit TIFF file with addition of all the FITS header information that is
supported by a number of processing software.

The saved FITS files can be compressed with fpack to use less disk space.

You can save the image in bitmap format in addition to the standard FITS or Astro-TIFF file.
Select also the file format you want. BMP and JPG are stretched 8bit images, PNG and TIFF are saved as linear
16bit, the same as the Save picture menu.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref1.png?id=en%3Adocumentation%3Apreferences
https://fits.gsfc.nasa.gov/fits_home.html
https://astro-tiff.sourceforge.io/
https://heasarc.nasa.gov/fitsio/fpack/
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Custom headers
It is possible to define custom headers to add to every captured FITS file.
Enter valid keyword and values in the table. It is possible to set text or numeric values.
If a keyword is already set by the standard CCDciel processing and you add the same keyword here your value
take precedence and replace the standard value.
For example the following input:

Add the following to the header:

Use the available script function if you need to add headers with a dynamic value.

https://www.ap-i.net/ccdciel/_detail/en/documentation/custheader1.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/custheader2.png?id=en%3Adocumentation%3Apreferences
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Observatory

Preset list
Each new observatory name is added to the preset list for an easy later retrieval.
This is useful if you transport the same equipment at different location.
But please do not use this option to work with different equipment, in this case you need a specific profile for
each.

General information
The information on top will be set in each FITS file for the OBSERVER, ORIGIN, TELESCOP and INSTRUME
keyword.

Observatory coordinates
The latitude and longitude of the observatory is used to get the Alt/Az position of the object, or for the
scope_alignment script. It is mandatory you set them before you can use the timing functions in the sequence
planner.

Rise/Set condition
The “Horizon profile” and “Minimum observing elevation” are used to compute the object rise and set time in
the sequence planner. If this values are set the rise/set time are relative to this limits.
You can set only one value or both. In the last case the highest elevation is used.
The horizon profile file is the same as the local horizon line in Skychart.

Azimuth origin
Select if you prefer to use the azimuth counted from the North or from the South. This only affect some display
in the program, the object azimuth recorded in the FITS header is always from the North.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref2.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/skychart/en/documentation/observatory#horizon
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Camera

Sensor temperature
Configure how you prefer to cool down and warm up you CCD sensor.
Consult your camera documentation to know if you need to limit the temperature change.
In this case check “Limit temperature change” and indicate the maximum rate in degree per minute.
Check the corresponding box if you want your camera to start cooling as soon it is connect to the program and
indicate the target temperature you want.

Sensor properties
Enter the camera pixel size and maximum ADU, or if applicable for your driver, check the box to get it
automatically.
The maximum ADU is used to avoid saturated stars during autofocus and photometry.
The pixel size is required to speedup the astrometry solving by estimating the image scale.

Predefined ROI
Manage a list of subframe size and position that can be quickly selected from the frame tool

Gain / Offset
Select if you want to manage the camera gain and offset from CCDciel or use the fixed value set in the camera
driver.
If this box is checked you must set the gain and offset in the Preview, Capture and Sequence box. You must
also set the gain and offset you want for the auto-focus and slewing operation.
This can work only if the camera driver expose this values. For ASCOM driver this is available only with new
drivers using the version 3 of the camera interface.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref12.png?id=en%3Adocumentation%3Apreferences
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Short exposure stacking
Check Show stacking option for Preview/Capture/Sequence if you want to use this options. You can let it
disabled to not risk an unwanted use during the imaging session.

Star alignment align the frames on a reference star. Use it for EAA along with the dark, BPM and
debayer option. No further pre-preprocessing is possible when any of this option is used.
Rotation correct the alignment for field rotation. This require the astrometry to be configured.
Apply Dark and BPM apply the setting from File → Dark frame and File → Bad pixel map.
Apply Flat apply the setting from File → Flat frame.
Debayer the image using the preview setting.
Floating point file using 32bit FITS file. This ensure the maximum of precision and prevent data
overflow. Be careful how to use this kind of image with your processing software.
Add images or Mean of images is the operation used to stack the images.
Save individual images before stacking in a specific folder named with the object name and the time
the stacking start.

Readout modes
If your camera support different readout modes you can activate the use of specific readout mode for
different actions.
Then select which one to use for the different operations. Normally you want the select the best quality mode
for Capture and a fast mode for the other.
With INDI DSLR this is a combination of the CAPTURE_FORMAT and TRANSFER_FORMAT property to select from
RAW, FITS, or different JPEG quality.
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Preview

This settings affect only the preview, the FITS files are always recorded in RAW format to allow further
preprocessing.

Color preview
If you use a color camera you can debayer the preview image by checking the corresponding box and selecting
the color pattern for your sensor. The Automatic option use the value set by the camera driver of the DSLR raw
file. If this not work try the other option in the list. You can also do some color balance with the cursors on the
right. For DSLR raw files you can select to use the color balance set in the file. By default the background color
is neutralized, this can be disabled if the image do not contain a classic sky background.
When using a slit spectrograph it is possible to colorize the spectra image using the wavelength FITS
keyword. This also colorize the spectra profile.

Reference image
The reference image help you to frame a previous image, for example to continue a sequence.
Select the threshold and color for the display of the reference image.

Image clipping
The image clipping indicator level. You can set the low and high threshold in ADU for this indicator.

Bad pixel map
The bad pixel map prevent the auto-focus function to lock on a hot pixel.
Select the threshold for detection of hot pixels for the bad pixel map.

Image cursor
Select the type and size of mouse cursor you want over the image display.

Video
Check the box to show the Video tab if available for your camera.
Select the preview rate for the video. Video require a suitable camera and is available only with INDI devices.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref9.png?id=en%3Adocumentation%3Apreferences
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Custom image type

This allow to define additional custom image type in addition to the standard Light, Flat, Dark, Bias.

Add one row per type, with a name and optionally a script with parameters to run when this type is selected or
unselected.

For the camera driver, all this additional type are of type Light.

A typical use is to light a neon lamp for spectroscope calibration, but this can be use for any purpose, for
example to subclassify the Light exposure according to your need.

After definition here, the custom type are available in the Capture or Sequences options.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref20.png?id=en%3Adocumentation%3Apreferences
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Flat

Automatic flat
Configure the method to use to capture a flat series from a sequence.

Twilight flat
For the twilight flat it is require to configure the automatic exposure as the sky lightness change a lot during
dusk or dawn.
You can also configure this automatic exposure for a use with other light source.
At each exposure the program will adjust the exposure time between the two limits to maintain the image level.
Set the shortest exposure time that give an uniform sensor illumination. This depend on the kind of shutter used
by the camera.
Set the longest exposure time you want for a flat. You have to take the corresponding dark separately.
Then give an image mean level range that make an acceptable flat. Start with 80% of your camera full range
but check there is no saturated part in the center of the flat image, specifically if the vignetting is important.

Dome/Panel
Select this method if you use dome flat or light panel.
You can also select automatic exposure, but at the difference of the twilight flat the exposure is adjusted only
once for each filter, then the same exposure time is use for the series.
If you need to point the telescope at a specific position to frame the panel you can enter the required azimuth
and elevation.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref13.png?id=en%3Adocumentation%3Apreferences
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Focus

Star profile
Select the camera ROI size of the zoomed window for the single star focus mode.
Normally a single pixel star is rejected as a hot pixel. If your optical configuration produce undersampled image
with single pixel star you can check this box. But be careful to make a bad pixel map to reject the hot pixel.

Focuser correction
If this is not already done by your focuser driver you can activate a backlash compensation. But be sure to let it
disabled if the compensation is done elsewhere. Indicate the number of additional steps to use for the
compensation, this must be greater than the actual backlash, don't hesitate to use a large value.
Indicate the direction the focuser will always finish to move, the best depend on your configuration. If you
configure the auto-focus this control is disabled and will be set to the same as the focus move direction.
If it take some time for the focus position to stabilize after a move you can set a delay to wait after every
focuser movement. This is more likely of use if the motor directly move the primary mirror of a SCT.

Filter offset
For each filter you can set an offset in focuser steps that will be applied to the focuser when you change the
filter.
The filter exposure factor is used for the auto-focus functions and the automatic sky flat. For example if your R
filter require 2x the exposure of the L filter and the Halpha 30x set : L=1 R=2 Ha=30
For narrow band filter this exposure factor can be very large. In this case you can use the option “Allow to select
a brighter star for high filter exposure factor” in the auto-focus preference.

Temperature compensation
Temperature compensation and automatic triggering of autofocus after a temperature drop can be set in tab
Sequence

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref3.png?id=en%3Adocumentation%3Apreferences
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Auto-Focus

This section is initially empty. It can be hard to fill with the right values for your specific equipment. It is strongly
suggested you use the focuser calibration wizard to set the correct default parameters.

After the wizard is run it select the preferred Dynamic method. You can return at this page if you want to
change the method or adjust some parameters.

 

Select the auto-focus method:

Dynamic: (hyperbole curve fitting) This method can be used with either an absolute or relative position
focuser. Like the dynamic method it de-focus the star(s) and tries to fit the corresponding HFD values(s)
to a hyperbole function. From the hyperbole function the bottom position so the focus can be calculated.
This method has the advantage that it doesn't require a calibration in advance. It also requires less de-
focusing of the stars (can work in bottom non-linear part of the curve) and therefore will work with fainter
stars.
This method will work well if you want to use the option “stay in place” for autofocus and it will use
multiple stars for reliable detection.
V curve: (asymptote crossing) This is a method for an absolute position focuser. It will measure the size
(HFD value) of a de-focused star at several focuser positions to calculate the best focus position. In
advance your system has to be analyzed using the V-curve learning tool. This routine will measure the
star size (HFD value) as function of the focuser position of your setup. The slope of the two linear lines
(asymptote) left and right of the focus position are constant and they cross at the best focus position.
Temperature changes, filters and slippage will only shift the focus but not the slope of the two lines.
Once the V-curve (the slope of the two lines) has been measured accurately and saved using the V-curve
learning tool, every auto focus operation will be done quick and efficient.
This method work best with a single bright star and you need to configure the focus star magnitude you
want to slew to before the autofocus routine is executed.
Iterative: A dumb method that move in one direction or another as long the star diameter is smaller.
Movement step is reduced at each direction reversal. It has the advantage to work with any kind of
focuser, including DC motor, and you can start with a very de-focused star. But it is slow and imprecise.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref10-1.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref10-2.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref10.png?id=en%3Adocumentation%3Apreferences
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Planet This method is similar to Dynamic but it measures the image sharpness (gradient) instead of the
stars HFD. This make it possible to autofocus on the Sun, the Moon or the planets. Note that the
difference between the minimum value and maximum is about 40% maximum.So the focus curve is
flatter. Set the number of sample points between 20 or 30 to average out noise. At severe de-focus
positions the curve will turns into a horizontal line which should be avoided. Reduce the focuser step size
till there is maybe 20% difference between minimum and maximum value. Below an example of an
autofocus curve of the planet Jupiter:

None: If you want to use your focuser only manually.

Performance comparison V-curve and dynamic focusing:

Method Target field V- curve focusing Dynamic focusing
Slew to database star Always a bright star +++ +++
Slew to database star +
Allow to select a brighter star Narrow band filter +++ +++

Stay in place Medium bright stars ++ +++
Stay in place Faint stars + ++
Stay in place Narrow band filter + faint stars - -
Dynamic focusing can work in the bottom non-linear part of the V-curve. HFD as low as 4 (twice minimum)
V-curve focusing requires a peak HFD value of typical 15 to 20. Below peak value HFD is 10, the focus result
will be less accurate.

Common parameters

Exposure time to use for the auto-focus operation. This time is multiplied by the filter exposure factor
above.
Gain and Offset to use for the auto-focus operation. This require you activate the camera option
Binning to use for the auto-focus. Use binning 1×1 unless you are way oversampled.
The move direction of the focuser. Depending on you setting the focuser can work better when moved
in or out of focus.
Autofocus tolerance is the maximum HFD that can be considered as a successful focus. If the HFD after
and auto focus operation is higher than this value the focuser position is set back to it's previous value.
The minimum SNR of the star during the measurement. If a measurement SNR is lower than this value
the auto focus operation is canceled and the focuser position is set back to it's previous value.
Number of exposure per point The number of exposure we take to get a mean HFD value for each
focuser position. Increase this value if the seeing is not good. But set to 1 when using multiple stars
detection.
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Option valid when running from a sequence

Default behavior for Focus star selection when the autofocus is run from a sequence. Select if you want
to slew to a bright star or stay on the object you are imaging to do the auto-focus. This can be selected
object by object in the target editor. When using the Autofocus button in the Star profile tool it always
stay at the current position, allowing you to manually select the target.
When measuring multiple stars it is possible to select the sensor area used for focusing in percent of
the sensor area, the default is to use 30%.
If you stay on position, you can select to Pause guiding during autofocus or not. You must pause
when using a OAG, but it is recommended continue guiding when using a separate guide scope.
Focus star selection when using “Slew to focus star”. Select the magnitude of a star that give a good
SNR for the auto-focus operation using the above exposure time. The telescope is moved to a nearby star
of this magnitude to run the auto-focus. You can set here the precision require for the slew to put the star
in half the image height. Use a lower precision than for target slewing to speedup the process. If Allow to
select a brighter star for high filter exposure factor the program can use a brighter star to avoid
too long exposure time with narrow band filter.

If the auto-focus fails to find stars and the journaling to file is active, the image is saved in the same folder as
the log so you can review them later to help to adjust the parameters.

Dynamic parameters

Number of dynamic points: The number of points we take on the curve. Do not set too high as this is
done at every focus operation. Recommended default value is 7.
Movement between points: The number of focuser steps we move between each measurement of the
curve. It must be set high enough to make a measurable change in star diameter, but not to high so faint
stars can still be detected. The HFD value should increase at least twice the minimum. So if the focused
stars have a typical HFD value of 2.5, the resulting V-curve should reach a HFD value of 5 or higher.
Larger steps will make it less vulnerable for focus drift but due to the larger HFD values it requires
brighter stars for enough signal to noise ratio. The maximum focuser movement in and out of current
position will be (Number of dynamic points)*(Movement between points)/2
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V curve parameters

Start focus HFD: The focus starting point on the V curve used to determine the Near focus position. Use
a high value near the top of the V curve but inside the measurement area. A typical value is 20.0.
Near focus HFD: We move the focuser to get this HFD to make the measurement on the V curve. This is
not the focus HFD, it must be half way on the linear part of the curve. For example if your focus HFD is
3.0 and you make a V curve up to a HFD of 20.0, you can set 10.0 here.
Slippage correction If your focuser is prone to slippage you can activate a correction here. You must
have configured the filter offset and the focuser focuser temperature compensation, so we can be
confident that the remaining offset is slippage.

The autofocus routine finds the focus in four focus movements using the slope information from the V-curve
learning.

Move beyond the Start focus HFD to (1) taken into account any temperature drift. This to fix any1.
mechanical hysteresis in your system.
Move to calculated Start focus HFD (2) taken into account any temperature drift. Here a number of2.
exposures is taken and the average new start HFD is calculated.
Based on the average new start HFD of step 2) move using the slope factor to the calculated Near focus3.
HFD position (3). This (3) will be already adapted to any focus drift and should be spot-on. Take a number
of exposures and use the average new near HFD and slope factor to calculate the new focus position.
Move to the new calculated focus position (4).4.

- If the SNR, signal to noise is too low, the routine is aborted.
- Any focus drift will result in a drift of the new start HFD but not in the new near HFD.

Iterative parameters

Initial movement in focuser steps. This is the movement we use between measurement on the first
iteration. It is then divided by two every time we change the direction.
Final movement in focuser steps. When we reach this movement value we consider we are at the focus.
This is typically the focus tolerance of your optical system.

Planet parameters

Number of points: The number of points we take on the curve. Set high enough to leverage the seeing
fluctuation on the planet surface. The default is the value measured for the dynamic focus during the
focuser calibration, but it is recommended to increase at least to 15.

https://www.ap-i.net/ccdciel/_detail/en/documentation/learn_vcurve_marked.png?id=en%3Adocumentation%3Apreferences
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Movement between points: The number of focuser steps we move between each measurement of the
curve. It must be set high enough to make a measurable change in image sharpness, but not too high
because at a certain point more defocusing do not make less sharpness. If the curve show flattening on
the top you need to reduce this value. The default is the value measured for the dynamic focus during
focuser calibration. The maximum focuser movement in and out of current position will be (Number of
points)*(Movement between points)/2 *
The sharpness detection works better if there is a strong signal. Expose long enough for a bright image of
the the planet.

Expert trick

At the bottom of the preference list, you can set a defocus amount to apply after the focus point is reached.
This can help to image with a constant defocus value when doing photometry measurement with a color sensor.

The option Autofocus using the OAG camera is for use with a slit spectroscope or other case where it is not
possible to use the main camera for focusing.
The guide camera is used to measure the stars reflected by the slit mirror.
In this case the defocus amount can be set to the difference of focus position between the guide camera and
the spectroscope.

Temperature compensation
Temperature compensation and automatic triggering of autofocus after a temperature drop can be set in
Sequence

https://www.ap-i.net/ccdciel/_detail/en/documentation/autofocus_guider.png?id=en%3Adocumentation%3Apreferences
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Astrometry

 

Global options
It is important the program know your telescope focal length to estimate the image scale to speedup the solving
process. Enter telescope focal length, or if applicable for your driver, check the box to get it automatically.

You can also adjust the timeout (in seconds) for a solve operation.

Software selection
Select the software you want to use for the astrometry resolution of the images, you can use astrometry.net ,
Star Locator Elbrus , PlateSolve 2 or ASTAP.

For each software you can adjust a few option to make them work quickly and reliably with your images.

Astrometry.net options

Maximum search radius: Is a tolerance in degrees to the telescope position. Set this value high enough if
you use the plate solving to make a pointing model.
Scale tolerance: The tolerance on the pixel scale derived from the focal length and pixel size.
Downsample: the image by this factor. Use at least 4 or 8 for DSLR images. For CCD it is better to use
binning.
Maximum number of source to consider.
Other options: any other option you want to give to the solve-field command. See man solve-field,
for example --use-sextractor.
Use online nova.astrometry.net, in this case specify your API key from this site.
Use custom script: Use a script instead of the solve-field command. There is two example with the
program, one for remote execution using ssh, the other for remote solving with the astrometry.net
python script.
On Linux or macOS you can specify the path to the solve-field program if it is not installed at a standard
location. Let this field blank to use the default system search path.
On Windows only, you need to specify the Cygwin path to where astrometry.net is installed, for example
C:\cygwin. See the installation instruction for more details.
You can setup astrometry.net as the fallback option if the primary configured solver fail. This let you use
a faster software like ASTAP as the primary solution and retry with astrometry.net only if it fail because of
difficult condition like half cloudy sky.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref4.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref5.png?id=en%3Adocumentation%3Apreferences
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Elbrus options

Elbrus images folder: the folder where Elbrus wait for new images to solve.
Images folder Unix path: Unix only, the unix path corresponding to the previous one where CCDciel save
the image for measurement.

 

PlateSolve 2 options

Program folder: the folder you install the PlateSolve2 program.
Wait after solve: the number of second the PlateSolve2 window remain visible after solving is complete.

ASTAP options

Program folder: the folder you install the ASTAP program.
Maximum search radius: Is a tolerance in degrees to the telescope position. As ASTAP is very fast there is
no reason to change the 90° default value.
Downsample: For large images (>3000 pixels wide) select binning. It is recommended to keep the default
value of 0 that let ASTAP select the best depending on the image size.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref4a.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref5a.png?id=en%3Adocumentation%3Apreferences
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Slewing

You can adjust how to correct the mount position after plate solving a control picture.

Correction method

Mount sync will send a Sync command to the mount after plate solving before to Slew at the requested
coordinates.
Pointing offset will compute the RA/Dec offset and send to the mount a Slew to coordinates modified by
this offset.

If your mount allow to sync anywhere select “Mount sync”, if not select “Pointing offset” to make the correction
in software.
“Pointing offset” can be useful if your telescope use a pointing model, this avoid any problem by using Sync with
the model, but this can result in a wrong position to be reported in other software.
With Eqmod it is best to disable the pointing model and select “Mount sync” here. With EQAscom, in
Alignment/Sync select “Dialog based” and “Nearest point”. With INDI EQmod select “sync mode=standard sync”
and “alignment mode=nearest point”.

Pointing options
Then set the precision you want/can reach and the maximum number of pointing/correction retry before to give
up. Beware that any backlash in the mount drive can limit the possible precision.

Control exposure
If you define a Finder camera you can select which camera to use.
Set the parameters (exposure time, gain, offset, binning and filter) for the control exposure. This must
give enough stars with your telescope/camera combination for the astrometry resolver to work.
If your mount need some time to stabilize after the movement you can increase the delay to wait before to
take the plate solving picture.
When using a separate finder, specify the Focal length and if you want to use an alternative solver, other
than the main one for the main or guide camera.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref6.png?id=en%3Adocumentation%3Apreferences
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Meridian

Configure here what you want to do when the mount reach the meridian.

Do nothing: select this option if your mount is not affected by the meridian (fork mount).
Automatic flip: automatically do a reversal of the mount to continue to track past meridian.
Run a script: run a script that do the meridian flip.
Abort: abort the current capture and stop the mount.

Automatic flip options

The first two parameters allow to loss the minimal time during a capture sequence. Set the difference between
them as long as the capture exposure time. Otherwise the sequence can be paused until it reach the time for
the flip.
Also be sure the flip do not start too early because this can be the cause of mount sync error in case of polar
alignment error or telescope cone error because many mount do not accept to sync across the physical
meridian.
To avoid error during the flip procedure it is important the mount and program observatory coordinates and
time are set precisely.

Can track past meridian for: the number of minute your mount can safely track past the meridian
without flip. This depend on the declination, set the smaller value here.
No flip until past meridian for: the minimum number of minute after the meridian we wait before to
initiate the flip. Set this value to at least 10 minutes to avoid mount sync error near the meridian. You can
set a negative value here to flip before the meridian, be sure the mount can accept that and support to
set SideOfPier.

Actions to take as part of the meridian flip:

Set mount SideOfPier if available: Set SideOfPier directly to the mount, otherwise use Goto
command.
Suspend dome slaving: This can prevent a full rotation with some dome.
Autofocus after meridian flip: In some case the focus point can move after a flip.
Calibrate autoguider after meridian flip: If your mount do not report the side of pier to the
autoguider you can check this option to force a new calibration.
Pause before meridian flip:
Pause after meridian flip: this two checkbox give you a prompt before or after the flip to let you the

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref11.png?id=en%3Adocumentation%3Apreferences
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time to do some manual operation on the mount (moving the counterweight for example).
Timeout: The maximum time we wait for the pause after the meridian flip, if you not close the prompt
after this time the sequence continue automatically.
Before the flip the pause is limited by the maximum time the mount can track without a flip.

Precise centering of the target using plate solving after the flip is done automatically and only require you
configure the plate solving correctly.
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Auto-guiding

Software selection Select your autoguiding software, this can be PHD2, Internal guider, Lin_Guider or only
dithering using mount command.

PHD2 options
For PHD2 you need to set the network name of the computer running PHD2 and the port number.
Check if you want to start PHD2 if it is not running when connecting. Indicate the command to start PHD2, the
default value correspond to the default PHD2 installation on the different platform.

Dithering
Set the options for dithering between the exposure, the number of pixels (in the guide camera) and if you want
to dither only in RA (if you have a lot of DEC backlash).
If the option Dither while downloading from the camera is checked the dithering will start as soon the
previous exposure is complete, making profit of the image download time to advance on the dither.

Settle tolerance
The settle tolerance define how we consider the autoguiding as good after a dither operation or after it start.
It must stay within the number of pixel for Min.time. But we wait for the maximum of Timeout if this is not
possible.
Set also the maximum time to wait if a new calibration is required.

Spectroscopy
This set the guide lock position for use with a reflective slit spectrograph.

Star lost recovery
In the case the guide star is lost we can cancel and restart the current exposure after a number of guide
step without star. This is for the case we know the current exposure will be lost anyway so there is no need to
loss more time by completing this exposure.

Then if the star is not recovered after a given time we can try to restart the guiding. This is useful if the star
as moved just out of the search area. But this can also make the sequence to continue with an unacceptable
offset, this can be avoided by checking for target drift. A value of zero disable this function.

Finally we can abort the current sequence after some time. Useful if the target is behind tree or cloud,
maybe the next target is at a better position.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref7.png?id=en%3Adocumentation%3Apreferences
https://openphdguiding.org/
https://sourceforge.net/projects/linguider/
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Guiding drift control
If the current guide position drift by more than the configured value a message is show in the log and eventually
the current exposure is canceled and restarted. We can wait for the delay to let the guiding to recover
before to restart the exposure.
The current sequence target can be aborted if it still drift after a number of consecutive restart.

Internal guiders
Define the Dithering and Settle tolerance options that have the same meaning as above.
Setup the guide camera to use in the devices setup.
All the internal guider specific settings are at the Internal Guider tab.

Lin_Guider options
For Lin_Guider you can choose to communicate by a local Unix socket or by the TCP network, on Windows only
the TCP option is available. The selection must correspond to the one in the Lin_Guider general setting.

Dithering
Set the number of pixels for dithering between the exposure.

Dither only options
With this option no auto-guiding is done but the program can initiate dithering between the exposure.

Here you set the mean duration of the dithering guide pulse send to the mount. This duration depend on the
imaging scale and the mount guide rate. An additional wait time can be configured to let the mount stabilize
after the dithering.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref_7c.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref7b.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/pref_dither.png?id=en%3Adocumentation%3Apreferences
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Dome

The Dome preference let you configure if you want to automatically manage the dome with the mount
park/unpark function.

If you check the box Allow to open the dome when safety status is bad or unknown there will be NO
check for the safety before to open the dome. Use this setting only if your safety monitor is not functional until
the dome is open.

If you check the box Automatically slave “Dome Park” to “Mount Park”, every time you unpark the mount
from CCDciel the sequence to open and initialize the dome will be taken. And every time you request to park
the mount the corresponding action to close and park the dome will be taken.

Beware to carefully test this procedure before use and be prepared if something go wrong. What to expect if
for example the telescope do not respond to the park request but the roof is then closed and hit the telescope?
This case can be secured by using hardware switch on the mount that prevent the roof motor to start.
If you are not sure please do not use this function and open/close your dome with manual action and visual
inspection.

For each of the unpark and park function you need to select the action you want in the order require by your
setup. For some configuration you need to open the dome first or unpark the telescope first.
If some action is not require by your setup just ignore it, you not need to fill all the rows. For example if
unparking the dome also open the shutter select only “Unpark the Dome”.
But be sure to put “Unpark the telescope” and “Park the telescope” somewhere, otherwise the telescope will
never be unparked and any slew will fail.

You can also wait for an additional delay between each operation to let time for the mechanical part to stabilize.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref16.png?id=en%3Adocumentation%3Apreferences


CCDciel documentation

58

Planetarium

Select the planetarium application you want to use.

You can use the planetarium to select a target, or to display a solved image or image frame.

You have the choice between Skychart. HNSKY, or a SAMP application like Aladin or Topcat.

Check if you want to start Skychart/SAMP/HNSKY if it is not running when connecting. Indicate the command
to start the program and eventual parameters, the default value correspond to the default installation on the
different platform, but you may have to adapt for 32bit version on Win64 for example.

There is two additional options for Skychart.

Adjust the chart for the image frame to automatically zoom and center when a frame is send. When
unchecked the chart is not modified.
Update chart with every astrometry result when checked a mark is set on the chart every time an
image is plate solved.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref8.png?id=en%3Adocumentation%3Apreferences
http://www.ap-i.net/skychart
http://www.hnsky.org/software.htm
http://www.ivoa.net/samp/
http://aladin.u-strasbg.fr/aladin.gml
http://www.star.bris.ac.uk/~mbt/topcat/
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Weather station

Beware this settings will never close your observatory, even in case of rain! See the Safety monitor
below if you need this actions.

You define here the parameters to pause a running sequence when the weather condition are not optimal.
When bad condition are detected the program do the following:

wait the end of current exposure1.
stop telescope tracking and autoguiding2.
wait for the sky to be clear again3.

When it is clear again it run the target initialization procedure, the same as when the target is first selected,
checking for time range, slew with plate solving, start autoguiding, eventually going to the next target if this
one is no more observable.

When you select to use a ASCOM ObservingCondition driver, you need to set the limits for every sensors here.
For INDI the limits are the Warning level of the weather driver.

You can also set a delay to wait after the weather is good again to avoid to start/stop continuously if a sensor is
just at the limit. See also if your driver can average the measurement over a period to avoid this behavior.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref14.png?id=en%3Adocumentation%3Apreferences
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Safety monitor

Select the actions you want to run when the Safety monitor detect dangerous conditions.
Beware that by default it do nothing!

The order to run the different actions depend on your specific equipment and need to be carefully tested.
For example if it rain you want to close the dome as soon as possible, but maybe the mount need to be parked
first. In this case you must also test what it do if the telescope cannot park because of cable disconnection or
other reason.

Use the function “Call external command” if you need additional actions not available in the dropdown list.

For two actions you need to set a parameter:

Show prompt : the time to wait before to continue automatically, in seconds.
Call external command: the full path of the command or script to be executed.

If you configure the Dome operation to be slaved to the mount park/unpark you only need to use the “Park the
telescope” action here to also park and close the dome as configured.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref15.png?id=en%3Adocumentation%3Apreferences
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Sequence

This let you set some global actions taken during the execution of a sequence.

You can select to Start new exposure as early as possible, without waiting for the previous image to be
saved and displayed. With this option checked you can save a few seconds between each exposure, the gain is
more important when using a big camera sensor with short exposure time.
This apply to capture sequence and preview loop.

When the previous option is active you can do some measurement on every image.

The Automatic HFD measurement let you monitor the image quality and record the mean HFD in the log.
The exposure time must be at least of 30 seconds to let the time for this measurement without perturbation of
the sequence.

A trend of the measured HFD values is plotted in the trend tab of the focus tool.

The measurement can also be used to trigger a new autofocus when the HFD change by more than a given
percentage.

The HFD Focus Monitoring goes through three states, each of which is logged when running:

Reset: All previous measurements and reference data is cleared. This forces the process into the1.
'measurement' state.
Measurement: During this stage three images are collected and the median HFD value is measured for2.
each. After the third image is collected and measured, the average of the three median HFD values is
calculated and this becomes the reference HFD going forward. When completed the process enters the
Active state.
Active: With each new image a running average of the median HFD is calculated and this new average is3.
compared to the reference HFD from step 2. If the running average varies from the reference HFD by the
threshold percentage (specified in the Preference/Sequence/% change HFD section), then an autofocus is
triggered. If an autofocus is triggered it goes back to the Reset state.

An average is used in the initial reference HFD calculation, as well as for the ongoing active-state
measurements, so a single bad image (e.g. a brief gust of wind or a period of bad seeing) doesn't trigger an

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref18.png?id=en%3Adocumentation%3Apreferences
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autofocus. By averaging these frames together it should only trigger an autofocus if the conditions continue,
and should more properly represent changes in seeing rather than temporary issues with the mount, guiding,
wind, etc. An autofocus can be triggered when HFD improves or degrades.

Recenter sequence target that drift
For various reason you may observe the target to slowly drift in the image field during the night. The obvious
symptom is large black border around the final image after registration and stacking.
You can observe this because you are not auto-guiding. But also when guiding with a separate guide scope
because of slow flexion of different mechanical and optical parts.

With this option the program plate-solve every image taken during a sequence to compute the drift from the
initial target position. If the drift is larger than the value set, it plan a recenter before the next exposure.
To make this possible it is required the image exposure time in the sequence is larger than the astrometry
timeout.
The last point to check is the drift value you set here must be larger than 1.5x the slew precision and also larger
than 2x or 3x the dithering if any.

Moon avoidance
Set here the acceptable distance to the Moon when the corresponding Sequence option is checked.

Periodic autofocus

This options are in addition to the autofocus frequency available in the Plan definition.

Focuser temperature compensation

If your focuser can measure the temperature you can set here the temperature coefficient (in steps per Celsius)
used to adjust the focuser position between the exposures, or to shift the auto-focus V curve accordingly. The
coefficient is positive if the focuser needs to move UP in position when the temperature drop. The routine will
adapt the focuser if the temperature difference is larger then 0.5 degrees.
Note that for a reflector telescope you have to turn the focuser OUT to correct for tube shrinkage. For a refractor
you have to turn the focuser IN since the change in refraction coefficient is dominant and much larger than the
tube shrinkage.
The temperature coefficient will help to reduce the number of autofocus actions required. It will work best when
the temperature drops slowly and all parts of the telescope have time to adapt to the changing ambient
temperature.
The compensation factor has to be measured empirically. Start with an almost zero factor=1 and monitor the
autofocus focus position in the log as function of the reported temperature. When you have enough data points
which show a repeatable temperature coefficient enter the estimated factor in this menu. Some telescopes like
a SCT could have less predictable coefficient and you most likely have to disable the coefficient and rely on the
autofocus routine only.
If the factor is set well, the result of each autofocus routine run should be close to the previous focus position.
The temperature of the last focus operation in a session is saved to make a first correction the next time you
start the program, so if no change was done in the mean time you recover a not too bad focuser position.

You can also request to run an auto-focus procedure if the temperature change is more than the
configured value.

The autofocus can also be run periodically after a given time interval.
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Performance

When using a computer with limited resource it is good to use this resources for the main job of capturing
images as quickly as possible. This can be improved by reducing the quality of the images show on screen or by
totally disabling image display when a sequence is running.
None of this option affect the quality of the saved images.

Low quality image scaling use simple pixel resampling to scale the image on screen. This iimprove the speed
a lot but can produce moire pattern with OSC sensors.

Do not display image during capture totally disable the display of the image during a sequence. This is a
good way to optimize the inter-frame delay, but also look at the option Start new exposure as early as
possible

When the option to not display the images is set, you can temporarily change this behavior using a new button
that appear on the right of the visualisation tool

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref19.png?id=en%3Adocumentation%3Apreferences
https://www.ap-i.net/ccdciel/_detail/en/documentation/visu2.png?id=en%3Adocumentation%3Apreferences
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Notifications

Email notification

You can configure email notifications that are send by the program on different conditions.

First you need to configure and test the email configuration so the program know how to send you an email.
Look at your email provider documentation for the values you need here, there is normally information how to
configure an email software.

Important security information. This email configuration is saved on a separate file in the program
configuration directory. The user name and password are obfuscated so they cannot be read directly in the file,
but they can be read from CCDciel that otherwise cannot send you an email. So be careful to not send this file
to anyone, and be sure you not use an important email account in this configuration.
It is strongly advised you create a low privilege email account to send this notifications.

Set the SMTP server address that accept outgoing request on the SMTP server port. Check the
corresponding box if the server use SSL/TLS for the connection.
Indicate the User name and Password to connect to this server, and the sender From email address that is
generally the same as the user name.
Finally indicate the Destination address that will receive the message. If you prefer to receive the messages
on your phone, this destination address can be an email to sms gateway.

You can test this configuration with the button Send test email. This show a message if the email can be send
or if there is connection error to the server. If the email is send successfully look at the destination mailbox for
the message. Do not forget to also look at the Spam box.

Then select the notifications you want to receive. It is probably best to start with all the notifications, then
remove the “Sequence normal end” if you want to receive only error notifications.

Voice notification

When you stay near the telescope during the capture it can be good to be alerted by some sound if something
require your attention. For this case CCDciel can spell the message that are normally only show on screen.

https://www.ap-i.net/ccdciel/_detail/en/documentation/pref17.png?id=en%3Adocumentation%3Apreferences
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You can configure the kind of message you want to ear from the Voice configuration tab.

A Test button allow to be sure the voice spelling is working and let you adjust the sound volume with the
computer settings.
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INDI settings

From the menu Edit → INDI settings.

This open a standard INDI client window where you can set any specific option for your devices.

http://www.indilib.org/
https://www.ap-i.net/ccdciel/_detail/en/documentation/indiclient.png?id=en%3Adocumentation%3Aindi_settings
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ASCOM settings

From the menu Edit → ASCOM … Setup.

The menu include an entry for each defined ASCOM device. This open the ASCOM driver setup dialog for your
device to let you set any specific option for the devices. Please note this setup dialog is not a part of CCDciel but
a part of the driver.

Beware that the device must be disconnected before the Setup dialog can be opened. This is from the ASCOM
specification and cannot be changed.
If it is already connected a dialog prompt ask your confirmation before to disconnect the device, it is
reconnected when the setup dialog is closed.
This fail if the device is also connected to another application because CCDciel cannot act for the other
application. In this case you have to disconnect the device from the other application first.

https://www.ap-i.net/ccdciel/_detail/en/documentation/ascom_setting.png?id=en%3Adocumentation%3Aascom_settings


CCDciel documentation

68

Display Menu

The Display menu let you select the tools you want to include or not in your screen.
Check or uncheck each tool to make it visible or not.
You can also move each tool on another part of the screen to suite your need just by dragging the tool title to
one of the main window border.

It includes the following options:

Image window
Connection
Preview
Autoguider
Internal Guider
Finder camera
Planetarium
Script
Weather station
Safety monitor
Focuser
Focus
Magnifier
Capture
Filters
Frame
Rotator
CCD Temperature
Telescope mount
Dome
Switch
Sequence
Video
Visualisation
Messages
Clock
Reset to default → 1 column layout → 2 column layout
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By default many tools are grouped in four tabs on the right of the window. You can adjust the width of the right
panel with the mouse depending on your screen size.

This correspond to the main functionality for a capture session.

Connection and preview
Focusing
Simple capture
Automated sequence

You can use the keyboard F1 to F4 to select one of the tabs.This same function are also available from the main
menu:

The F11 key make the captured image full screen. Press any key to return to the standard display.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tabs.png?id=en%3Adocumentation%3Adisplay
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_menu.png?id=en%3Adocumentation%3Adisplay
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Image window

This menu is active only when a guider or finder camera is defined in CCDciel.

The two options are:

Single Panel to show each camera in the full image area depending on the tab selected on the right. This is the
default.

Multiple panel to show up to three camera at the same time in the image area. It is possible to move the slider
to adjust each camera size. The main camera is show at the bottom, the guider and finder camera share the
top.
This is specifically useful when working with the spectroscope.

The keyboard shortcut Alt+W allow to quickly switch between this two mode.

https://www.ap-i.net/ccdciel/_detail/en/documentation/multipanel.png?id=en%3Adocumentation%3Aimage_window
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Connection Tool

This tool let you connect or disconnect your equipment and monitor the status. It is a mandatory tool as the first
thing to do after starting the program is to click the Connect button.

The Profile button open the Devices setup window to modify or select a profile.

After all the devices are connected you can connect or disconnect an individual device by a click on the short
device name. This may be useful in case of connection issue with a single device.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_connection.png?id=en%3Adocumentation%3Aconnection
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_connection2.png?id=en%3Adocumentation%3Aconnection
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Preview Tool

This tool is to take a preview exposure for focusing or centering purpose.

Set the Exposure time and the Binning to use for the preview.
You can also change the Gain and Offset or the “ISO” if supported and activated in the options
The camera lens F-Stop when using a supported INDI DSLR.

This setting is totally independent of the Capture setting.

Click Preview for a single exposure or Loop to take exposure continuously until you stop it with the same
button. The light change to green when the loop is active.

The Option on top let you select an action to do on every preview image.

Astrometry , every preview image is solved and the current center coordinates are shown at the bottom
of the preview tool:

Image inspection , show the image inspection overlay.

Stack , visible only if you activate the “stacking option” in the preferences
When it is checked, every preview loop frame is added to the previous ones. If available the images are
processed with Dark and BPM. If the option is activated the frames can be aligned.

After you start the Loop, you see the object image to appear progressively in the screen as the number of
frame increase. This function is often use in public demonstration.

You can use the menu File/ Save FITS file... to record the stacked image after you stop the Loop.
A new stack is started when you restart the Loop.

Preprocessing , preprocess every image with the loaded dark and flat frames.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_preview.png?id=en%3Adocumentation%3Apreview
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_preview2.png?id=en%3Adocumentation%3Apreview
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Autoguider Tool

This tool is to interface with the external autoguider.

If you configure to start the autoguider you can directly click the Connect button. Otherwise be sure the
autoguider application is running before to click it.

It show the autoguider status and let you to start or stop autoguiding, force a new calibration, or dither.
This functions are used automatically by the sequence tool when the autoguider is connected.

When using PHD2, check the box on the right to show the guide graph for the last 100 guide frames.

The blue curve represent the RA error, the red the Declination error and the yellow is the star mass.
The vertical scale is in arc-second. It is adjusted automatically for the current range, so don't be afraid by large
apparent variation as long the total range is small.

Below the graph is the current RMS error and RA oscillation index of the last 100 guide frames.

Double click on the graph to clear the graph and start new statistics.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_autoguider.png?id=en%3Adocumentation%3Aautoguider
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_autoguider2.png?id=en%3Adocumentation%3Aautoguider
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Internal Guider

Quick reference guide

The internal guider requires a system calibration once. Click on the calibration and select option 1 or option 2
depending on your mount and driver.

Option 1, first slew the telescope manually to a point in the sky at least 45 degrees away from the celestial pole,
click on the Calibration button and wait till the calibration is finished.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider1.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider_calibration_options.png?id=en%3Adocumentation%3Ainternal_guider
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Once calibration is finished click on the Guide button an check if guiding is satisfactory. Tune the Gain and
Hysteresis settings if required. For the best star detection sensitivity make a master dark for dark subtraction
in guider tab camera.

The trend scale can be adjusted with the up/down button in the graph. The trend unit is default in pixels. With
the checkmark “in the XY-graph you can set the unit to arcseconds. Note that the conversion factor from pixels
to arcseconds is measured during calibration. See documentation below.

Trending is suspended during dithering. Dither events are marked in the trend with a sinus ∿ character.

The XY-graph numerical values indicates the standard deviation of the right ascension (α) and declination (δ)
trends. At a typical seeing conditions you can expect having guiding trends around one arcseconds standard
deviation equals about 0.4 pixels standard deviation at a 2.5 ”/px scale.

A guide log CCDciel_GuideLog_YY-MM-DD_HHMMSS.txt in “PHD2” format is written to the log directory
(Windows: %LocalAppData%\ccdciel\log) and can be analyzed in existing log viewers. To allow open and view
CCDCiel guide logs you have then enter *.txt search pattern in the log viewer file&open menu.

Introduction

The internal guider is used to correct for small errors in a mount’s tracking like any guider software. This guider
is build-in and doesn’t require an external program. The guider takes short exposures with the guide camera.
From the star movements in the images if calculates the drift and send corrections to the mount to compensate.
Note that it can not correct for the fast effects by seeing. So the right ascension and declination will always
fluctuate typically about one arc seconds (or 0.4 pixels at 2.5 “/px) as indicated by the standard deviation
values in the XY-graph.

Note: The tab internal guider will only be visible if you select the internal guider for guiding in preferences, auto-
guiding and a guide camera in device setup, guide camera.

System calibration

Prior to use the internal guider requires a system calibration. During system calibration the guider will take an
image, detect stars and then send guide pulses to the mount in direction East, West, North and South. Then it
takes a second image and measures the movement of the same stars. By this it knows the effectiveness of the
mount guide pulses and the orientation of the guider camera. This calibration takes a few minutes maximum.
The calibration will be done in two phases. As soon the calibration phase one is finished without errors you can
start guiding.

Note that as soon you slew to the other side of the meridian and start guiding a quick second calibration phase
will be executed only to test the pulse direction. For more details se section tab advance.

Once the full calibration is done no more calibration is required unless you change something in your setup like
binning setting, a new camera or telescope. The calibration is saved with the CCDCiel settings.

Set in tab camera the guider exposure time to a value between 3 and 5 seconds. Start a simple looping with the
Loop button and check if the guider camera is in focus and some stars are visible. Stop the loop and go to the
Guider tab and click on button Calibrate. After a few minutes maximum the calibration should be completed.

Backlash calibration: This measure the mount backlash when the declination movement change of direction.
The result is set in the Option tab where you can activate or not the automatic backlash compensation.
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Tab Guider

By default the guide image is show below the control. Check Enlarge guide image if you prefer the multi-
image feature or to show in full in place of the main image. This is useful for focusing the guide camera for
example.

Guiding is started with the Guide button in the first tab guider. Star detection is fully automatic. Even if guiding
is interrupted by a cloud, the guiding software will recover automatically and continue with guiding unless an
other action is programmed in a sequence.

For control there are two settings available for both right ascension and declination.

Gain. This sets the proportional corrective action in % on an offset. For right ascension typically set at 50%. For
declination it is typically set at 50-70 %. If set too high the controller will overreact resulting in a oscillation.
During oscillation the control action bars will show an East, West,East, West.. pattern or North, South, North,
South… pattern. In this case reduce the gain.

Hysteresis. A percentage value. The controller will rely with the specified percentage on the last corrective
action and reduce the new corrective action accordingly. Hysteresis is typically set at 30% for right ascension
and 70% for declination.

The declination controller has an output filter to prevent switching between North and South pulse corrections.
There have to be at least three correction pulses in a different direction before they are passed unless there is a
large correction pulse (>3 x min pulse duration).

In the XY-graph there is small checkmark to change the unit from pixels to arcseconds.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider1.png?id=en%3Adocumentation%3Ainternal_guider
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Tab Camera

In this tab you can set the exposure time and binning. For guiding use exposure times around 3 to 4 seconds.
Note that guiding can only compensate for mount fluctuations and not for seeing effect.

Loop button. The loop button will start a loop taking continuous exposures and is intended for adjusting the
focus of the guider camera.

Stop button. Stops the looping.

Dark button. This will start taking a dark for dark subtraction and store it. During guiding the dark will be
automatically subtracted from the guide image improving star detection for noisy guide cameras.

Exposure Set the guide camera exposure time. Typical set between 3 and 4 seconds.

Binning Binning of the guide camera pixels. In most cases binning set at two works best.

Gain Camera gain. Set high enough for the short exposure used for guiding. See you camera manual.

Offset Use a value high enough to prevent low level truncation, this depend on the Gain.

Temperature If the guide camera has temperature control you can set the value here.

Gamma Stretch factor for your guide camera view. Set this slider in the middle. For more stretching move the
slider to the right.

Luminosity For your guide camera view. Move the slider to the right for more brightness.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider2.png?id=en%3Adocumentation%3Ainternal_guider
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Tab Options

Options

Shortest guide pulse. This setting will ignore guide pulses shorter then the setting. Too short guide
pulses have an more unpredictable effect and the resulting error can become larger then the intended
correction. Ignoring too short pulses will improve the guiding stability. Default is 40 ms.

Longest guide pulse. The longest pulse correction used. This is also the value used to remove the
backlash during calibration. For telescopes with a very long focal length you may have to reduce the
default value of 2500 .

Minimum HFD. Any star with a half flux diameter below this setting will be ignored. This setting can help
to ignore hot pixels. If hot pixels are seen as stars and are annotated during guiding increase this value.
To assist with setting this value the mean star HFD is reported in the log.

Minimum SNR. Any star with a signal-to-noise value below this setting is ignored. If your guide system
detects sufficient stars you could increase the setting to filter out the faintest stars.

Frame size. Normally the full sensor area (=Max) of the guide camera is used for guiding. In case the
guide camera has a very large sensor or the CPU load of the (small) computer used for guiding is too high
you could set a smaller frame size. For example if you specify 100 then the software will download a
100×100 pixels frame only for guiding. As center of the 100×100 frame the brightest star location is
used. Any other star found in this frame is also used for guiding. This smaller frame will reduce CPU load
and download time significantly. For small frame sizes the guider will find and therefore use only one star
(the brightest) for guiding.

Activate solar object tracking. This will allow the telescope to follow a solar object using the two
parameters below. If checked the object will be sharp in the image but stars will form streaks.

Solar object apparent motion. The apparent motion of a solar object like a comet or minor
planet.
Solar object apparent motion PA. The angle of the apparent solar movement CCW from north.
Either filled by the connected planetarium or manual entered.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider3.png?id=en%3Adocumentation%3Ainternal_guider
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The solar motion values can be imported from the connected planetarium program together with
the object position. For this select “update position from planetarium program” in a sequence. Else
the values have to be entered manually from MPC

Use backlash compensation activate the automatic backlash compensation. Use the backlash
calibration to set the initial value. Note this is only a starting point value and the backlash is
automatically adjusted based on the result during guiding.

Disable guiding. This will temporary stop all guide actions but the trend will continue. This can be useful
to study the mount behavior without guiding.

Initial calibration step is the time in milliseconds of the first calibration move. Change only when using
very long focal length with narrow guide image field.

Set guide speed, Set the guide speed or correction rate you want for the RA and DEC axis. If unchecked
the correction rate set in the mount driver will be used. The setting is limited to 0.9 siderial maximum.
The idea behind it to avoid stopping the RA movement for correction. So with the maximum setting of 0.9
a pulsed RA axis correction will either slow down from 1 x siderial rate (15 arcsec/sec) to 0.1 * siderial or
increase to 1.9 * siderial rate. Typical setting for both axis is 0.5 * siderial.

Measure pixel scale [“/px] by stop tracking. The last field of the calibration result contains the
conversion factor arcseconds/pixel. This value is used only for the trend to convert pixels to arcseconds
and does not influence the guiding in anyway. It is measured by setting the pulse guide ratio of your
mount software (e.g EQASCOM) to a pulse rate 0.5x and 1.5x times the normal guide rate. If the option
Measure pixel scale [”/px] by stop tracking is check marked then the conversion factor will be
measured differently during calibration. It will measure the conversion factor by stopping the mount
tracking a few times for a 0.5 second and measure the total drift. It takes more time then the first
method. Both methods should give about the same conversion factor in arcseconds/pixel. A third method
would be to upload a guide image to nova.astrometry.net for solving and enter the found
arcseconds/pixel manually.

https://minorplanetcenter.net//iau/MPEph/MPEph.html
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Tab Advanced

Calibration results

Normally you should not change these calibration values. Just check if East and West values are about the
same and the North and South values are the same. The field Pixel scale estimate [”/px] contains the
measured conversion factor from pixels to arcseconds. See options.

Note: the following is valid for CCDCiel version compiled at 2023-09-4 or later:

There are three types of equatorial mount behavior. Typ “A” is typical for equatorial mounts controlled by
Ascom. Type “I” for mounts controlled by Indi. Type “F for fork mounts and some equatorial mounts where the
software adapt the pulse guide direction to the site of pier.

The calibration goes in two phases. Assume you have an equatorial mount with EqAscom mount control
software and you calibrate your setup with the telescope pointing west. After the calibration you will see this:

Measured at[E/W]: W
Pulse North direction [cal/flipped]: N, ?

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider4.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider_pulse_guiding_directions.png?id=en%3Adocumentation%3Ainternal_guider
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Guiding will work fine. Calibration of the other side of the meridian (east) is outstanding which is indicated by
the “?”

As soon you slew to the other side of the meridan (east) and start guiding a quick calibration phase will be
executed and the following will be shown:

Measured at[E/W]: W:
Pulse North direction [cal/flipped]: N, S

If you start calibration at the east side of the meridian, you will get this result for EqAscom:

Measured at[E/W]: E
Pulse North direction [cal/flipped]: S, N

The last calibration date is reported and any issue. Note that the calibration does not age. Re-calibration is only
required if your system setup changes.

These setting are overwritten after each calibration. The reported “pulse guide directions” are reported in the
log during calibration. For some mount software like GS Server is is required to use the special calibration. This
will simple set the option “pulse guiding is reversed after meridian flip”.
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Guide image

The guider image is displayed similar as the images from the main camera. It is possible to zoom, save, swipe
and solve the guide image.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider_popup1.png?id=en%3Adocumentation%3Ainternal_guider
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Tab Spectroscopy

This tab activate special auto-guiding function for use with a reflective slit spectrograph.

Check Activate spectroscopy functions on top to enable the other options.

Select the best suited centering and guiding strategy depending on the telescope, spectroscope and target.
Prefer the method with astrometry if the field of the guide camera is large enough for a reliable plate solving,
the other method are available when this is not the case.

It is possible to change the guide strategy, and other guide parameters, per target in a sequence using the
initialization script Spectro_SetGuideMethod. See the explanation in the script itself.

In all the case be sure the settle timeout in the auto-guiding options is large enough to allow to move the target
at the slit position.

* Single star, use the brightest star
This method is quick and simple, but limited to bright star without disturbing neighbor.
After slewing, the brightest star in the field of the guide camera is selected, moved at the slit position and the
guiding star.
You can also manually select the right star with a double click. It is possible to parameter the size of the guiding
box and the size of a search box centered on the slit that is used in priority to find the star.

* Single star, brightest star with offset
This method is useful to measure a faint target when it is difficult to plate solve the guide image.
This is the same as above but the guide star is a nearby star, not the object to measure in the slit. The offset x,y
is the difference of position between the target and the guide star.
Use the script Spectro_SetGuideMethod in a sequence to give the guide star coordinates and let the program
compute this offset.
It is necessary to plate solve the guide camera once to get the precise image scale and orientation. The easiest
solution is to point a rich field of star, take a long enough exposure and click Resolve. The calibration remain
valid as long the guide camera is not moved or rotated.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider5.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider6.png?id=en%3Adocumentation%3Ainternal_guider
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* Single star, with guider astrometry
The astrometry ensure the right target is selected on the guide camera, even when a brighter neighbor is
present.
After slewing, the guide image is plate solved the to identify the target star and move it to the slit for guiding.
An additional parameter is the exposure time for the astrometry image.

* Single star, with astrometry, then multistar
This work the same as the previous method, but once the target star is located on the slit the guiding
automatically switch to multi-star for better stability, preventing oscillation around the slit.

* Multistar with guider astrometry
This method allow to measure a faint target but it not require a specific guide star to be know, the astrometry
identify automatically the offset to apply to the multiple guide stars to put the target on the slit.
The guiding is also more stable with multiple guide stars. The main difference with the previous method is how
the target is moved to the slit.
The guide offset x,y are set automatically after the astrometry is done. But you can also adjust them manually,
this is a way to measure a faint target when astrometry is not possible.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider7.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider8.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider9.png?id=en%3Adocumentation%3Ainternal_guider
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Example of guiding a single bright star directly on the slit:

The multi-star method is better suited to measure faint stars or nebula.

https://www.ap-i.net/ccdciel/_detail/en/documentation/spectro1.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/spectro2.png?id=en%3Adocumentation%3Ainternal_guider
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Setting the guide position

Indicate to guide position you want on the slit, this is where the target star is moved using one of the method
above.
You can enter the pixel position directly or click on the image. The calibration light can help to locate the slit in
the dark.
This position is indicated by the large green cross.

When using a spectroscope with multiple slit widths you can set an offset to apply for each slit. This can be used
with fixed photometric slit or with motorized slit.
A script command is available to select an offset. This is done automatically when using the script
UVEX4_Set_Slit, be sure the name in the list match the name in the UVEX4.

Draw slit area on the image
This draw a red rectangle in the image where you can indicate the extension and rotation of the slit.
This is not necessary but this can help in some case.

https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider10.png?id=en%3Adocumentation%3Ainternal_guider
https://spectro-uvex.tech/
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider11.png?id=en%3Adocumentation%3Ainternal_guider
https://www.ap-i.net/ccdciel/_detail/en/documentation/internal_guider12.png?id=en%3Adocumentation%3Ainternal_guider
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Finder camera

This tool is to manage the finder camera, it is visible only when a device is defined and selected in the Slewing
preferences.

You can adjust the exposure parameters, gain, offset, cooling and binning.
The target position is automatically adjusted when the binning change.

It is possible to start a preview loop to adjust the focus and exposure for the camera. Be careful to not let this
loop active when using the same camera for autoguiding.
When the option is checked it is possible to save every images from this camera.

To work more precisely to center a target in the main instrument it need to be calibrated for the offset between
the finder and main instrument.
You can enter manually the X,Y position of the main instrument in pixels or use the Image center button.

But for the maximal precision it is recommended to use the Finder Calibration tool.
Start by pointing the main instrument at an easy to find target, for example a bright star. Be sure it centered at
the exact location you want, for example on the spectrograph slit. Note the J2000 coordinates of this star.
Click the button Calibration measurement.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_finder.png?id=en%3Adocumentation%3Afinder_camera
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Enter the J2000 coordinates you note before, really the coordinate of the star, never use telescope coordinates
here. You can past them from the clipboard, or plate solve the main camera image if this is possible.

Click the button OK, it take an image, plate solve, and compute the offset automatically.

The result is a green cross indicating the center position of the main instrument.

It is possible the cross do not show if the offset is larger than the finder image size. This not affect the precision
if not too wrong but you may want to adjust the finder mechanical pointing to reduce the offset.

You are now ready to point any target in the main instrument from a sequence or using the mount Goto tool.

https://www.ap-i.net/ccdciel/_detail/en/documentation/finder_calibration.png?id=en%3Adocumentation%3Afinder_camera
https://www.ap-i.net/ccdciel/_detail/en/documentation/finder_image.png?id=en%3Adocumentation%3Afinder_camera
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Planetarium Tool

This tool is to control the connection to the planetarium.

It is used to display an astrometry resolved image with the right click menu, or to set the targets coordinates in
the sequence preparation.

If you configure to start the planetarium you can directly click the Connect button. Otherwise be sure the
planetarium application is running before to click it.

In previous version of the program there was a button here to slew to a target selected in the planetarium. This
function is now integrated in the telescope mount Goto button.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_planetarium.png?id=en%3Adocumentation%3Aplanetarium
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Script

This tool let you create or run a script

The scripts can be used to automate some task in CCDciel or to interface with external program for example to
manage your observatory and equipment.

The same scripts can be used as a step in a sequence, or in specific conditions, but this box is a convenient way
to create, test and quickly run any script.

To specify the arguments for the script click the button “…“. This add an input box where you can type the
parameters.

After you click the New button, a prompt ask you for the script name and the programming language you want
to use.

The button Download allow to get script example you can customize.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_script.png?id=en%3Adocumentation%3Ascript
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_script3.png?id=en%3Adocumentation%3Ascript
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_script1.png?id=en%3Adocumentation%3Ascript
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https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_script2.png?id=en%3Adocumentation%3Ascript
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Weather station tool

This tool show the status of the weather monitor, when the light is green the observing condition are good, for
example there is no clouds.

If a sequence is running when the weather go bad, the sequence is paused until the condition return good.

For this tool to work you need to setup the driver and eventually configure the sensors limits

This is related but independent of the Safety monitor.

The Detail button open a window with all the current sensors values:

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_weather.png?id=en%3Adocumentation%3Aweather_station
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_weather2.png?id=en%3Adocumentation%3Aweather_station
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Safety monitor tool

This tool show the status of the safety monitor, when the light is green it is safe to open the observatory for
observing, for example it not rain.

For this tool to work you need to setup the driver and eventually configure the actions to take automatically
when the condition change to bad.

This is related but independent of the Weather station. Some sensors of the safety monitor can be related to the
weather but not only. You can also be interested to monitor the UPS status to be sure you have enough battery
to close the dome in case of power outage.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_safety.png?id=en%3Adocumentation%3Asafety_monitor
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Focuser Tool

With this tool you can control your motorized focuser manually. The control are adapted if you use an absolute
or relative focuser. The temperature is reported if available.

With a relative focuser you can set the desired movement in steps, then click the arrow buttons < > to move
the focuser in or out.

With an absolute position focuser you can set the movement as with the relative focuser, or set an absolute
position and click Move to.

If you select Vcurve in the autofocus preferences the button V-learn is visible to start the V-curve learning.

V curve learning

If you not already do it, it is strongly suggested you use the focuser calibration wizard to set the correct default
parameters before to use this procedure.

Introduction
In case you have an absolute position focuser and want to use the V-curve auto-focus you have to run the V-
curve learning routine first.

The routine steps the focuser and measures at several positions the size (HFD value) of a star. This will result in
a typical V-curve of two lines left and right of the focus point, The slope of the lines will be used later in the
autofocus routine for finding the focus. in this screenshot the routine will step from position 12186+800 to
position 12186-800.

The focus position shown as 12186 should be approximately the best focus position. The maximum offset 800
as shown should be selected such that the HFD value at the beginning and end is above the Start HFD
focus=20 so in this example 25.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_focuser_relative.png?id=en%3Adocumentation%3Afocuser
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_focuser.png?id=en%3Adocumentation%3Afocuser
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Steps to follow
If you are using filters, select the luminance filter. Start an preview loop of about one second exposure and
center on and select a bright star. Run the manual focus aid and check if the peak intensity indication is about
80% of saturation level using the star_profile tool. If not adapt the exposure accordingly or select an other star.

Be sure to stop the preview loop and press the V-learn button

The first time you launch this tool all the settings and graphic are empty.

Indicate the most accurate focus position you can estimate, as you make a manual focus just before you can
click the Get current button here.

Set the Max offset value such that moving to the best focus position plus this offset give a defocused image with
an HFD around 25.

Set the number of step to 30, this is a good value that allow for precision curve. But for the first try you can save
some time by setting it to 10. Just remember to repeat with 30 when you are accustomed with the procedure.

When this three numbers are set click the Learn button on the bottom.

This curve is slowly build up until the procedure is finished. Progress in is also reported in the Log and Star
profile tools.

After the measurement are completed the curve should look as in the screen shot here. The graph shows the
HFD value as function of the focuser position.

Check the following important points before you continue:

The curve must be centered with top left and right about at the same level focus in the middle.
It must extent to about the double of the value of Near focus HFD in the options, indicated by a blue line
here.
The two branches of the V must show a long linear part, specifically on the side of the base of the focus
direction arrow (right on the screen shot).
The branches must not flatten on the top. If you remark such behavior you must reduce the Max offset

https://www.ap-i.net/ccdciel/_detail/en/documentation/learn_vcurve.png?id=en%3Adocumentation%3Afocuser
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value.
The move direction should be such that the learn routine moves the focuser in the same the direction as
you have to adjust the focuser manually during the night when it is cooling down. If not change the
direction in settings. For a reflector (mirrors) type of telescope you typically have to turn the focuser out
if the temperature drops. For a refractor (lenses) type of telescope you typically have to turn the focuser
in.

At the center of the V with the points marked in red.
It is important to exclude this points from the linear regression and you can use the Fit cursor to exclude more
or less points.

When you adjust this cursor, look to maximize the Quality value on the right but also check the aspect of the
black regression line across the green circles. The linearity must be specially good at the intersection with the
blue line.

When you are satisfied by the result click the Save button. This will save the curve parameters and mean
temperature for use in the auto-focus routine.

You can now try the Autofocus in the Star profile tool.
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Focus Tool

With this tool you can check the focus or start an autofocus run. It can be used with motorized focuser or
manual focuser.

If the autofocus mode is set to Planet all the reference to HFD are replaced by Sharpness but the tool work the
same.

Show star profile

When you double click on a star, it's profile and information about it's sharpness are show here.

The top part of the tool show three tabs with graphical representation.

The curve in the Profile tab is a cross-section of the star image intensity.
The narrower it is the better and sharper is the star image.
Take a specific attention to the top of the curve. A flat top indicate a saturation, a rounded top is indication of
bad focus or oversampling.
A curve that enlarge too much on the foot can be an indication of optical issue, light cloud in the sky, or frost on
the lens.

The 2D tab is an extreme zoom on the star image colorized to enhance the view.

The area in green has a level higher than half maximum, it represent a 2D view of the FWHM.
The area in yellow has a level higher than 9% above the background.
The area in red is the foot of the profile curve with a level between 3% and 9% above the background.
Look for the roundness of the image with each color area as narrow as possible.

The Trend tab show the history of the previous measurement.

This is the main help for the manual focus tool, adjust the focuser position to reach the minima of the red curve

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_starprofile1.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_starprofile2.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_starprofile3.png?id=en%3Adocumentation%3Astar_profile
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and the maxima of the green. The HFD is in red and the intensity in green.
Double click on the graphic to clear and start a new graph.
Move the mouse cursor on the curve to show the exact value in the status bar.

Each of this graphic can be opened in a separate window with a click on the button  on the bottom right. This
allow make the graph larger and to monitor both at the same time, even when the Focus tool is not show.

Measurement values

Below are the measurement value for the current star image.

The HFD (Half Flux Diameter) unit is pixels. The history of the previous three measurement is show on the
right.

The FWHM (Full Width at Half Maximum) units are pixels and arc-seconds.

The star peak intensity should not be saturated. And the Signal/Noise ratio must be high enough.

Manual focus

When focusing on a star, make first a preview exposure and double click on a non saturated star you want to
use for focusing.

Click Manual focus aid to start a preview loop on the selected star area, configurable by setting the focus
window size.

Optimum focus is reached when the Sharpness or HFD / FWHM are at minimum value, and the intensity is at the
maximum value.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_starprofile4.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_starprofile5.png?id=en%3Adocumentation%3Astar_profile
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Auto-focus

Click Autofocus to start the auto-focus procedure on the selected star. You must have configured the auto-
focus in advance and if applicable run the V curve learning tool and saved the result.
This button do not execute the action that are specific to autofocusing from a sequence, it will not stop
autoguiding, and not slew to a nearby bright focus star.

When the autofocus is running it show a plot of the HFD or Sharpness versus the focuser position. The aspect of
the plot depend on the selected focusing method. For dynamic focus the pink curve is the resulting hyperbola
fit.

Vcurve Dynamic / Planet Iterative

If you move the mouse over the graph it display the values of the focuser position and HFD.

You can click the button  to open the graph in a separate window and not close the graph when the auto-
focus is completed to let you more time for examination. Click the button again to close the graph.

You can review this graph later using the button View last autofocus.

https://www.ap-i.net/ccdciel/_detail/en/documentation/autofocusgraph2.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/autofocusgraph3.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/autofocusgraph4.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/autofocus_graph.png?id=en%3Adocumentation%3Astar_profile
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Spectrum profile

When you use a spectrograph to image a spectrum it can be useful to quickly show the profile.

Select if you want to show the average or maximum values in the selected area.

Click the Spectral profile button, then mark the spectra area by pressing the Shift key and the mouse left
button.

The profile can be opened in a separate window with a click on the button  on the bottom right.
The scale is show in ADU and pixel because this is totally uncalibrated.

https://www.ap-i.net/ccdciel/_detail/en/documentation/spectra2.png?id=en%3Adocumentation%3Astar_profile
https://www.ap-i.net/ccdciel/_detail/en/documentation/spectra.png?id=en%3Adocumentation%3Astar_profile
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Magnifier Tool

This tool show a magnified part of the image below the mouse cursor.

The zoom level is at least of 2x, or 3x the main image zoom level.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_magnifier.png?id=en%3Adocumentation%3Amagnifier
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Capture Tool

This tool is to take a series of exposures.

Set the Exposure time, the Gain and Offset if supported and activated in the options, and the Binning to use.
Also the camera lens F-Stop when using a supported INDI DSLR.

If you activate the “stacking option” in the preferences you also see a Stacking count value. This is the
number of exposure it accumulate to save in a single file.

Enter an Object name. The object name will be used for the file name and stored in the FITS header at keyword
OBJECT.

Set the Number of consecutive exposures to be taken.

Select the Type of frame: Light for sky exposure. Bias, Dark, Flat for the calibration. This selection will be used
for the folder name and stored in the FITS header at keyword IMAGETYP. If your camera has a shutter, it will be
closed for Bias and Dark.
When BIAS is selected the exposure time selection is disabled and exposure time is set to zero.

If Dithering is required, put a checkmark and enter the image interval. Dithering requires the autoguider to be
connected, configured and guiding from the Autoguider tool before you start capturing.

if Autofocus is required, put a checkmark to the option you want. It is possible to refocus after a given number
of image, after a temperature change, or after a HFD change.
Autofocus must have been configured in auto-focus and V curve learning should have been run and result
saved. For autofocus the telescope will automatically slew to a database star of configured magnitude. The slew
to and return will only work accurately if you have configured the plate solver and slewing options.

Click the Start button to begin the exposure series. The same button can be used to interrupt the series when it
is running.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_capture.png?id=en%3Adocumentation%3Acapture
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Filter Tool

With this tool you can control your filter wheel.

It will show the currently mounted filter.

To change the filter, select one from the list.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_filter.png?id=en%3Adocumentation%3Afilters
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Frame Tool

This tool is to set the sensor area used for imaging.

The first row is the horizontal starting point and width.
The second row is the vertical starting point and height.

You can set the values with the mouse on a preview exposure. Press the Shift key and the mouse left button to
draw the frame.

A list of predefined ROI can be set in the Camera preferences. When the list is not empty it is show here for
selection. Be sure to always click the Set button after changing the selection.

Click the Set button to send the values to the camera.

Click the Reset button to reset to full frame.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_frame.png?id=en%3Adocumentation%3Aframe
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Rotator Tool

With this tool you can control your motorized rotator.

To rotate to a new position type the new Position Angle and click Rotate.

Check Reverse if your optical configuration require to reverse the rotation to match the celestial position angle.

The light is red when the PA field is the rotator raw value without calibration.

Use the right click menu Resolve and sync the rotator to calibrate the rotation angle. After that the light is
green and PA field indicate the celestial position angle.

The last calibration is restored when the rotator is connected.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_rotator.png?id=en%3Adocumentation%3Arotator
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Sensor Temperature Tool

With this tool you can set the camera cooling setpoint and read the current imaging sensor temperature.

To start cooling, enter the temperature Setpoint (target) and click on the Set button. Automatically the Cooler
check mark will be checked.

To stop cooling un-check Cooler

When active the cooler power level, in percent, is show.

If you have configured a maximum temperature rate the button text change to “Cancel” to let you cancel the
current temperature change.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_ccdtemp.png?id=en%3Adocumentation%3Accd_temperature
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Telescope Tool

This tool display the current telescope RA/DEC and Alt/Az position, the side of pier if reported by the driver, the
time to or from the meridian.

You can Park or Unpark the mount using the corresponding button.
The Track button start or stop the mount tracking.

The … button open a virtual handpad to manually move the telescope.

Click the Goto button to move the telescope to a new position.

There is tree way to define the new telescope coordinates:

Enter an object name and click Search to get the position from the internal database, if not found and
you are connected to Internet, it continue the search using Simbad and NED online.
Select the object in the connected planetarium.
Type directly the RA and Dec J2000 coordinates, using decimal value or the hms/dms format with a
variety of separator .

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_telescope.png?id=en%3Adocumentation%3Atelescope_mount
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_telescope3.png?id=en%3Adocumentation%3Atelescope_mount
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_goto.png?id=en%3Adocumentation%3Atelescope_mount
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After the coordinates are entered, the target Azimuth and Elevation is show, so you can check if it is safe to slew
the telescope there.

If you not want a precise centering of the object you can uncheck Use astrometry to refine the position. In
this case a simple Goto is done, without plate solving.

There is an indication the Goto is in progress and you can stop it using the Stop button. Wait 10 to 15 seconds
for terminating all the running tasks.

You can also use the sequence tool to automatically move the telescope at a new location from CCDciel.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_goto2.png?id=en%3Adocumentation%3Atelescope_mount
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_telescope2.png?id=en%3Adocumentation%3Atelescope_mount
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Dome Tool

This tool show the status of the dome.

The first light is green when to dome shutter is open, it is red when closed.

If applicable, the second light is green when the dome is slaved to the telescope position, it is red when not
slaved.

CCDciel do not take any action to initialize the dome, do homing, unpark or open the shutter. But this is checked
before to start a sequence and the dome can be closed and parked at the end of a sequence or when the
condition are not safe.

To initialize and slave your dome at the beginning of the night you can use the software provided by the dome
manufacturer, the ASCOM Dome Control Panel, or the INDI control panel.

If you have a script to initialize the dome you can run it when you launch CCDciel, part of the Startup script. Or if
you prefer in a script you run at the beginning of the sequence.

Only two common function have a button to take an action:

Park to park the dome at the end of the night.
Slave to start mount slaving.

But if you want you can also define in the dome preference to park/unpark the dome along with the telescope
mount.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_dome.png?id=en%3Adocumentation%3Adome
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Switch Tool

This tool show and let you change the status of the different switch.

Each tab correspond to a switch box driver connection defined in the Device setup, Switch.

The list of individual switch is returned by each driver, you can normally configure them in the driver setup.

You can change the state of a switch and click the Set button to send the new value to the driver.

It is possible to right click on a row to copy the exact switch name to the clipboard. This is particularly useful
when writing script to control INDI switches.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_switch.png?id=en%3Adocumentation%3Aswitch
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_switch2.png?id=en%3Adocumentation%3Aswitch
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Sequence Tool

This tool is to control a sequence of exposure on one or more objects.
The current implementation support only sequential processing of the targets, with options for repeating or
skipping some target.

The top grid show the current list of targets. You can enlarge the right pane with the mouse to see all the
column.

You can Load an existing file with a list of target, create a New one or Edit the current list.
Using the Manage button you can Copy, Delete or Edit any sequence present on the computer.

Use the Start and Stop button to start or interrupt a sequence.
The Pause button allow to pause the sequence after the current exposure is completed.

The Restart exposure button abort the current exposure and restart it immediately. To be use if you know for
sure the current exposure will be damaged for any reason.

The Autofocus button force a new autofocus before the next exposure. Can be use in addition of all the
automatic autofocus options.

The Status button show the detail of the current completion status of the sequence.

The Reset button remove all the completion status about the images already done, allowing to restart a
sequence from the beginning.

The button you cannot use at any moment are show in light gray and disabled.

The Run unattended check box control how the program react in case of error.

If not checked a message prompt you on the screen what you want to do. After a delay without response
the operation is canceled.
If it is checked the operation is canceled. Also the termination actions are always taken anyway the
sequence is stopped.

The bottom grid show you the plan for the current target. A plan name ending with a “*” indicate it is modified

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_sequence.png?id=en%3Adocumentation%3Asequence
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from the base template.
When the sequence is running the current target and step are highlighted.

You can edit a sequence while it is running but there is some limitation to ensure consistency and be sure you
get the required number of exposure with the new parameters:

The option “Record restart information” must be checked.
No autofocus or slewing operation are now active.
Current camera exposure continue normally during the editing but a new exposure is not started until the
editor is closed.
Change to future target is applied without limitation.
Change to already complete target is used only for an eventual future repetition.
The following action are taken if the running target is modified:

If changing only the repeat count or the autofocus option the sequence will continue.
If changing the object name, the coordinates or the rotator angle, the sequence is stopped and
restarted with the new parameters.

The following action are taken if the running step is modified:
If changing only the total number of exposure, the dithering or autofocus frequency, the sequence
will continue.
If changing the description, exposure time, frame type, binning, filter, gain or offset, the current
step is interrupted and the sequence is restarted with the new parameters.
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Sequence editor

After you click New or Edit, the target editor let you modify the list of target and the plan steps.

At the top of the screen is the global sequence option, when it start and end, how restart is managed, what
action to take when it start and end.

Then is a list of target with the name, exposure template, coordinates, time constraint. On the right is a list of
additional options for the currently selected target.

At the bottom is the list of exposure steps for the selected target. This give all the capture parameters for each
exposure series. This can be selected from a template or be specific for only this target.

You can adjust the size of the target and exposure steps list depending on your needs.
For a monochrome camera with a filter wheel you typically want 3 or 4 steps for each filter. But with a color
camera a single step is generally used, in this case you can reduce the step list to get more space for more
targets.

https://www.ap-i.net/ccdciel/_detail/en/documentation/sequence_editor.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/sequence_split.png?id=en%3Adocumentation%3Asequence
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Target list

Add a target

A target can be an object you want to take the images, a switch to set, a script to run in the sequence, or a
series of twilight flats. Click the button Insert rows and select the desired option to add the target you want.
When already editing the target list you can add more rows using keyboard shortcut. Use Ctrl+a to add an
empty row, or Ctrl+o to add an object from the internal database.
You can edit a value directly in the table or change the values for a whole column by a click in the column title.
Click the Options button to access more parameters for the target.

When you add a New object, or click the Search menu, the program will search for the object coordinates in
the internal database.

You can use wildcard to list all the matching objects. For example if you enter NGC you will get a list of all NGC
objects in the database. But if you enter NGC100 you will get the coordinates of NGC100 because this object
exists. To get all object starting with NGC100 in the list, you have to enter NGC100*.
If the object is not found in the database, you can enter the coordinates directly or click the Planetarium menu
to select the object in the connected planetarium application.
If you are connected to the Internet you can also select Search online for an extended search in the Simbad
and NED database.
The coordinates can also be selected by plate solving the current image.
Or click the No move menu to clear the coordinates and not change the telescope position.
Note that the target coordinates are always J2000 and could differ from those show by the mount or the
planetarium if they use local apparent coordinates.
Depending on the source the target magnitude can be automatically added, including for different pass band
when using the online search. This magnitude can be used for star auto-exposure for photometry or
spectroscopy measurement.

Select the template exposure plan to apply to this target using the dropdown box, or type a new plan name to
create a new empty plan. If you not want to use a template you can even let it blank. After a plan is selected

https://www.ap-i.net/ccdciel/_detail/en/documentation/target_editor.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/search_object.png?id=en%3Adocumentation%3Asequence
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you can change it's properties on the lower part of this screen.
The template are saved in separated files and can be used by many target list. When the exposure properties
for the current sequence differ from the saved template this is indicated by a “*” at the end of the template
name.

Type the desired value in the PA column to move the rotator at the specified angle.
You can also use the current image orientation after plate solving.
Be sure the rotator is calibrated before to start the sequence if you use celestial PA.

If you are imaging a fast moving asteroid or comet you can check the Update RA+Dec from planetarium
additional option to ask the planetarium for the object coordinates just before the telescope is slewed to the
target.
Be sure the planetarium is connected before to run the sequence.
Check the name of the object is compatible with the search function of the planetarium. No problem if you set
the coordinate and name from the planetarium.
The planetarium must be set to follow the system time, otherwise the asteroid position is not updated.
When using the internal guider you can automatically set the object motion and activate tracking on the object.

Check Use astrometry to refine the position option to refine the telescope position with an astromery
solved control exposure. This ensure the selected object is framed exactly as required.

You can check the Stay in place for autofocus option if you are sure the center of the image field contain
suitable stars for auto-focus. It is recommended to use the Dynamic focus method in this case.
If unchecked, the telescope is first moved to a focus star of the magnitude defined in the auto-focus preference,
and returned to the target after the operation.
The default value for this option is set in the auto-focus preference.

Check Do not change autoguiding state if you want to manage the autoguiding status by script for a group
of target.
By default autoguiding start with the first Light frame, this allow for calibration frame at the start of the plan.

It is possible to run an initialization script before to slew to the target. It receive the following parameters
separated by a coma: object name, plan name, RA, DEC, magnitude. Additional parameters can be specified. If
the script exit with a code of 2 the target is skipped.

Click the button Apply to all targets to set this additional parameters to all the targets of the sequence.

Set the begin and end time

You can set a time range for this target to be imaged, it will wait for Begin time to start. If End time is reach
during the exposure plan it is stopped and the next target is selected.
By default the Begin time can be delayed if the previous target is not complete. You can force a start at the
specified time by checking Mandatory start time in the options on the right. In this case the previous target
can be aborted at this time.

You can enter any time using the format hh:mm:ss, for example 23:45:12, but you can also use the following
special time.

https://www.ap-i.net/ccdciel/_detail/en/documentation/target_tracking.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/target_script.png?id=en%3Adocumentation%3Asequence
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The default is rise or set if the object coordinates are set. This automatically use the rise or set time of the
object above the limits you define in the Observatory configuration, for the date of the observation. Similarly
you can select a time from meridian crossing for the begin or end time. The default is no time constraint if the
coordinates are not set.
To reset to the default values, click the Any time menu.

You can also select to not wait a target that not meet the begin/end condition. In this case it process the other
targets instead of waiting. This can be useful if you have a list of target you repeat over the night using the
option Repeat the whole sequence and take the object when they are visible, or at a given time from the
meridian.

By default a target is started if there is enough time for at least one image before the stop time. This can be
changed by checking Do not start if it cannot be done completely

Check Moon avoidance to not select a target that is too close to the Moon. The default distance is 30°, this can
be modified in the Preferences.

You can also select to skip a target if it is not fully dark night because of the twilight or because of the Moon.
This way you can skip the faint target when the Moon is up and take them at the next repetition after the Moon
is set.

You can also define when the whole sequence start and stop.
Check the box Start at“ or Stop at” and enter the time you want.
Check dusk or dawn to adjust the time for the astronomical twilight for the date of the observation.

Repeat a target

You can set this target to repeat it's whole plan for a number of time at a given interval between two
consecutive start. Set the number of repetition in the target list.
To temporarily skip a target but keep it in the list you can set it's Repeat count to zero.

More option are available in the repeat panel that appear when the count is greater that one. The interval is
measured between two consecutive start of the sequence, this is not the delay to wait. If the interval is smaller
than the total plan duration the next repetition start immediately.
You can also start a preview loop while waiting for the next repetition, this is useful to keep the Sun or Moon
centered if you do an eclipse sequence.

https://www.ap-i.net/ccdciel/_detail/en/documentation/target-start.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/seq-start.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/target_repeat1.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/target_repeat.png?id=en%3Adocumentation%3Asequence
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Set a switch

To set a switch, select the nickname for the switch connection, the switch to modify, and the new value to set.
Set the value to 1/0 for ON/OFF switch or the numeric value for multi-state switch.
A switch can also be added in a plan step, see below.

Add a script

To add a script you just have to select the one you want from the list, or create a new script here.
It is possible to specify the arguments specific for this instance of the script.
A script can also be added in a plan step, see below.

Add an automatic twilight flat

To add an automated flat click the Sky flat button.
Note: to take a dome/panel flat set a standard No move target and use a plan with an image type = Flat.

Set if you want the flat series to be taken at dusk or at dawn, this change the position on top or bottom in the
list.
Select the number of flat to take for each filter, the binning, gain, offset, F-Stop and finally check the filters to
use.
The automatic exposure time must be configured in the flat preferences.
To better manage the changing sky luminosity the filter are selected from the darker to the lighter at dusk, from
the lighter to the darker at dawn. This require you configure the filter exposure factor.
When you add a sky flat to the plan this disable the “Start at dusk” and “Stop at dawn” global options. Do not
re-enable them otherwise the sequence will not run during the twilight and the flat are bypassed.
For the same reason you must be careful the sky flat remain in first or last position in the list. The only
acceptable steps before or after them are script to manage the equipment because they will run in full daylight.
The flat and this scripts are run only one time if the Repeat the whole sequence option is set.

https://www.ap-i.net/ccdciel/_detail/en/documentation/seq_switch.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/seq_script.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/target_flat.png?id=en%3Adocumentation%3Asequence
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Normally a dusk flat can run until the Sun is 16° below the horizon, then it wait until 18° before to start the first
target. When in summer this condition are never set but you still want to make some observation you can set an
absolute start time for the first target after the dusk flat, this allow the flat to run until this time, then the
sequence continue.

Repeat the whole sequence

You can also repeat the whole list a number of time by checking the box at the top of the list. The Infinity button
set a value of 999999.
There is no option for the interval here, the repetition is immediate. But you can add scripts in the sequence to
delay the execution in a more flexible way.

Restarting a sequence

When running a long sequence you may find it not finish totally and you need to restart it to complete the
missing frames. There can be a number of reason for that, maybe you just put too many frames to be taken in a
single night, or you need to stop the sequence to fix something with the equipment.
When a sequence is fully completed, the restart information is cleared so it can be reused later.

To allow a sequence to be restarted at the point it was interrupted you need to activate the Record restart
information option. It is active by default for a new sequence but not for the one created by a previous version
before this function exists to keep the compatibility.

Normally you want this option to be active. A typical case to disable it is if you run a survey, for example for
asteroid or variable stars, and want to always restart the same full sequence every night even if it not complete.

The option Clear restart information on repeat define how Repeat the whole list manage the completion
of individual targets.

If checked (default option), the targets already completed on the previous pass are re-done completely
from the start. If the target plan define 5 images of M13 and the number of whole list repetition is 10 you
end with 50 images of M13.
If unchecked, the target completion is not reset when the whole list is repeated. This meant that targets
already completed are not done again. In the previous example you only get 5 images of M13. A typical
use is a “Messier marathon”, you want 1 image of every Messier object taken when the elevation is high
enough. For that you repeat the full Messier list of targets all the night and not redo the objects
previously taken, only the new that are now high enough.

You can force a sequence to restart from the beginning by using the Reset button in the Sequence tool.

https://www.ap-i.net/ccdciel/_detail/en/documentation/sequence_repeat.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/sequence_completion.png?id=en%3Adocumentation%3Asequence
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Start options

The start options will be executed immediately after the sequence start.

Cool the camera: The cooling of the camera is typical configured to start after camera connection and is the
preferred option for most users. If not (to save power) the cooling will start when the sequence becomes active
and start imaging. If the above option “Cool the camera” is checked the camera cooling is started at the
beginning of the sequence as configured even if it is waiting for reaching “begin time”.

Unpark the telescope: The mount/telescope is unparked when the sequence is started. Note in the dome park
slaving configuration it is possible to keep dome closed until “begin time” is reached.

Run a script: to do more action when a sequence is started.

Termination options

You can configure the action to take after the sequence is finished normally.

Select the actions you want from the list, for more actions you can use a script.
In case of error an additional script can be configured for more actions. A selection box to select the script is
show when the action is checked.

This actions are not taken when you voluntarily stop a sequence with the Stop button and the Unattended
checkbox is not checked.

Beware that Do nothing let the mount tracking after the sequence is terminated.

https://www.ap-i.net/ccdciel/_detail/en/documentation/start-options.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/termination.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/termination2.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/termination3.png?id=en%3Adocumentation%3Asequence
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Import a mosaic from the planetarium

You can import a mosaic definition from the HNSKY or Cartes du Ciel/Skychart planetarium. Be sure you connect
to the planetarium before you start.

Take a preview image, plate solve and send the image frame to the planetarium. This ensure the
planetarium know your exact CCD frame size and orientation.
Use the instruction from the planetarium software HNSKY or Skychart to create the mosaic.

Give a name to the mosaic frame, this will be the target name prefix in the sequence.
In the CCDciel sequence editor, click the “Insert rows” button, select the menu “From planetarium”.

For HNSKY select from the right click menu “Export via server / All frames”.
For Skychart click the button “Send via server”. You can also save the mosaic to a file, then use the menu
“Import mosaic”.
Close the planetarium import tool and adjust any option you want to take the images.

You can also use this import tool to input as many object you want from the planetarium, as long this tool is
open any click in the planetarium insert a new row in the sequence.

Import observing list from Skychart

You can import an observing list from Cartes du Ciel / Skychart or other software that produce file in the same
format.

Click the Insert rows button and select the corresponding menu to open the observing list you have saved
from Skychart. All the objects from the list are imported with their coordinates.
The other options like the plan to use, the astrometry or the autofocus options are copied from the current
target. If you import to an empty sequence you can set the template globally afterward by a click in the ”+“
column header.

https://www.hnsky.org/help/uk/hnsky.htm#cross
https://www.ap-i.net/skychart/en/documentation/mosaic_tool
https://www.ap-i.net/ccdciel/_detail/en/documentation/mosaic_cdc.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/mosaic_import.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/mosaic_cdc2.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/skychart/en/documentation/observing_list
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Import and export targets in CSV file

It is possible to import a list of target using the button Insert rows / Import CSV.
This can be a file with all the column produced by the Export function, or a minimal file with only the object
name and coordinates.

To export the current target list to a CSV file use the same button / Export CSV. This include the same column
as the table view.

Manage the target list

You can add a new target, switch, script, flat or delete one with the buttons at the top of the list.
A value can be change for a whole column by a click on the ”+“ in the column header.
The list can be sorted by name, RA or DEC by a click in the “v” column header.
You can also change the target order with a mouse drag/drop on the first column of the list.

The target list is saved when you click the Save or Save as.. button at the bottom right of the window.

https://www.ap-i.net/ccdciel/_detail/en/documentation/target_order.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/target_save.png?id=en%3Adocumentation%3Asequence
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Plan steps list

Use the plan list to specify the exposure steps to take of a target.

Add a step

A click to the Add Step button show a menu to select Capture, Script or Switch.

Capture step

Give a description of the step that can be used to make a subfolder.

Set the type of frame, exposure time, binning, filter, number of exposure, gain, F-Stop, autofocus and dither as
in the Capture tool.

Check corresponding box if you want to run an auto-focus at the start of this step.
For long steps you can also repeat the auto-focus after a given number of images or when the temperature
change, as configured in the focus options.

The Gain and Offset column are only visible if supported by the camera and the option to manage the gain from
the program is checked.

The Stack column is visible if you activate the “stacking option” in the preferences. This is the number of
exposure it accumulate to save in a single file.

In this case it will save 8 files with the R and G filter, each file is a stack of 10 x 30 seconds exposure.

For star photometry or spectroscopy you can use an automatic exposure time based on the star magnitude ba
selecting a specific profile. This is particularly useful for large survey when it can be tedious to manually set an
exposure time for each star. Do not try to use this function for DSO, this not work!

To define an autoexposure profile for your equipment click the button Star auto-exposure at the bottom.

https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_editor.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_stack.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_autoexposure.png?id=en%3Adocumentation%3Asequence
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Select a name for the profile and set a reference exposure and magnitude, i.e. how long you need to expose for
a star of this magnitude.
Bellow set the maximum allowable exposure time for the case the target magnitude is too faint.
At the bottom you can test the setting with different magnitude and look at the resulting exposure time.

Script step

When adding a script, set the script name and parameters in the box:

Switch step

When setting a switch, set the switch nickname, name and value in the box:

Both script and switch appear as special entries in the plan.
This can be saved in a template along with the other steps.

Manage the steps

You can add a new step or remove one with the two button at the top of the list.

You can change the steps order with a mouse drag/drop on the first column of the list.

https://www.ap-i.net/ccdciel/_detail/en/documentation/autoexposure.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_script.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_switch.png?id=en%3Adocumentation%3Asequence
https://www.ap-i.net/ccdciel/_detail/en/documentation/plan_switch2.png?id=en%3Adocumentation%3Asequence
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The template is saved when you click the Save template button and select an option from the menu.

Save and apply to targets save the template file and update all the targets using the same template with the
new exposure parameters.

Save template save the template file, the other targets are not modified.

Save template as… save the template file with a new name.

If you no more need this template you can delete it with the Delete template button. This not modify the
exposure parameters for the current target or any other targets.

https://www.ap-i.net/ccdciel/_detail/en/documentation/save_template.png?id=en%3Adocumentation%3Asequence
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Video tool

This tool is only available for INDI camera with video stream capability, specifically on Linux and Mac.
Because of the way INDI record the video, the file is written on the computer running the INDI server.

You must first set the preview rate in the Preview options. Do not use a too high value as this preview frames
have to transit by the network.

The video tool appear in a new tab after the Sequence if the INDI camera you connected as video stream
capability.

Select the Encoder to use for the images frames. Use RAW for best quality or MJPEG for quick preview.
With DSLR LiveView the MJPEG option give a color preview of the full frame, the RAW option give a raw central
crop you can use for planetary imaging.

Select the exposure range, depending on the camera it can be a direct input box or a the drop down box and a
cursor.

Depending on the camera there can be other settings for the Gain, Gamma or Brightness. The More
settings button open the INDI client for this camera, this let you to access some properties specific to your
camera.

Two more drop down list are to select the Image size and the Frame rate.

Check Preview on top to visualize the frames without recording.

Next are the video capture options, you can limit the video Duration in seconds or the number of Frames.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_video.png?id=en%3Adocumentation%3Avideo
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The Object name is use as a part of the filename.
The Directory where to save the video file on the computer running the INDI server.

Click the Start to start recording. The recording to the video file is always directly done by the INDI driver
without any action from CCDciel.

Use the Stop button if you want the stop the recording before the planned end.



CCDciel documentation

127

Visualisation Tool

This tool is to control the aspect of the preview image. None of the setting here have any influence to the image
saved as a FITS file. They are only to help you to view the most of detail on the single raw images.

On the bottom, a cursor control the relative range of histogram drawing, using 90% to 100% or the active
histogram range. Reducing the histogram range make the image lighter and help to see the faint nebulae in the
image.

The top is separated in two part, an histogram of the image and the control buttons.

On the histogram you can move the high (green) and low (red) clipping bar with the mouse.
You can also directly edit the low and high threshold by moving the mouse cursor to the top left or right to
display the edit box.

Bellow the cursor, the numeric value let you adjust the Gamma for the display. This also help to better see the
faint part of the image but without saturation of the bright area. A value of 0.45 in this box allow to convert a
linear image to a display image with a standard gamma of 2.2.

The next button  switch the histogram view between full range and active range.

The button  show a negative image that can help to see faint details.

On the next row, the four button are preselected zoom level for the image.
You can also get other zoom level using the mouse wheel rotation
When the zoomed image is bigger than the screen you can move it with the left mouse button.

On the bottom row you can mirror the image  horizontally and  vertically,

The  bull eye button show the mark on the image.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_visu.png?id=en%3Adocumentation%3Avisualisation
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_visu2.png?id=en%3Adocumentation%3Avisualisation
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It is also possible to temporarily show a large cross at the cursor position by pressing the Alt or Meta key at the
same time as the left mouse button.

If the image is plate solved it also display an arrow with the North and East direction and print the image
rotation angle.
A focus star can be automatically selected in the square that circumscribe the external circle.

Finally the  button let you check for saturation in the image.

The overflow in the highlight area is marked in pink.
The clipped shadows area is marked in yellow.

https://www.ap-i.net/ccdciel/_detail/en/documentation/bulleye.jpg?id=en%3Adocumentation%3Avisualisation
https://www.ap-i.net/ccdciel/_detail/en/documentation/large_cross.png?id=en%3Adocumentation%3Avisualisation
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_visu3.png?id=en%3Adocumentation%3Avisualisation
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You can define the clipping level for your camera in ADU in the preferences, the default are 0 and 65535.

When using the option to not display the images during a capture, a new button  appear on the right,
allowing to temporarily show the captured images.
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Logging

This text window will report all messages (Log) from the program and drivers.

The top left button allow to select the level of detail to display.

If configured, the messages (log) will be also stored in a text log file for further study. It essential to use this
option if you let the program run unattended.

The file location is:

Linux:
/home/[your user name]/.config/ccdciel/Log

Windows:
C:\Users\[your user name]\AppData\Local\ccdciel\log

Note that above folders are typically hidden.

The Help menu provide a quick access to this folder and the current log file.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_log.png?id=en%3Adocumentation%3Amessages
https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_log2.png?id=en%3Adocumentation%3Amessages
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Clock

This tool show the current local time in the status bar.

This is useful if you not have another clock on the computer screen but you may want to disable it if you use
some remote desktop display on a slow network.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tool_clock.png?id=en%3Adocumentation%3Aclock
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Tools Menu

The Tools menu include some useful tools:

View FITS header
Image statistics

Measure telescope cone error

Polar alignment without pole visibility

Polar alignment near the pole

Inspection and collimation

Focuser calibration

Sensor analysis
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View FITS header

From the menu Tools → View header.

Show the FITS header of the current file.

https://www.ap-i.net/ccdciel/_detail/en/documentation/fitsheader.png?id=en%3Adocumentation%3Aview_fits_header
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Image statistics

From the menu Tools → Image statistics

Show statistics about the pixel values in the current image.
When the button Select area is checked you can select an area of the image to get the statistics from.

This show the following:

Pixel count: the number of pixel used to compute the statistics.
Min: The minimal value of a pixel.
Max: The maximal value of a pixel.
Mode: The mode of the image, i.e. the most frequent value. This is a good estimate of the sky
background.
Median The median value of the image.
Mean: The mean value of all the pixel.
Std.Dev: The standard deviation from the mean value.
Mean2: The sigma clipped mean value.
Std.Dev2: The sigma clipped standard deviation.

If the image is plate solved the following values are added:

Center RA2000: The J2000 right ascension of the image center.
Center Dec2000: The J2000 declination of the image center.
FOV: The image size width x height in minutes of arc.
Image scale: The image scale in second of arc per pixel.
Actual focal length: The real focal length of the instrument, can be used to update the value in the
Preferences.

https://www.ap-i.net/ccdciel/_detail/en/documentation/img_stat.png?id=en%3Adocumentation%3Aimage_statistics


CCDciel documentation

135

Measure telescope cone error

The “measure cone error” tool measures the slew error after a meridian flip. This slew error will be twice the
cone error.

Cone error is a misalignment of the telescope axis away from or towards the plane of the mount puck. The
front/light inlet of the telescope is either pointing slightly inwards towards the puck or outwards away from the
puck.

The cone error results in less pointing accuracy of the telescope and continuous drift during guiding. It is typical
to have a cone error up to 30 arc minutes but it is better reduce it to a lower value with some shims, sheet-
metal ring or a few layers of thick aluminum foil.

With a significant cone error, polar alignment using the drift method will not work.

https://www.ap-i.net/ccdciel/_detail/en/documentation/cone_error2.png?id=en%3Adocumentation%3Acone_error
https://www.ap-i.net/ccdciel/_detail/en/documentation/cone_error1.png?id=en%3Adocumentation%3Acone_error
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This tool will only report accurately if mount modelling is switched off or not available.

The “measure cone error” slews the telescope to two points high in the sky east and west of the meridian at the
same declination position. While crossing the meridian the telescope will flip. At both positions an image is
taken and solved. The distance between these two solved positions is compared with the distance between the
two mount positions as reported by the mount. The difference is reported as slew error and will be twice the
cone error. To assure no other effects are measured it is possible to measure first east then west or the other
way around. The reported slew error values should be very equal.

If the reported value is positive then the situation is as above sketch. To correct the positive error the telescope
front has to move to the puck. If the reported value is negative then the telescope front has to move away from
the puck.

Exposure and binning settings are taken from the preview menu.

The cone error is explained in this video

When using multiple camera in CCDciel an additional prompt ask the camera to use for the measurement.

This allow to first correct the cone error on the main instrument, then to repeat the measurement with another
camera to adjust the guider or finder so they point at the same location relative to the main instrument on both
side of the meridian.

https://www.youtube.com/watch?v=WatdQlPp22Y
https://www.ap-i.net/ccdciel/_detail/en/documentation/cone_error3.png?id=en%3Adocumentation%3Acone_error
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Polar alignment without pole visibility

This tool is designed to be as quick and easy to use as possible to help to refine the mount polar alignment. It
can be run on any part of the sky and not require pole visibility.

Before starting this tool the mount must be pole aligned as good as possible. The camera must be connected
and the mount initialized to allow to slew and report it's coordinates.
It is very important the observatory location is set in the preferences and the computer time is set with a
reasonable precision.
The camera uses the Slew setting exposure, binning and filter. Be sure this setting give a fast enough image
refresh.
If slewing is configured to use a finder camera, this finder is also used for the polar alignment.

To start the procedure select the menu Tools → Polar alignment, without pole visibility

Select where you want to run the measurement. It is recommended to use one of the predefined option, but if
all point to obstructed part of the sky you can define the azimuth and altitude of the two measurement points.

When ready click the Start button.

https://www.ap-i.net/ccdciel/_detail/en/documentation/align1.png?id=en%3Adocumentation%3Apolar_alignment_2_points
https://www.ap-i.net/ccdciel/_detail/en/documentation/align2.png?id=en%3Adocumentation%3Apolar_alignment_2_points
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The telescope will move to the two points, take a preview image and plate solve.

After it complete, you have the choice to directly go to the adjustment screen with the Next button or to move
the telescope a bit to show a bright star or an area that is more easy than the current field.

If you click Move the program start an image loop and you can move the telescope with the handpad until it
show a bright star. When this is done click Continue.

Then it show the correction to do on the mount in both the horizontal and vertical axis.

The direction are to be interpreted this way:

move East : is moving the mount horizontal knob so the top of the polar axis move to the east.
move West : is moving the mount horizontal knob so the top of the polar axis move to the west.
move Down : is moving the mount vertical knob so the top of the polar axis move down.
move Up : is moving the mount vertical knob so the top of the polar axis tube move up.

https://www.ap-i.net/ccdciel/_detail/en/documentation/align4.png?id=en%3Adocumentation%3Apolar_alignment_2_points
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Adjust the luminosity slider so the sky background is dark enough to clearly see the guide lines.
Move the green circle at an extremity of the line to a star you can easily recognize later, for example a star that
is part of a small figure, or the brightest star on the image.
You can zoom on the image with the mouse wheel to help to center the star. Press the Ctrl key if you need to
move the image instead of the overlay.
It is also possible to double click to select the star nearest to the mouse cursor.
When the overlay is in place, click the button Lock overlay, this way you can zoom and move the image
without the risk to move the overlay.

Now the goal is to move the star to the pink circle at the other extremity of the line by using only the mount
polar axis adjustment knob. To help with this movement the azimuth movement is represented by the blue line
and the altitude movement by the red line.

During all this procedure you can change the exposure time of the preview but do not change the geometry of
the image, no change of binning or ROI!

After the star reach the pink circle you can close this screen, the alignment procedure is complete.

When using a plate solving application that is fast enough, for example ASTAP, you can check the box Plate
solve to update the correction

This continuously update the correction value in arc minutes for both direction.

https://www.ap-i.net/ccdciel/_detail/en/documentation/polar_astrometry.png?id=en%3Adocumentation%3Apolar_alignment_2_points
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Polar alignment near the pole

This tool is designed to help to refine the mount polar alignment. It require the telescope ra axis to be pointed
within 2 degrees of the celestial pole, if this is not possible use the method without pole visibility.

Before starting this tool the mount must be pole aligned as good as possible. For the northern hemisphere you
could start by aiming at the star Polaris which is about 40 arcmin from the true celestial pole.

The camera uses the Slew setting exposure, binning and filter. Be sure this setting give a fast enough image
refresh. If slewing is configured to use a finder camera, this finder is also used for the polar alignment.

To start the procedure select the menu Tools → Polar alignment, near the pole

In the first window, select if you want to align on the true or refracted pole. The default is the refracted pole if
the observatory latitude is higher than 30°. The true pole give better result in the tropical zone.

If the mount can slew select “Automatic”. This generally requires an initialized handpad and a star alignment.
The mount will later automatic slew to a position 2 degrees from the celestial pole,

if you prefer to move manually or if the mount is not connected to the program then select “Manual”. Point the
telescope manually to a declination of about 88 degrees, so 2 degrees ( or more for large errors) from the pole.

Select if the mount will move West or East direction, and the movement between two measurement. The mount
will move two time this amount, so be sure there is no obstacle in the path.

If the mount cannot slew automatically, because it is a non-goto mount or the handpad is not initialized yet, you
can select to move the mount manually.

When ready click the Start button.

https://www.ap-i.net/ccdciel/_detail/en/documentation/polar1.png?id=en%3Adocumentation%3Apolar_alignment
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The next screen shows the progress of the measurement, take exposure, plate solve, move to next position.

If you select the automatic telescope move you have nothing to do until this step is complete.

In the case of manual move, it will stop at each “Rotate the telescope” step.

Move the telescope only along the RA axis by about 15° to 45°
It is very important to not change the declination and to do the two rotation in the same direction.
But it is not important if the amount of rotation is not the same for the two rotations.
You can move the telescope using the handpad or manually by losing the RA axis knob. When the telescope is
stable in the new position you can click the Continue button.

After all the steps are complete it change to the final screen. Do not close this window until you complete the
mount adjustment.

https://www.ap-i.net/ccdciel/_detail/en/documentation/polar2.png?id=en%3Adocumentation%3Apolar_alignment
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This show the result of the computation with the current mount axis direction and the total polar alignment
error. Be careful at the value after the +/- sign, if it is not zero this indicate an inconsistency in the
measurement.

Then it show the correction to do on the mount in both the horizontal and vertical axis.
The direction are to be interpreted this way:

move East : is moving the mount horizontal knob so the front of the telescope tube move to the east.
move West : is moving the mount horizontal knob so the front of the telescope tube move to the west.
move Down : is moving the mount vertical knob so the front of the telescope tube move down.
move Up : is moving the mount vertical knob so the front of the telescope tube move up.

At the same time the camera start a loop of exposure and an overlay is show on the image.

Adjust the luminosity slider so the sky background is dark enough to clearly see the guide lines.
Move the green circle at an extremity of the line to a star you can easily recognize later, for example a star that
is part of a small figure, or the brightest star on the image.
You can zoom on the image with the mouse wheel to help to center the star. Press the Ctrl key if you need to
move the image instead of the overlay.
It is also possible to double click to select the star nearest to the mouse cursor.
When the overlay is in place, click the button Lock overlay, this way you can zoom and move the image

https://www.ap-i.net/ccdciel/_detail/en/documentation/polar3.png?id=en%3Adocumentation%3Apolar_alignment
https://www.ap-i.net/ccdciel/_detail/en/documentation/polar4.png?id=en%3Adocumentation%3Apolar_alignment
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without the risk to move the overlay.

Now the goal is to move the star to the pink circle at the other extremity of the line by using only the mount
polar axis adjustment knob. To help with this movement the azimuth movement is represented by the blue line
and the altitude movement by the red line.

During all this procedure you can change the exposure time of the preview but do not change the geometry of
the image, no change of binning or ROI!

After the star reach the pink circle you can close this screen, the alignment procedure is complete.

In the case the alignment error is bigger than the camera sensor size you cannot show the pink circle on the
image. In this case move the star to the point the green line exit the image field. Then redo the full procedure
until the polar error is small enough to show the two circle.

When using a plate solving application that is fast enough, for example ASTAP, you can check the box Plate
solve to update the correction

This continuously update the correction value in arc minutes for both direction.

https://www.ap-i.net/ccdciel/_detail/en/documentation/polar_astrometry.png?id=en%3Adocumentation%3Apolar_alignment
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Inspection and collimation

This tool can help to inspect the image and get a good collimation for the telescope optic. It include the image
HFD inspection and two collimation method, centering the ring of a defocused star, or examining the
deformation in the corner of the image using a 9 panel display.

Before any attempt with this procedure you must carefully read the telescope documentation, Beware that
doing it wrong can make the secondary mirror to fall on the primary.

Image inspection

This panel allow to measure the median HFD value, sensor tilt and curvature.

Select the method to display the result:

Octagon based on HFD values at the center and eight peripheral area.
Triangle with adjustable orientation to match the tilt corrector screw.

Click Inspect to analyze the current image.
Click Start to start a preview loop and analyze each image.

The routine will detect and annotate the stars with their HFD value and plot a tilt and Off-axis aberration
(curvature) indicator in the image.

https://www.ap-i.net/ccdciel/_detail/en/documentation/collimation4.png?id=en%3Adocumentation%3Acollimation
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In the log the following will be reported:

Image median hfd which is an excellent indicator of the quality of focusing. The lower the value the better the
focusing, the sharper the stars are. The value is also depending on the astronomical seeing and the quality of
the optics.

Sensor tilt as the HFD difference between the best and worst corner median values. In addition as a graphical
indication it draws a trapezium in the image based on the four median values.
There can be some variation in images of the same series, so a tilt of a few tenths looks normal but anything
more indicates a camera mounting problem.

Off-axis aberration as the HFD difference between the center and the corners of the image. This is an help to
adjust the optimal distance between the field flattener and the camera. But be careful to first remove tilt and
get a precise focus at the image center, otherwise this value is meaningless.

https://www.ap-i.net/ccdciel/_detail/en/documentation/tilt_test.jpg?id=en%3Adocumentation%3Acollimation
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9 panel image

This panel allow to display a zoomed image of the corner and center of the image to help to detect the
aberration. This can be used to adjust a comma corrector, a tilt adapter, or to collimate a RC telescope.

Load an existing image for analysis and click the Set button or click the Start button to loop from the camera.
Adjust the Zoom and Margin offset to clearly see the aberration with enough stars in each box. After every
change click the Set button to apply.
Return to the normal display using the button Stop or by closing this window.

https://www.ap-i.net/ccdciel/_detail/en/documentation/collimation3.png?id=en%3Adocumentation%3Acollimation
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Single star

This method is to adjust the final collimation of a Newtonian or SCT.
To start, point the telescope to a bright star, then select the menu Tools → Collimation.
Click the Center button.
This start a preview exposure loop. Center the star in the bull eye, defocus enough to see the concentric ring in
the image, adjust the exposure time so the image is not overexposed but high enough to mitigate the seeing
fluctuation.

When ready click the Start button.
This crop the image to the size defined for the focus window and draw concentric circle centered on the star.
You can adjust the Number of circles so they match the main ring in the star image.

Slowly adjust the position of the star in the image field using the telescope fine movement (guide speed) until
all the circle are concentric. The program try to automatically follow the star by modifying the camera ROI but
this cannot work if you abruptly move the star out. When this is done the star is in the telescope optical axis.

https://www.ap-i.net/ccdciel/_detail/en/documentation/collimation1.png?id=en%3Adocumentation%3Acollimation
https://www.ap-i.net/ccdciel/_detail/en/documentation/collimation2.png?id=en%3Adocumentation%3Acollimation
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Now click the Center button and move the star to the image center using only the telescope collimation screw
(main mirror for Newtonian, secondary for SCT). This way you make the optical axis to match the center of the
image.

If the initial offset is larger than the camera FOV, place the star in the border of the image where the ring are
the most concentric, process as above, then retry to finish the collimation.

If no circle are draw after you click the Start button this is probably because the focus window is to small for the
size of the defocused star. In this case refocus a bit to make the star circle smaller or increase the size of the
focus window.
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Focuser calibration

This function help you to set the auto-focus parameters specific to your focuser, telescope and camera because
it is not immediately evident what to set for all this numbers.

The principle is you start by centering and manually focusing a star that is used by the procedure to find how
the star diameter change with an increasing movement of the focuser.

At the end it propose you new auto-focus parameters you can save to the configuration.

To start the procedure select the menu Tools → Focuser calibration

The first screen give you information about centering, focusing and correctly exposing the star.
Do it now, before to click the Next button.

The next screen let you select the direction you want to move the focuser in the auto-focus operations.
Depending on you setting the focuser can work better when moved in or out of focus. If you want to configure
the temperature compensation, set the direction to compensate when the focuser cool down during the night.

If the focuser need a backlash correction you can enter the value now. But be sure to let it disabled if the
compensation is done elsewhere.
Indicate the number of additional steps to use for the compensation, this must be greater than the actual
backlash, don't hesitate to use a large value.

https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal1.png?id=en%3Adocumentation%3Afocuser_calibration
https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal2.png?id=en%3Adocumentation%3Afocuser_calibration
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Then it offer you to change two measurement parameters, the maximum defocused star diameter (HFD) it will
try to reach, and the initial movement of the focuser in step.

You can change the first parameter if you know what your equipment can achieve, otherwise keep the default
and follow the recommendation if the first try fail.
The minimum movement is not really important to change because any way the program will double the value
until it see enough change in the star diameter. You can just save a few time if you know your focuser need
more steps even for fine focus.

It start slowly, just wait until it reach the maximum diameter.
Then it start to move the focuser on the opposite side, much quickly as it know what speed to use.
You can check if the curve is symmetrical and as not evidence of gross error.

Now the program know how your focusing system react.
You can review the parameters before to click Next to save them to the configuration.
Later you can view or change this values in the auto-focus parameters.

https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal3.png?id=en%3Adocumentation%3Afocuser_calibration
https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal4.png?id=en%3Adocumentation%3Afocuser_calibration
https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal5.png?id=en%3Adocumentation%3Afocuser_calibration
https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal6.png?id=en%3Adocumentation%3Afocuser_calibration
https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal7.png?id=en%3Adocumentation%3Afocuser_calibration
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The procedure is completed and you can close this window.

You can now open the auto-focus parameters and without changing any of the detailed parameters you can
change the auto-focus method depending on your preferences.

Select also how you prefer to run the auto-focus automatically as part of a sequence.
You have the choice to stay at the current target position and use whatever stars are present, or slew to a
nearby star of fixed magnitude.
Later you can also alter this choice target by target in the sequence editor.

https://www.ap-i.net/ccdciel/_detail/en/documentation/foccal8.png?id=en%3Adocumentation%3Afocuser_calibration
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Sensor analysis

This is a special tool to analyse automatically your camera read noise, sensor gain, well capacity and linearity.
You will just need a flat panel or substitute in front of your telescope and a cap to cover your telescope to make
darks. Analysing will go fully automatic. Halfway the process the tool will ask you to remove the flat panel and
cap the telescope for darks.

It is important that CCDCiel has access to your camera gain setting in menu Edit, Preferences, tab Camera and
check mark option “Manage gain and Offset if available”. After using the tool you can uncheck it.

The recorded data values can be copied to a spreadsheet/word-processor.

In the main windows you can set the gains to test. If the camera allow to set the offset it is very important you
set a value as low as possible that not result in any truncation for the range of gains to test.
The linearity test is optional and can be set for one gain (in screenshot at camera gain 120) .
The dark current test is also optional and can be set for one gain ( in screenshot at camera gain 120). To
increase the accuracy your could choose to repeat the number of tests from one to three.
At the bottom of the menu there is a setting (400 sec) for the duration of the dark current test. For older
cameras you can set it lower at 100 or 200 seconds. For modern cameras with a very low dark current it could
be required to increase it to 1000 seconds. The dark current test will abort is the difference recorderd is two or
less adu.

https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis1.png?id=en%3Adocumentation%3Asensor_analysis
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Actual gain in e-/adu:

Read noise for each gain. One line is for the pure read noise. The second line is for the combination of read
noise and random telegraph noise (RTN), also called salt & pepper noise. The read noise is calculated as follows

read noise including RTN := stdev(bias1-bias2)/sqrt(2)

read noise excluding RTN := stdev2(bias1-bias2)/sqrt(2) where stdev2 is using sigma clipping to remove hot
pixels.

https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis2.png?id=en%3Adocumentation%3Asensor_analysis
https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis3.png?id=en%3Adocumentation%3Asensor_analysis
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Full well capacity:

Charge persistence (cmos image lag). The bars indicate the median dark pixel values. This dark series is taken
directly after the last flat. If the first bar is higher then the second bar (both are for the same camera gain) then
there is some minor charge persistent. So there is some charge left from the previous flat image. The height &
values of the other bars can be influenced by the gain setting.

Dark current. The red line indicates the total measurable noise including the random telegraph noise. For some
modern cameras it could be required to increase the default dark exposure from 400 up to 1000 seconds. The
dark current test will take two dark so the duration will double the exposure time.

https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis4.png?id=en%3Adocumentation%3Asensor_analysis
https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis5.png?id=en%3Adocumentation%3Asensor_analysis
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Camera info from the camera driver:

Note: The RTN, Telegraph Noise is measured in the difference of two darks. It is defined as all pixels with a value
above 3.0 sigma of the the noise. For a clean Gaussian noise only 0.27% of the pixels exceed this value. Any
more then 0.27% is defined as RTN. The noise sigma value is determined using a sigma clip routine.

https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis6.png?id=en%3Adocumentation%3Asensor_analysis
https://www.ap-i.net/ccdciel/_detail/en/documentation/analysis7.png?id=en%3Adocumentation%3Asensor_analysis
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Right click menu

The main menu Image, or a right click on the preview image to show the following menu:

Plate solving functions

The image will be resolved (plate solved) and if successful, the image position, pixel size and orientation will be
saved in the FITS file.
Approximate coordinates are read from the FITS header to speedup the process. If this coordinates are not know
you are prompted to enter an object name or the coordinates at the center of the image.
A second resolve request for the same image will use the saved solution, for example you can first show the
image in the planetarium, and then slew to cursor without running the plate solver again.
Once the image is resolved the astronomical position of the mouse cursor will be displayed at the left bottom
status bar in apparent coordinates.

Resolve

Resolve the image using the astrometry software and load the solved image in the preview.
This force a new resolution even if the image is already solved, contrary to the other selection that reuse the
existing solution.

The image show an arrow with the North direction, or a cross at the position of the Pole if in the image field.
You can show the J2000 RA/DEC of the cursor by moving the cursor on the image.
If you save the FITS file now it will include the astrometry solution.

Resolve and Slew to image center

Resolve the image using the astrometry software and if the resolution is successful move the telescope at the
position of the image center.

https://www.ap-i.net/ccdciel/_detail/en/documentation/rightclick.png?id=en%3Adocumentation%3Aright_click_menu
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This useful to center the telescope on an image taken on a previous session.

Resolve and Slew to cursor

Resolve the image using the astrometry software and if the resolution is successful move the telescope at the
cursor position.

Can be useful to refine an object position but be careful of the mount backlash.

Resolve and Sync the mount

Resolve the image using the astrometry software and if the resolution is successful Sync the telescope at the
current position.

If you use Eqmod for your telescope driver, this can be used to set the alignment points.

Resolve and Rotate

Resolve the image using the astrometry software and if the resolution is successful set the rotator angle to
match the image orientation. The rotator must be calibrated before this function can work reliably.

Resolve and Sync the rotator

Resolve the image using the astrometry software and if the resolution is successful calibrate the rotator angle to
match the celestial position angle.

Resolve and annotate DSO

Resolve the image using the astrometry software and if the resolution is successful draw the deep sky objects
and bright star present in the image.

Resolve and annotate galaxies (Hyperleda)

This is the same as “annotate DSO” but using the Hyperleda database of more than 2 million galaxies.
You need to install the data separately before you can use this function.

https://www.ap-i.net/ccdciel/_detail/en/documentation/plot_dso.png?id=en%3Adocumentation%3Aright_click_menu
http://leda.univ-lyon1.fr/
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Resolve and show image in planetarium

Resolve the image using the astrometry software and if the resolution is successful view the image in the
planetarium.

Resolve and show image frame in planetarium

Resolve the image using the astrometry software and if the resolution is successful center the planetarium at
the position and draw a frame of the CCD field.

View last resolver log

You can take a look at the output log of the astrometry resolver to help to solve a problem or to refine the
performance.

Photometry

This menu open a new photometry window with measurement of the star under the cursor.
You can let the window open and double click on another star to make a new measurement.

Preview functions

Preview preprocessing

Preprocess the current image with the loaded dark and flat frames.

Preview debayer

The default display mode for bayer matrix color images is set in the preview preference. You can switch
between the two mode with this menu.

When checked, debayer and display the color image if the current image is a raw color image with bayer matrix.

When unchecked , display the raw image in black/white.

Image inspection

Show the image inspection overlay for the current image.

Image cleanup

Remove any marking and redraw the image.
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Unselect star

Unselect the marked star show in the Focus / Star profile tool.
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Photometry

You can open the photometry window by a right click on a star and select Photometry in the popup menu.

This tool is intended as a quick way to get a magnitude estimate for a star in an image you just take with your
camera.
It must not be used for any precision measurement.

The first time you open this window it need to be calibrated for your setup. Select a star in the image with a
know magnitude, type this magnitude in the box at the bottom right, and click the button Set magnitude.
You need to repeat this operation every time the image is modified, changing gain, using another telescope,
camera or filter. Only exposure time change is acceptable.

The magnitude computation take account for change in the exposure time and airmass. Both of this information
must be present in the image FITS header, otherwise only the calibration magnitude is used. The first rows at
the top of the window show this status.

The measurement include:

The star X/Y pixel position in the image
The maximum pixel intensity, in ADU, found in the measurement box
The sky background level around the star and it's standard deviation
The total flux of the star, in ADU, background subtracted
The signal to noise ratio of the measurement and how this affect the magnitude measurement
The computed star magnitude

https://www.ap-i.net/ccdciel/_detail/en/documentation/photometry.png?id=en%3Adocumentation%3Aphotometry
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File Menu

The File menu includes the following options:

Open FITS or picture file
Save FITS file
Save picture file

Bad pixel map
Dark frame
Flat frame

Open reference image
Clear reference image

Save configuration now
Quit
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Open FITS or picture file

From the menu File → Open FITS or picture file.

You can also open an image file by drag&drop of the file to the CCDciel window.

This let you load a FITS or picture file in the preview window instead of taking the image with the camera.

This is useful if you want to review a previous shot from the capture sequence, or to play with some other
image.

The FITS file must contain a 2 or 3 dimensions image in the primary array. The format of the pixel can be 8, 16
or 32 bit integer, 32 or 64 bit floating point. 3 dimensions array are interpreted as a RGB color image.
If the file extension end with '.fz' it is automatically unpacked using funpack

DSLR raw file can be any format supported by LibRaw or dcraw.

The picture file format can be one of the following: png, bmp, jpg, tif, gif, tga.
This support monochrome picture both 8 or 16 bit per pixel, or color picture 3×8 or 3×16 bit per pixel.
The image is converted in 16 bit FITS format to show in the preview window.
If you want you can then save the picture to a FITS file using the menu Save FITS file.

Note CCDciel is not a multi-purpose FITS file viewer. It is intended to display images from the camera but it
could fail displaying FITS files from other programs.
There is also chance CCDciel cannot plate solve a file taken with another software if WCStools cannot find the
approximate coordinates and scale of the image.

https://heasarc.gsfc.nasa.gov/fitsio/fpack/
https://www.libraw.org/
https://www.dechifro.org/dcraw/
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Save FITS file

From the menu File → Save FITS file.

This let you save to a FITS file the image in the preview window.

If the file extension is '.fits.fz' the file is automatically packed with fpack.

This is not used part of the capture sequence as the files are automatically saved, but this can be useful to save
an image taken with the Preview function or loaded with File → Open FITS file.

Be careful this Preview image can be processed for bad pixel if you create a bad pixel map.

https://heasarc.gsfc.nasa.gov/fitsio/fpack/
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Save picture file

From the menu File → Save picture.

This let you save to a picture file the image in the preview window.

The content of the picture depend on the file format you select in the save dialog.

The PNG and TIFF picture will be saved as 16 bit linear images.
The BMP and JPG picture are saved in 8 bit, stretched using the current preview settings.
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Bad/Hot pixel map

The bad pixel map will prevent the auto-focus or slewing function locking on a hot pixel rather then on a star.

The bad pixel map will be only applied on preview images, focus or slewing images. It is not applied on captured
images. Those images are not altered.

Use the menu File → Bad pixel map → Apply to current image If you want to apply the bad pixel map to an
image you load in the program.
You can identify an image that was BPM processed with a comment at the end of the FITS header.

Information

This menu show information about the current bad pixel map, the number of bad pixel and the size of the image
it was taken from.

You have two options to create, using the camera directly or using a processed dark frame. The second option is
preferred because the processed dark as less noise and you can use a lower sigma value to detect fainter
deviant pixels.

Create from the camera

Procedure:

Camera should be connected and cooling on if available.1.
Set the required binning in Preview tool. Use the same binning as for the focus and slewing2.
Select an exposure time between 10 and 60 seconds.3.
Cover the camera or telescope similar as taking a dark image. If your camera has a shutter it will remain4.
closed during the exposure.
Select menu File → Bad pixel map → Create from camera5.
Click Continue. A dark will be taken and number of hot pixels will be reported in the log window.6.

Create from a dark file

Select menu File → Bad pixel map → Create from dark file

Select the dark file from the file dialog.

https://www.ap-i.net/ccdciel/_detail/en/documentation/bpm_create.png?id=en%3Adocumentation%3Abad_pixel_map
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Clear the bad pixel map

To remove/clear the bad pixel map select the menu File → Bad pixel map → Clear bad pixel map

Check the bad pixel map

Take a preview image and check if the bright hot pixels are suppressed.

Or open a saved raw image and use the menu File → Bad pixel map → Apply to current image

If you still see some not removed hot pixel you can retry the procedure after setting a lower value for sigma.

Possible errors

Error: If you get an error message: “too many hot pixels”, increase the sigma threshold value in the menu Edit
→ Preferences → preview options. If successful the program log will report the number of hot pixels
suppressed.

.
A typical threshold value is 5 for CCD and 8 for a modern CMOS sensors. Decrease the threshold value if you
want suppress more hot pixels. Normally you should suppress maybe 5 to 30 hot pixels but you can go much
higher.

With some camera it is not possible to get a good result here. In this case use a dark frame instead.

https://www.ap-i.net/ccdciel/_detail/en/documentation/bmp-threshold.png?id=en%3Adocumentation%3Abad_pixel_map
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Dark frame

With some camera it is difficult to use a bad pixel map to cleanup the auto-focus frames. In this case you can
define here a dark frame that will be subtracted to remove the hot pixels.
Beware this processing require the dark frame is acquire with the same exposure time and at the same
temperature than the auto-focus frames. This also use more resources than the bad pixel map processing. So
the bad pixel map must be used in preference if applicable.

This same dark frame is also used with the image stacking option.

Use the menu File → Dark frame → Apply to current image if you want to subtract the dark from the
currently displayed image.
You can identify an image that was dark subtracted with a comment at the end of the FITS header.

Information

This menu show information about the current dark frame, the exposure time and the size of the image, you can
also see the dark file FITS header for more details.

You have two options to define the dark frame, using the camera directly or using a processed dark frame. The
second option is preferred because the processed dark as less noise.

Create from the camera

Procedure:

Camera should be connected and cooling on if available.1.
Set the required binning in Preview tool. Use the same binning as for the focus and slewing2.
Select the same exposure time as used for the auto-focus.3.
Cover the camera or telescope. If your camera has a shutter it will remain closed during the exposure.4.
Select menu File → Dark frame → Create from camera5.
Click Continue. A dark will be taken and saved for future use.6.

Load a dark file

Select menu File → Dark frame → Load dark file
Select the dark file from the file dialog.
The file must be taken with the same binning, exposure time, temperature than used for auto-focus. This file
must use a pixel format of 16bit.

Clear Dark frame

To remove/clear the dark frame select the menu File → Dark frame → Clear Dark frame

Check the dark frame

Take a preview image, select the menu File → Dark frame → Apply to current image
Verify the hot pixels are removed and the processing do not create unwanted artifact.
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Flat frame

When using the image stacking option it can be useful to process the individual frames with a flat before
stacking.
This is specially interesting when using star alignment because this preclude the use of a flat later in the
processing.

Use the menu File → Flat frame → Apply to current image if you want to divide the currently displayed
image with the flat.
You can identify an image that was divided by a flat with a comment at the end of the FITS header.

Information

This menu show information about the current flat frame, the size of the image and the mean level, you can
also see the flat file FITS header for more details.

You have two options to define the flat frame, using the camera directly or using a processed flat frame. The
second option is preferred because the processed flat as less noise.

Create from the camera

Procedure:

Camera should be connected and cooling on if available.1.
Set the required binning in Preview tool. Use the same binning used for stacking.2.
Select the same exposure time to get a mean level about 2/3 of the camera range.3.
Use your flat panel or other way to take flat.4.
Select menu File → Flat frame → Create from camera5.
Click Continue. A flat will be taken and saved for future use.6.

Load a flat file

Select menu File → Flat frame → Load flat file

Select the flat file from the file dialog.

The file must be taken with the same binning than used for stacking. This file must use a pixel format of 16bit.

Clear flat frame

To remove/clear the flat frame select the menu File → Flat frame → Clear Flat frame

Check the flat frame

Take a preview image, select the menu File → Flat frame → Apply to current image
Verify the vignetting and dust are removed and the processing do not create unwanted artifact.
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Reference image

You can load a reference image of the object you want to capture to adjust the position of the telescope and the
rotation of the camera. This is very useful to continue a sequence over many night if you cannot use plate-
solving.

You can adjust the display threshold and the color of the reference image in the preview options.
Normally you want the threshold to display only the stars from the reference image.

To load the image use the menu File / Open reference image

Then start a preview loop, it show the new image over the reference.

You can now move the telescope or rotate the camera to match the reference.

When you are satisfied with the result you can remove the reference image from the menu File / Clear
reference image

Tips:
To help to center the telescope open first the reference image with File / Open FITS file. Right click on the image
and select “Resolve and slew to image center”. After the telescope stop slewing process as above to adjust the
rotation.

https://www.ap-i.net/ccdciel/_detail/en/documentation/refimagesetting.png?id=en%3Adocumentation%3Aopen_reference_image
https://www.ap-i.net/ccdciel/_detail/en/documentation/refimage.png?id=en%3Adocumentation%3Aopen_reference_image
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Quit

From the menu File → Quit.

Exit the program and save the configuration.

If the devices are connected you are asked if you want to disconnect them.
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Help

Some help to use the software.

PDF documentation open the PDF documentation installed with the software

Online documentation open the documentation in a web browser

User group open the user group in a web browser. This is the place to ask question about the program
use.

CCDciel status open the CCDciel status page in a web browser

Show current log open the current log file using the default text editor

Show INDI log some INDI driver are very verbose, so any message below the Error level are not show in
the console but written directly to this file

Browse log files open the log file folder in the file explorer

Report a problem open the CCDciel bug tracker. You can report here any error you encounter in the
program.

Download latest version open the SourceForge download page. Ignore this entry if you use a package
from your Linux distribution.

About show the program version and copyright notice.
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The status bar

The status bar at the bottom of the program window show a number of information.

On the right, three lamp indicate the status of the planetarium, autoguider and devices connection.

When a capture is running the status bar show the sequence number and the remaining time of the current
exposure. On the right it show the name of the last saved image and the size of this image.

When a preview is running it show the remaining time of the current exposure, the time of the currently
displayed preview and the size of the image

After the exposure time as elapsed the remaining time is replaced by the advance of the image reading
process:

Downloading: the image is transferred from the camera to the driver.
Read image: the image is read from the driver by the program.
Display: the image is processed to show the preview on screen.

When the mouse cursor is moved over the image the following information is show in the left part of the status
bar:

The X/Y image coordinate of the cursor.
The pixel intensity.
The HFD and FWHM of the star under the cursor.
The star total Flux and Signal-to-noise ratio.
If the image is plate solved it also show the Right ascension and Declination of the cursor position, using
the apparent coordinates if the telescope mount use the coordinates of the date, or J2000 if the telescope
use this system. It show the apparent coordinates if no telescope is connected.

https://www.ap-i.net/ccdciel/_detail/en/documentation/status4.png?id=en%3Adocumentation%3Astatus_bar
https://www.ap-i.net/ccdciel/_detail/en/documentation/status1.png?id=en%3Adocumentation%3Astatus_bar
https://www.ap-i.net/ccdciel/_detail/en/documentation/status2.png?id=en%3Adocumentation%3Astatus_bar
https://www.ap-i.net/ccdciel/_detail/en/documentation/status3.png?id=en%3Adocumentation%3Astatus_bar
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The status web page

You can open the status web page from the menu Help → CCDciel status
or directly from your web browser: http://localhost:3277
It is also possible to get this page from another computer or phone in the local network or from the Internet if
you make the required configuration in your network equipement.

This page give information about the connections, the devices, the focus, the running sequence with completion
indicator, the last image and the console log. It refresh automatically every minute.
Click on the image to get the full size.

If you want to access this page remotely on the Internet, a safe way is to use a proxy.

You can also get this information from a program, the available options are:

This status web page.
The Simple socket command.
The JSON-RPC status method.

https://www.ap-i.net/ccdciel/_detail/en/documentation/ccdciel_status.png?id=en%3Adocumentation%3Accdciel_status
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TCP/IP Status server

You can connect locally or remotely to get information about the program.
There is three way to get the information:

The status web page.
This Simple socket command.
The JSON-RPC status method.

Simple socket command

The program listen on port 3277 and use the following command:

status Return the devices connection status
sequence Return information about current sequence
capture The capture information in the status bar
log The last 10 lines of the current log
quit disconnect from the server

For example:

$ telnet localhost 3277
Connected to localhost.
OK! id=1

status
Planetarium connected, Autoguider guiding, Devices connected

sequence
Targets: test1 Plan: L-3x2 Start step R

capture
Seq: 2 Exp: 19 sec. Saved /home/pch/Capture/M13_Red_20180217_161453.fits 1392x1040

log
17:14:07:Starting Light exposure 3 for 20 seconds
17:14:27:Saved file /home/pch/Capture/M13_Red_20180217_161427.fits
17:14:27:Stop capture
17:14:33:Start step R
17:14:33:Start capture
17:14:33:Starting Light exposure 1 for 20 seconds
17:14:53:Saved file /home/pch/Capture/M13_Red_20180217_161453.fits
17:14:53:Starting Light exposure 2 for 20 seconds

quit
Connection closed by foreign host.
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CCDciel Script

The scripts allow automation of many CCDciel function but also allow to interact with other component of the
observatory. They can be executed from the script tool or part of a sequence or sequence termination.

There is also standard script that are executed on defined occasion, create a script with the following name :

startup is executed when the program in launched. This is the place you can automatically start other
program, connect the devices, the autoguider and the planetarium. This can also be use to automatically
start a sequence when the program start.
shutdown is executed when the program is closed, it can be use to close other software or power off the
observatory.
beforeconnect is executed just before the devices are connected to the program, receive the profile
name as parameter.
connected is executed after all the devices are connected, receive the profile name as parameter.
disconnected is executed after all the devices are disconnected, receive the profile name as parameter.

The scripts can be written using the Python or Pascal programming language.
On Windows, basic Python functionality are provided with CCDciel. But you can install a full version of Python if
you want more functionality like Astropy. In this case adapt the python command to use in the Preferences.
On system with an ARM processor only the Python language is available.

Both of this language are very powerful and allow for complex tasks, but this can also be as simple as sending a
list of command to different devices.
It is possible to download script example for a quick start.
The functions specific to the interface with CCDciel are described in a separate page for Python or Pascal.

Script editor

The editor allow to write and test a script from within CCDciel.

Use the Editor font button to select the character font to use.
The Save button to record your change and return to the main window.

The top button are related to the debugging function as describe below.

https://www.astropy.org/
https://www.ap-i.net/ccdciel/_detail/en/documentation/scripteditor.png?id=en%3Adocumentation%3Accdscript
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Script debugger

Python debugging

With Python you can run the script with the green arrow button and see the printed output. The Stop button is
also available to interrupt the execution.

The Debug button open a separate windows with the Python debugger pdb where you can use the standard
Python debugger commands.

Pascal debugging

To run the script in debug mode press the green arrow Run button. The program is first compiled.

In case of compilation error, the corresponding row is highlighted in yellow, and the error message is show in

https://www.ap-i.net/ccdciel/_detail/en/documentation/script_debug1.png?id=en%3Adocumentation%3Accdscript
https://docs.python.org/library/pdb.html
https://docs.python.org/3/library/pdb.html#debugger-commands
https://www.ap-i.net/ccdciel/_detail/en/documentation/script_debug2.png?id=en%3Adocumentation%3Accdscript
https://www.ap-i.net/ccdciel/_detail/en/documentation/script_debug.png?id=en%3Adocumentation%3Accdscript
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the bottom message area.
If the compilation finish without error the program start to run and stop on the first code line of the main
procedure. The current execution position is highlighted in blue.

You can now use the Step over button to execute your program line by line.
The Step into button do the same, except if the current line is a call to one of your function. In this case Step
into allow to run the function line by line, but Step over execute the function and stop at the main program
next line.

You can also set a breakpoint on a specific line to jump directly at this position.
To set a breakpoint click on the leftmost column to show a red icon.
Use the Run button to jump to the next breakpoint. The current line is then highlighted in red.

You can remove a breakpoint by clicking on the red icon or all at at time with the Remove all breakpoint
button.

You can display the value of variables when the program is in pause at a breakpoint or after a Step over click.
Just click on the variable name anywhere in the program source to display the value in the message area.
Note this work only for local variables, not for object properties.

You can use the Pause button to pause the program execution. This can be useful to examine the condition of
an infinite loop for example.

The Stop button terminate the program execution immediately.
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Pascal language example

Here is the code of a Pascal version of scope_unpark script you can use to unpark the telescope.
The full script code look as following:

{
  This script unpark the telescope mount
}
var ok,parked: boolean;
    arg: TStringList;
    r: string;
begin
  // telescope connected?
  GetB('TELESCOPE_CONNECTED',ok);
  if not ok then begin
    logMsg('Telescope not connected!');
    exit;
  end;
  // get park status
  GetB('TELESCOPE_PARKED',parked);
  if parked then begin
    getSl('STRL1',arg);
    arg.clear;
    arg.add('OFF');
    r:=cmdArg('TELESCOPE_PARK',arg);
    if r<>msgOK then logMsg('Telescope park: '+r);
  end
  else begin
    logMsg('Telescope already unparked');
  end;
end.

Take a look at each part in detail:

{
  This script unpark the telescope mount
}

Is a comment, you can use // {..} (*..*) to enclose your comments.

var ok,parked: boolean;
    arg: TStringList;
    r: string;

Define the variable we use later in the script.
Important variable type are: integer, double, string, boolean.
The Tstringlist type is use here to send a command argument to CCDciel.
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  begin

The start of our script.

GetB('TELESCOPE_CONNECTED',ok);

We ask CCDciel about the status of a boolean variable to know if the telescope is connected, the result is in our
variable ok.

  if not ok then begin
    logMsg('Telescope not connected!');
    exit;
  end;

We test the result of the previous command, ok is true if the telescope is connected, so we add the negation
“not” to test for “not connected”. If the result of the test “not connected” is true we execute the code block
starting at “begin” up to the corresponding “end”, this write a message in the log and exit the script.

GetB('TELESCOPE_PARKED',parked);

We continue and we do the same to check if the telescope is parked, with the result in our parked variable..

    if parked then begin

We test if the telescope is parked, in this case we can unpark.

GetSL('STRL1',arg);
arg.clear;

Request a TStringList object identified by STRL1. We clear any data that may stay in the object. We need this
TStringlist to pass argument to a CCDciel command.

This code is using the CCDCiel specific GetSL to access a global stringlist. An alternative way for getSL is the
create a stringlist in standard Pascal as follows:

arg:=TStringList.Create;
arg.clear;

end at the end of the program free it:

arg.Free;

    arg.add('OFF');
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    r:=cmdArg('TELESCOPE_PARK',arg);

Add the argument 'OFF' for the command and execute 'TELESCOPE_PARK' 'OFF'. This effectively unpark the
telescope and the result is in variable r.

if r<>msgOK then logMsg('Telescope park: '+r);

We test the result is different than msgOK, in this case we write a message to the log to show the error from the
driver.

 end.

The end of the script.
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Python and JSON-RPC reference

This page contain reference for the JSON-RPC interface.

The program accept JSON-RPC 2.0 request on the port 3277 using both direct socket or HTTP POST.

For HTTP POST set your JSON-RPC procedure to use the following URL:

http://localhost:3277/jsonrpc

Python scripts

This JSON-RPC method are the basis for the Python scripts, both internal (launched from CCDciel) or external
(launched from a terminal or another application).
A Python function is provided to simplify the use. The host,port parameters can be use to send the command to
another instance of CCDciel.
The syntax is:

jsonresult = ccdciel(method)
jsonresult = ccdciel(method,parameter)
jsonresult = ccdciel(method,parameter,host,port)

For example:

from ccdciel import ccdciel
ra = ccdciel('TelescopeRA')['result']

To make Python to find this function in external script you must specify the environment variable PYTHONPATH,
this is not necessary when running the script from CCDciel:

set PYTHONPATH=C:\Program Files\CCDciel\scripts
export PYTHONPATH=/usr/share/ccdciel/scripts

Use the standard Python functions ( argv, getopt, argparse) to retrieve the script parameters. For example:

print ('Argument List:', str(sys.argv))

Methods that return a value

The invocation format for this methods is: {“jsonrpc”: “2.0”, “method”: “method_name”, “id”:1}
The responses for this methods are in the form: {“jsonrpc”: “2.0”, “result”: result_value, “id”: 1}
Method name is not case sensitive.

Method name Result
type Result value

CCDciel_Version array [main version, short revision, full revision]

Devices array The driver and connection type for each defined
device

Devices_connected bool True if all the devices are connected
Camera_connected bool True if the camera is connected
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Method name Result
type Result value

Camera_getframe integer Camera frame [x,y,width,heigth]
CcdTemp double The current CCD temperature
Preview_getexposure double Get the preview exposure time
Preview_getbinning string Get the preview binning
Preview_running bool True if the preview is running
Preview_loop_running bool True if the preview is in loop
Capture_getexposure double Get the capture exposure
Capture_getbinning string Get the capture binning
Capture_getobjectname string Get the capture object name
Capture_getcount integer Get the capture image count
Capture_getframetype string Get the capture frame type
Capture_getdither integer Get the capture Dither count
Capture_running bool True if a capture is running
Capture_getLastfilename string The full path name of the last saved file
Telescope_connected bool True if the telescope is connected
Telescope_eqmod bool True if the telescope use the EqMod driver
Telescope_parked bool True if the telescope is parked
Telescope_tracking bool True if the telescope is tracking
Telescope_trackingrate string SIDEREAL, LUNAR, SOLAR, CUSTOM

Telescope_PierSide string pierEast, pierWest, pierUnknown,
pierNotImplemented

Telescope_slewing bool True if the telescope is slewing
Astrometry_Goto_Running bool True if the telescope is slewing using astrometry
Astrometry_Goto_Result bool True if the last astrometry goto is successful
TelescopeRA double The telescope position right ascension
TelescopeDE double The telescope position declination
Wheel_connected bool True if the filter wheel is connected
Wheel_GetfiltersName array The name of the filters in the wheel
Focuser_connected bool True if the focuser is connected
FocuserPosition int The focuser absolute position
CoverStatus string The status of the telescope cover
CalibratorStatus string The status of the flat calibrator
CalibratorBrightness int The brightness of the calibrator
Autoguider_connected bool True if the auto-guider is connected
Autoguider_running bool True if the auto-guider is running
Autoguider_guiding bool True if the auto-guider is guiding
Autoguider_Getlockposition x,y The current guide lock position
Internalguider_GetGuideExposure double The guider exposure time
Internalguider_GetAgressivityRA integer [gain,hysteresis] in RA
Internalguider_GetAgressivityDEC integer [gain,hysteresis] in DEC
Internalguider_GetSpectrofunction bool The value of “Activate spectroscopy function”

Internalguider_GetSpectroStrategy string
The current spectro guiding strategy: 'SingleStar',
'SingleOffset', 'SingleAstrometry', 'SingleMulti',
'MultiStar'

Internalguider_GetSpectroAstrometryExposure double The exposure time for the astrometry
Internalguider_GetSpectroSlitname string The selected slit name in the list of slit offset

Internalguider_GetSpectroGuidestaroffset double,
double The X,Y guide star offset relative to the target
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Method name Result
type Result value

Internalguider_GetSpectroMultistaroffset double,
double The current multi-star guide offset

Planetarium_connected bool True if the planetarium is connected

TimeNow string The current local time on the computer running
CCDciel

SiderealTime double The current local sidereal time in hour
Obs_latitude double The observer latitude
Obs_longitude double The observer longitude
Obs_elevation double The observer elevation

HostOS string The operating system on the computer running
CCDciel

DirectorySeparator string The directory separator symbol on the computer
running CCDciel

AppDir string The directory where the program is installed
TmpDir string The directory for temporary files

CaptureDir string The directory to save the images from capture
sequence

Methods that invoke a command without parameter

The invocation format for this methods is: {“jsonrpc”: “2.0”, “method”: “method_name”, “id”:1}
The responses for this methods are in the form: {“jsonrpc”: “2.0”, “result”:{“status”: “OK!”}, “id”: 1}
Status can be “OK!” if the command is successful, or “Failed!” if not. In this later case it can contain information
about why it fail.
Method name is not case sensitive.

Method name Function
Camera_Resetframe Reset the camera full frame ROI
Preview_single Start a single preview
Preview_loop Start a preview loop
Preview_waitloop Wait until the user stop the preview loop
Preview_stop Stop any in progress preview or preview loop
Capture_start Start a capture
Capture_stop Stop a capture
Finder_Stoploop Stop the finder loop
Telescope_track Start telescope tracking
Telescope_abortmotion Stop any telescope movement
Eqmod_clearpoints Clear EqMod alignment data
Eqmod_clearsyncdelta Clear Eqmod sync delta
Eqmod_stdsync Set Eqmod in Standard sync mode
Eqmod_appendsync Set Eqmod in Add point on sync mode
Wheel_getfilter Get the current filter number in the wheel
Cover_open Open the telescope cover
Cover_close Close the telescope cover
Calibrator_light_off Turn flat calibrator light off

Autofocus Run auto-focus at the current position, same as the Autofocus
button

AutomaticAutofocus Run auto-focus, same as invoked from a sequence, will eventually
move to a bright star
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Method name Function
Astrometry_solve Plate solve the current image
Astrometry_sync Plate solve the current image and sync the telescope
Astrometry_slew_image_center Plate solve the current image and slew the telescope
Astrometry_plot_dso Plate solve the current image and annotate DSO

Astrometry_plot_hyperleda Plate solve the current image and annotate DSO using the
hyperleda catalog

Autoguider_connect Connect to the autoguider software
Autoguider_calibrate Force a new calibration of the autoguider
Autoguider_startguiding Start to guide
Autoguider_stopguiding Stop guiding
Autoguider_pause Pause guiding
Autoguider_unpause Restart after pause
Autoguider_dither Dither now
Autoguider_shutdown Close the autoguider program
Internalguider_ClearSpectroTargetRaDec Clear the target ra,dec, for spectro guiding
Internalguider_ClearSpectroGuideStarRaDec Clear the guide star ra,dec, for spectro guiding
Planetarium_connect Connect the planetarium software
Planetarium_showimage Plate solve the current image and show in planetarium
Planetarium_shutdown Close the planetarium software
Program_shutdown Close CCDciel
Clear_reference_image Remove the reference image
CustomHeader_clear Delete all the custom header keywords

Methods that invoke a command with parameter

The invocation format for this methods is: {“jsonrpc”: “2.0”, “method”: “method_name”, “params”: [params],
“id”:1}
The responses for this methods are in the form: {“jsonrpc”: “2.0”, “result”:{“status”: “OK!”}, “id”: 1}
Status can be “OK!” if the command is successful, or “Failed!” if not. In this later case it can contain information
about why it fail.
Method name is not case sensitive.

Method name Parameter Function
Devices_connection True / False Connect or disconnect the devices
Ccd_settemperature temp Set the CCD temperature
Camera_Setframe [x,y,width,height] Set the camera frame size (ROI)
Preview_setexposure exp Set the preview exposure time
Preview_setbinning bin Set the preview binning
Capture_setexposure exp Set the capture exposure
Capture_setbinning bin Set the capture binning
Capture_setobjectname name Set the capture object name
Capture_setcount count Set the capture image count
Capture_setframetype Light/Bias/Dark/Flat Set the capture frame type
Capture_setdither count Set the capture Dither count

Finder_Saveimage ON/OFF Activate the saving of finder image
when looping

Finder_Startloop exposure time Start the finder loop with the given
exposure time
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Method name Parameter Function

Finder_Snapshot exposure time,
filename, count Take a series of finder camera snapshot

Internalguider_Snapshot exposure time,
filename, count

Take a series of guide camera snapshot,
guiding must be stopped before to use
this command

Sequence_start sequence Load and start the sequence
Telescope_settrackingrate rate rate = SIDEREAL,LUNAR,SOLAR

Astrometry_Goto_Async [RA, DEC]
Slew to specified coordinates, use
astrometry correction, return
immediately

Telescope_slew [RA, DEC] Slew to specified coordinates, do not
return until the slew is complete

Telescope_slewasync [RA, DEC] Slew to specified coordinates, return
immediately

Telescope_sync [RA, DEC] Sync to specified coordinates
Telescope_park True / False Park or unpark the telescope

Autoguider_SetSettleTolerance px,min,timeout Set the settle tolerance in PHD2 or
Internal guider

Autoguider_Setlockposition x,y Set immediately the new guide lock
position in PHD2 or Internal guider

Autoguider_Storelockposition x,y Store the guide lock position for the next
time guiding is started

Internalguider_SetGuideExposure double Set the guider exposure time
Internalguider_SetAgressivityRA integer Set the [gain,hysteresis] in RA
Internalguider_SetAgressivityDEC integer Set the [gain,hysteresis] in DEC

Internalguider_SetSpectrofunction bool Set the value of “Activate spectroscopy
function”

Internalguider_SetSpectroStrategy string
Set the spectro guiding strategy, one of:
'SingleStar', 'SingleOffset',
'SingleAstrometry', 'SingleMulti',
'MultiStar'

Internalguider_SetSpectroAstrometryExposure double Set the exposure time for the
astrometry

Internalguider_SetSpectroSlitname string Select this slit name in list to set the slit
offset

Internalguider_SetSpectroGuidestarRaDec double, double Set the guide star RA,DEC, offset is
computed from target RA,DEC

Internalguider_SetSpectroGuidestaroffset double, double Set the X,Y guide star offset relative to
the target

Internalguider_SetSpectroMultistaroffset double, double Set the X,Y multi-star guide offset
Wheel_setfilter number Set the filter number in the wheel
Focuser_setposition number Set the focuser absolute position

SetFocusXY X,Y Select the star at position X,Y for focus
operation

Get_Switch nickname, switchname Return the current value for the switch

Set_Switch nickname,
switchname, value Set the value of the switch

Calibrator_light_on brightness Light the flat calibrator at the specified
brightness

Planetarium_showimage_fov FOV [degree]
Plate solve the current image and show
in planetarium using the specified field
of view

J2000_to_Apparent [RA, DEC] Convert J2000 ra,dec to apparent. RA in
hours, DEC in degree
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Method name Parameter Function

Apparent_to_J2000 [RA, DEC] Convert apparent ra,dec to J2000. RA in
hours, DEC in degree

Eq2hz [RA, DEC]
From apparent ra,dec, return alt,az
coordinates. RA in hours, all other angle
in degree

Hz2eq [AZ, ALT]
From az,alt, return apparent ra,dec
coordinates. RA in hours, all other angle
in degree

Save_fits_file filename Save the FITS file
Open_fits_file filename Open the FITS file
Open_reference_image filename Load a reference image
LogMsg text Print text in CCDciel log

CustomHeader_add [key,value]
Add a new custom header keyword with
value. Replace the value if the key
already exist

CustomHeader_del key Delete all the occurrence of this custom
header keyword

CustomHeader key Return the value for this keyword

Specific status method

This method return a global program status with the same information as the Status web page.

method status

params devices planetarium autoguider safety weather dome mount camera wheel rotator focuser sequence
capture log

The params field allow to filter the information send by the program.
When the params field is not specified the response include all the information.

Example:

$ telnet localhost 3277
Connected to localhost.
{"jsonrpc": "2.0", "method": "status", "params": ["camera","focuser"], "id": 2}

{"jsonrpc": "2.0", "result":{"camera": {"connected": true, "binning": "1x1",
"frame": "0/0/1280/1024", "cooler": false, "temperature": 0.0},
"focuser": {"connected": true, "position": 37200, "temperature": 0.0,
"focusermessage": "AutoFocus successful; 15:03:52 HFD=4.2"}}, "id": 2}

There is three way to get the status information:

The status web page.
The Simple socket command.
This JSON-RPC status method.



CCDciel documentation

187

Pascal script reference

This page contain reference material for scripting functions using the Pascal language. Beware Pascal script are
not supported on ARM processor. Refer to this page if you want to use the Python language.

See the script description page for general information.

See the script example page for a quick start with the programming functions.

Script language

The language to use is Pascal Script.
For a complete reference of the Object Pascal language your can read the Free Pascal Reference guide. But
beware that some feature are not implemented by the script language, for example: no pointer, no assembler,
no overloading.

In addition to the standard Pascal Script feature the following CCDciel specific function are added.

Retrieve script parameters
name value
ParamCount the number of parameters available
ParamStr array of string containing the parameters. ParamStr[0] is always the script filename

Constants
name value
deg2rad degree to radian conversion constant
rad2deg radian to degree conversion constant
msgOK returned when a CCDciel command complete successfully
msgFailed returned when a CCDciel command fail

Global variables access
function GetS(varname:string; var str: string):Boolean;
Get the global string variable identified by varname
varname value
CoverStatus The status of the telescope cover
CalibratorStatus The status of the flat calibrator
LastError The text of the last error
HostOS The operating system on the computer running CCDciel
DirectorySeparator The directory separator symbol on the computer running CCDciel
AppDir The directory where the program is installed
TmpDir The directory for temporary files
CaptureDir The directory to save the images from capture sequence

https://en.wikipedia.org/wiki/Pascal_Script
https://en.wikipedia.org/wiki/Pascal_Script
http://www.freepascal.org/docs-html/ref/ref.html
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function GetS(varname:string; var str: string):Boolean;
Preview_getbinning Get the preview binning
Capture_getbinning Get the capture binning
Capture_getobjectname Get the capture object name
Capture_getframetype Get the capture frame type
Str1 .. Str10 Ten global variable for your use

function SetS(varname:string; str: string):Boolean;
Set the global string variable identified by varname for later use
varname value
Str1 .. Str10 Ten global variable for your use

function GetSL(varname:string; var strl: Tstringlist):Boolean;
Get the global stringlist variable identified by varname
varname value
Strl1 .. Strl10 Ten global variable for your use

function SetSL(varname:string; stlr: Tstringlist):Boolean;
Set the global stringlist variable identified by varname for later use
varname value
Strl1 .. Strl10 Ten global variable for your use

function GetI(varname:string; var i: Integer):Boolean;
Get the global integer variable identified by varname
varname value
FocuserPosition The focuser absolute position
CalibratorBrightness The brightness of the calibrator
Capture_getcount Get the capture image count
Capture_getdither Get the capture Dither count
Int1 .. Int10 Ten global variable for your use

function SetI(varname:string; i: Integer):Boolean;
Set the global integer variable identified by varname for later use
varname value
Int1 .. Int10 Ten global variable for your use

function GetD(varname:string; var x: double):boolean;
Get the global double variable identified by varname
varname value
TelescopeRA The telescope position right ascension
TelescopeDE The telescope position declination
TimeNow The current time in TDateTime format
CCDTEMP The current CCD temperature
OBS_LATITUDE The observer latitude
OBS_LONGITUDE The observer longitude
OBS_ELEVATION The observer elevation
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function GetD(varname:string; var x: double):boolean;
Preview_getexposure Get the preview exposure time
Capture_getexposure Get the capture exposure
Double1 .. Double10 Ten global variable for your use

function SetD(varname:string; x: Double):Boolean;
Set the global double variable identified by varname for later use
varname value
Double1 .. Double10 Ten global variable for your use

function GetB(varname:string; var x: boolean):boolean;
Get the global boolean variable identified by varname
varname value
TELESCOPE_CONNECTED True if the telescope is connected
TELESCOPE_PARKED True if the telescope is parked
TELESCOPE_TRACKING True if the telescope is tracking
TELESCOPE_SLEWING True if the telescope is slewing
TELESCOPE_EQMOD True if the telescope use the EqMod driver
AUTOGUIDER_CONNECTED True if the auto-guider is connected
AUTOGUIDER_RUNNING True if the auto-guider is running
AUTOGUIDER_GUIDING True if the auto-guider is guiding
WHEEL_CONNECTED True if the filter wheel is connected
FOCUSER_CONNECTED True if the focuser is connected
CAMERA_CONNECTED True if the camera is connected
PLANETARIUM_CONNECTED True if the planetarium is connected
PREVIEW_RUNNING True if the preview is running
PREVIEW_LOOP True if the preview is in loop
CAPTURE_RUNNING True if a capture is running

function GetV(varname:string; var v: Variant):Boolean;
Get the ASCOM interface for the device identified by varname (Windows only)
varname value
TELESCOPE, DOME, CAMERA, GUIDERCAMERA,
FINDERCAMERA, FOCUSER, FILTER, ROTATOR, COVER,
SAFETY, WEATHER

The corresponding ASCOM device connected to
CCDciel

Variant1 .. Variant10 Ten global variable for your use

function SetV(varname:string; v: Variant):Boolean;
Set the global variant variable identified by varname for later use
varname value
Variant1 .. Variant10 Ten global variable for your use

Commands
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function Cmd(cname:string):string;
Execute a simple command cname in CCDciel.

Valid Cmd() command are:

Command Description
TELESCOPE_ABORTMOTION Stop any telescope movement
TELESCOPE_TRACK Start telescope tracking
EQMOD_CLEARPOINTS Clear EqMod alignment data
EQMOD_CLEARSYNCDELTA Clear Eqmod sync delta
EQMOD_STDSYNC Set Eqmod in Standard sync mode
EQMOD_APPENDSYNC Set Eqmod in Add point on sync mode
AUTOGUIDER_CONNECT Connect to the autoguider software
AUTOGUIDER_CALIBRATE Force a new calibration of the autoguider
AUTOGUIDER_STARTGUIDING Start to guide
AUTOGUIDER_STOPGUIDING Stop guiding
AUTOGUIDER_PAUSE Pause guiding
AUTOGUIDER_UNPAUSE Restart after pause
AUTOGUIDER_DITHER Dither now
AUTOGUIDER_SHUTDOWN Close the autoguider program
AUTOGUIDER_GETLOCKPOSITION Return the current guide lock position
WHEEL_GETFILTER Get the current filter number in the wheel
PREVIEW_SINGLE Start a single preview
PREVIEW_LOOP Start a preview loop
PREVIEW_WAITLOOP Wait until the user stop the preview loop
PREVIEW_STOP Stop any in progress preview or preview loop
CAPTURE_START Start a capture
CAPTURE_STOP Stop a capture
FINDER_STOPLOOP Stop the finder loop
ASTROMETRY_SOLVE Plate solve the current image
ASTROMETRY_SYNC Plate solve the current image and sync the telescope
ASTROMETRY_SLEW_IMAGE_CENTER Plate solve the current image and slew the telescope
ASTROMETRY_PLOT_DSO Plate solve the current image and annotate DSO

ASTROMETRY_PLOT_HYPERLEDA Plate solve the current image and annotate DSO using the hyperleda
catalog

PLANETARIUM_CONNECT Connect the planetarium software
PLANETARIUM_SHOWIMAGE Plate solve the current image and show in planetarium
PLANETARIUM_SHUTDOWN Close the planetarium software
PROGRAM_SHUTDOWN Close CCDciel
CLEAR_REFERENCE_IMAGE Remove the reference image
AUTOFOCUS Run auto-focus at the current position

AUTOMATICAUTOFOCUS Move to a bright star and run auto-focus, return to last position when
finished

COVER_OPEN Open the telescope cover
COVER_CLOSE Close the telescope cover
CALIBRATOR_LIGHT_OFF Turn flat calibrator light off
CUSTOMHEADER_CLEAR Delete all the custom header keywords

function CmdArg(cname:string; arg:Tstringlist):string;
Execute a command cname in CCDciel with parameters arg. Add each parameter to the string list.
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Valid CmdArg() command are:

Command Arguments Description
DEVICES_CONNECTION ON/OFF Connect or disconnect the devices

TELESCOPE_SLEW RA, DEC Slew to specified coordinates, do not return
until the slew is complete

TELESCOPE_SLEWASYNC RA, DEC Slew to specified coordinates, return
immediatelly

TELESCOPE_SYNC RA, DEC Sync to specified coordinates
TELESCOPE_PARK ON/OFF Park or unpark the telescope

AUTOGUIDER_SETLOCKPOSITION x,y Set immediately the new guide lock
position in PHD2 or Internal guider

AUTOGUIDER_STORELOCKPOSITION x,y Store the guide lock position for the next
time guiding is started

WHEEL_SETFILTER number Set the filter number in the wheel

WHEEL_GETFILTERSNAME arg On return arg contain the name of the
filters

WHEEL_SETFILTERSNAME arg Put each filter name in arg
FOCUSER_SETPOSITION number Set the focuser absolute position

SetFocusXY X,Y Select the star at position X,Y for focus
operation

Get_Switch nickname,switchname Return the current value for the switch
Set_Switch nickname,switchname,value Set the value of the switch
CCD_SETTEMPERATURE temp Set the CCD temperature
PREVIEW_SETEXPOSURE exp Set the preview exposure time
PREVIEW_SETBINNING bin Set the preview binning
CAPTURE_SETEXPOSURE exp Set the capture exposure
CAPTURE_SETBINNING bin Set the capture binning
CAPTURE_SETOBJECTNAME name Set the capture object name
CAPTURE_SETCOUNT count Set the capture image count
CAPTURE_SETFRAMETYPE Light/Bias/Dark/Flat Set the capture frame type
CAPTURE_SETDITHER count Set the capture Dither count

FINDER_SAVEIMAGES ON/OFF Activate the saving of finder image when
looping

FINDER_STARTLOOP exposure time Start the finder loop with the given
exposure time

Finder_Snapshot exposure time, filename, count Take a series of finder snapshot

Internalguider_Snapshot exposure time, filename, count
Take a series of guide camera snapshot,
guiding must be stopped before to use this
command

SEQUENCE_START sequence Load and start the sequence
SAVE_FITS_FILE filename Save the FITS file
OPEN_FITS_FILE filename Open the FITS file
OPEN_REFERENCE_IMAGE filename Load a reference image

PLANETARIUM_SHOWIMAGE_FOV FOV [degree]
Plate solve the current image and show in
planetarium using the specified field of
view

CALIBRATOR_LIGHT_ON brightness Light the flat calibrator at the specified
brightness

CUSTOMHEADER_ADD key, value
Add a new custom header keyword with
value. Replace the value if the key already
exist

CUSTOMHEADER_DEL key Delete all the occurrence of this custom
header keyword
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Command Arguments Description
CUSTOMHEADER key Return the value for this keyword

Delay functions
procedure Wait(wt:integer);
Wait wt seconds before to continue the execution

function WaitTill(hour:string; showdialog: boolean):boolean;
Wait until the time is “hour”, encoded as 23:30:00 .
If the time is already passed by less than 12h the function return immediately, if it is passed for more than 12h
it wait for the next day.
If showdialog is true a dialog with time countdown is show, this dialog also allow to cancel or to continue
immediately, it return False if the wait is canceled.

Coordinates conversion
Procedure Eq2Hz(var ra,de : double ; var a,h : double);
Convert Equatorial ra,de to Alt/Az a,h for the location and time of the current chart. RA in hours, all other angle
in degree

Procedure Hz2Eq(var a,h : double; var ra,de : double);
Convert Alt/Az a,h to equatorial ra,de for the location and time of the current chart. RA in hours, all other angle
in degree

Formating and conversion
Function ARtoStr(var ar: Double) : string;
Return a string formated Right Ascension of ar value

Function DEtoStr(var de: Double) : string;
Return a string formated Declination of de value

Function StrtoAR(str:string; var ar: Double) : boolean;
Convert a formated string to Right Ascension decimal value

Function StrtoDE(str:string; var de: Double) : boolean;
Convert a formated string to Declination decimal value

Function JDtoStr(var jd: Double) : string;
Format a julian date to YYYY-MM-DD string
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Function StrtoJD(dt:string; var jdt: Double) : boolean;
Convert a formated string YYYY-MM-DD to julian date value

Function FormatFloat(Const Format : String; var Value : double) : String;
Format a decimal number according to the Format specification

Function Format(Const Fmt : String; const Args : Array of const) : String;
The Format Pascal function

Procedure StrtoFloatD(str:string; var defval: Double; var val: Double);
Convert a string to a floating point value. Return defval if the string is a invalid number

function IsNumber(str: String): boolean;
Return True if the string represent a valid number

function StringReplace(str,s1,s2: String): string;
Replace all occurrence of s1 by s2 in str

Dialog
function MsgBox(const aMsg: string):boolean;
A message confirmation dialog. Return True if YES is clicked.

Procedure ShowMessage(const aMsg: string);
Display a message.

Procedure LogMsg(const aMsg: string);
Write a message to the log

Run external program
function Run(cmdline:string):boolean;
Execute the specified command. Return immediately without waiting for the execution to end.

function RunWait(cmdline:string):boolean;
Execute the specified command. Wait for termination.

function RunOutput(cmdline:string; var output:TStringlist):boolean;
Execute the specified command, wait for termination and put the stdout to “output”. Beware this function can
completely lock the main program if it not finish in time.

http://www.freepascal.org/docs-html/rtl/sysutils/formatfloat.html
http://www.freepascal.org/docs-html/rtl/sysutils/format.html
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function OpenFile(fn:string):boolean;
Open a document file using the default program
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Command line options

CCDciel accepts the following options on the command line:

Option Parameter Function

--basedir
-b Base directory

The base directory to store all the program configuration and work files. The
default is in the user profile, %LOCALAPPDATA%\ccdciel or ~/.config/ccdciel
Example: --basedir=E:\ccdciel_files , -b E:\ccdciel_files

--config
-c

configuration file
path

Lets you specify the device configuration file to use instead of the last one
you load
Example: --config=default , -c default

--run_sequence
-r sequence file path

Automatically connect the devices and run this sequence.
the startup script is run before to start the sequence. The camera cooler and
the autoguider connection are set according to the configuration.
Example: --run_sequence=/tmp/seq1.targets , -r /tmp/seq1.targets

--shutdown
-s

Wait 5 minutes and shutdown the program after the sequence specified with
--run_sequence is finished. This option as no effect if --run_sequence is not
specified.
The sequence termination options are run before this option is processed.
The shutdown script is run after.
Example: --shutdown , -s
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Image preprocessing

It is possible to use scripts to preprocess the new images automatically for example at the end of the nightly
sequence.
There is standard script you can use directly or if you have very specific needs you can modify them to make
your own. This page describe this standard scripts in more detail.

Using Siril

Siril is a powerful image processing software that can be automated with it's own scripting language. You need
at least the version 0.9.9 to use this scripts.
Just install the latest version for your system, no specific configuration in Siril is need.

You can select the following from any CCDciel script selection box:

siril_bias : Process the bias files and produce the master bias.
siril_dark : Process the dark files and produce the master dark.
siril_flat : Process the flat files and produce the master flat, one per filter if it apply.
siril_light : Preprocess all the light frame using the master dark and flat.
siril_light_color : Preprocess all the color light frame using the master dark and flat.

You need to follow a standard scheme for the file and folder name, otherwise the script will not work.
In the file preferences you must set the following:

Separator must be _
FITS file extension must be .fits
For File name option you must check only “Object name” and if using a filter wheel also set “Filter”. It is
very important that “Date(UT)/Sequence” and any other option remain unchecked.
For Folder name options you must check only “Subfolder by frame type”. It is very important that any
other option remain unchecked.

 

After you run the script you can look at the log file created in the CCDciel Capture folder. This file show all the
Siril operations and messages.

Usage requirement

As it is not possible to make standard script that adapt to every use case you must be careful of the following
condition before to use them:

Follow the file and folder naming convention.
All the light frames must be taken on the same condition with respect to the temperature, gain and
exposure time.
The dark must correspond to the light exposure condition.
The master flat is mandatory. If you not want to use a flat, create a fits file filled with a uniform value.

https://www.siril.org/
https://www.ap-i.net/ccdciel/_detail/en/documentation/filename1.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/filename2.png?id=en%3Adocumentation%3Aimage_preprocessing
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Take and process Bias

The following descriptions will use a sequence as an example, but you can do the same by using directly the
Capture and the Script tools.

First create a plan to take the bias frames:

Then create a sequence to run this plan and preprocess the bias:

After you run this sequence you find in the Bias directory every individual bias frame and the processed master
bias:

With a cooled camera you probably not make bias every day, so just keep the file Master_Bias.fits in place so it
can be used by the other processing operation.

Take and process Dark

Same as for the bias, create a plan to take the dark frames:

Then create a sequence to run this plan and preprocess the dark:

After you run this sequence you find in the Dark directory every individual dark frame and the processed master
dark:

With a cooled camera you probably not make dark every day, so just keep the file Master_Dark.fits in place so it

https://www.ap-i.net/ccdciel/_detail/en/documentation/bias_plan.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_bias1.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_bias2.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/dark_plan.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_dark1.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_dark2.png?id=en%3Adocumentation%3Aimage_preprocessing
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can be used by the other processing operation.

Take and process Flat

It is required the Master_Bias is available before you can run this script.
We have more options to make the flat frames because it depend if we use a flat panel or sky flat, and if we use
a filter wheel or not.
To use a flat panel just create a plan as for the dark but select “Flat” for the type.

Then create a sequence to run this plan and preprocess the flat.
To use a sky flat add an automatic dusk or dawn Sky Flat in the sequence.

After you run this sequence you find in the Flat directory every individual flat frame and the processed master
flat:

As you probably make flat every day a good place to add this processing is at the end of the sequence, just
before to process the light frames. Or you can use a specific flat sequence you run at the beginning of the night.

Take and process Light

It is required the Master_Dark and Master_Flat are available before you can run this script.
Again it depend how you take the flat to chain this process. The important point is it run once at the end of the
night after the flat are processed.

If you use a flat panel a good solution is to use the Script option in the sequence termination options. This
ensure it run only once if you set a sequence repetition or if the sequence is interrupted at dawn.

If you use a sky flat you can add the script at the end of the sequence after the flat processing:

https://www.ap-i.net/ccdciel/_detail/en/documentation/flat_plan.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_flat1.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_flat2.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_light2.png?id=en%3Adocumentation%3Aimage_preprocessing
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After the script is finished you find the dark and flat preprocessed files for all the objects and all the filters in a
new directory “processed” under the base capture directory. Every file is prefixed by “pp_” as Siril do to
distinguish them from the original files.

By default this script stop here because at this point you probably want to review your files and make some
selection before to go further.

But if you want it is possible to continue with alignment and stacking. For that you need to modify the file
template_light.ssf located in the CCDciel program directory in scripts/siril.
On Windows this is “Program Files\ccdciel\scripts\siril”, on Linux this is “/usr/share/ccdciel/scripts/siril”
In the file remove the # in front of the command “register” and “stack”. If you use a OSC or DSLR camera you
also need to add the options “-cfa -debayer” to the preprocess command to debayer the images before the
registration.

https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_light1.png?id=en%3Adocumentation%3Aimage_preprocessing
https://www.ap-i.net/ccdciel/_detail/en/documentation/siril_light3.png?id=en%3Adocumentation%3Aimage_preprocessing
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Installation on Ubuntu, Debian

Bellow installation procedure uses only command line approach, because this is the simpler way to follow
instructions just by copy-pasting the commands in terminal.

This same procedure can be used with any system using deb packages (Debian, Mint, Raspbian, …)

CCDciel and it's dependency are available from the same repository as Skychart, but you need the unstable
repository as long this program is in beta version only.

Install the public key:1.

sudo apt-key adv --keyserver keyserver.ubuntu.com --recv-keys 8B8B57C1AA716FC2

Add Skychart unstable repository:2.

sudo sh -c "echo deb http://www.ap-i.net/apt unstable main >
/etc/apt/sources.list.d/skychart.list"

Update repository:3.

sudo apt-get update

Install CCDciel:4.

sudo apt-get install ccdciel

See also the list of the optional dependencies to install to take full advantage of the software.

Specific instruction for DSLR

To open DSLR raw files you need the library libpasraw to interface with LibRaw.
Unfortunately the LibRaw programming interface is not stable across LibRaw version, so libpasraw must be build
specifically for your system or it not work.

For Ubuntu you can simply install libpasraw from this PPA:
https://launchpad.net/~pch/+archive/ubuntu/ppa-skychart
then install with sudo apt-get install libpasraw

For a few other system you can find a package at:
https://github.com/pchev/libpasraw/releases

For other system you need to compile and install libpasraw from source after installing the libraw-dev package.
See https://github.com/pchev/libpasraw/blob/master/README.md

As a last resort you can install the libraw-bin or dcraw package, but this is less performant as it need to work
with temporary files.

https://www.ap-i.net/skychart
https://launchpad.net/~pch/+archive/ubuntu/ppa-skychart
https://github.com/pchev/libpasraw/releases
https://github.com/pchev/libpasraw/blob/master/README.md
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Installation on Linux

If your Linux system use deb packages,see Installation on Ubuntu, Debian.

On Fedora you can use ccdciel, qt5pas and libpasastro packaged with the system.

On Gentoo Linux use the overlay available here: https://github.com/jamesbates/gentoo-overlay

For other Linux system you can download rpm or tar packages from the Sourceforge download link.

The requirement are Qt5, LibQt5Pas and libpasastro.

See also the list of dependencies to install to take full advantage of the software.

You can also compile the source code using Lazarus.

Specific instruction for DSLR

To open DSLR raw files you need the library libpasraw to interface with LibRaw.
Unfortunately the LibRaw programming interface is not stable across LibRaw version, so libpasraw must be build
specifically for your system or it not work.

For Ubuntu you can simply install libpasraw from this PPA:
https://launchpad.net/~pch/+archive/ubuntu/ppa-skychart

For a few other system you can find a package at:
https://github.com/pchev/libpasraw/releases

For other system you need to compile and install libpasraw from source after installing the libraw-dev package.
See https://github.com/pchev/libpasraw/blob/master/README.md

As a last resort you can install the libraw-bin or dcraw package, but this is less performant as it need to work
with temporary files.

https://github.com/jamesbates/gentoo-overlay
http://sourceforge.net/projects/ccdciel/files/
https://github.com/pchev/libpasastro
https://github.com/pchev/ccdciel
http://www.lazarus-ide.org/index.php
https://launchpad.net/~pch/+archive/ubuntu/ppa-skychart
https://github.com/pchev/libpasraw/releases
https://github.com/pchev/libpasraw/blob/master/README.md
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Installation on Windows

CCDciel can run on any current version of Windows. The oldest supported version is Windows 10.

The CCDciel installer is available in 32bit and 64bit. The 64bit version is recommended, install the 32bit version
only if you need an old ASCOM driver that only work in 32bit.

To use the devices connected to your Windows computer you need the latest ASCOM platform and the most
recent drivers for your hardware.

But you can also use the devices connected to a remote Alpaca, or a remote Linux system (a Raspberry PI for
example) using the INDI protocol.

You can download the setup installer from the Sourceforge download link.

See also the list of the optional dependencies to install to take full advantage of the software.

A very important point when using Windows astronomy software is to
NEVER run anything as administrator
this is the source of many issue when accessing shared resources like a ASCOM driver. No current software
need that despite the popularity of this false advice in astronomy forum.

http://ascom-standards.org/
http://sourceforge.net/projects/ccdciel/files/
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Installation on macOS

CCDciel can run on a recent version of macOS, the minimal version required to run the program is 10.14 Mojave
for x86_64, 11.0 Big Sure for arm64.

You can download the CCDciel dmg installer from the Sourceforge download link.
Select the version macos-x86_64 for a Mac with an Intel processor.
Select the version macos-arm64 for a Mac with Apple silicon.

IMPORTANT
After download open a Terminal, change to the Download directory and run the following command:

xattr -cr ccdciel*.dmg

Open the dmg file and run the installer.

See also the list of the optional dependencies to install to take full advantage of the software.

There is a security prompt when CCDciel attempt a network connection for the first time, for example to get a
list of devices from a INDI server, you need to allow it.

http://sourceforge.net/projects/ccdciel/files/
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Install Hyperleda database

From the right click menu you can draw an overlay with the position and name of the objects in the image.
By default CCDciel use a database of 30'000 objects, if you need more faint objects you can install the
Hyperleda database with more than 5 million objects.

Because of it's size this database is not include with the program and you have to install it once.
You can find the installer for your system (.exe, .dmg, .deb or .rpm) here:

https://sourceforge.net/projects/ccdciel/files/hyperleda/

If you do a custom install the file must be in ccdciel/data/dso/

https://www.ap-i.net/ccdciel/_detail/en/documentation/hyperleda.png?id=en%3Adocumentation%3Ahyperleda_database
https://sourceforge.net/projects/ccdciel/files/hyperleda/
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ASCOM

ASCOM Platform is the standard astronomical equipment driver for Windows.

Install the latest ASCOM platform and the drivers you need from
http://ascom-standards.org/Downloads/Index.htm or from your equipment manufacturer.

With Alpaca you can use the device remotely, from another Windows computer, or from a computer running
Linux or macOS. To get started install the ASCOM Remote Server on the Windows computer where the devices
are connected.

A very important point when using Windows astronomy software is to
NEVER run anything as administrator
this is the source of many issue when accessing shared resources like a ASCOM driver. No current software
need that despite the popularity of this false advice in astronomy forum.

http://ascom-standards.org
http://ascom-standards.org/Downloads/Index.htm
https://www.ascom-alpaca.org/
https://github.com/ASCOMInitiative/ASCOMRemote/releases
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INDI

INDI Library is the standard astronomical equipment driver for Linux and macOS.

Linux

You can install INDI with the packages provided by your Linux distribution, but as this is a rapidly moving project
it is best to get the latest version directly from the project.
For example for Debian/Ubuntu see https://launchpad.net/~mutlaqja/+archive/ubuntu/ppa
It is also easy to build INDI from source. You can get the script I use myself:build_indi.sh. Be sure to install the
prerequisites and add the drivers you need in the setup section at the beginning of the script.

macOS

INDIWebManager and INDIStarter distribution include the INDI server and the drivers.

Install INDIWebManager from: https://github.com/rlancaste/INDIWebManagerApp/releases
or
Install INDIStarter from: https://sourceforge.net/projects/indistarter/files/

Windows

There is no INDI server for Windows but you can run CCDciel on Windows to connect to a INDI server running on
a remote computer, a Raspberry Pi for example.

Additional utilities

You can use IndiStarter to help to manage the INDI server and the drivers.
Download for Linux and macOS are available from https://sourceforge.net/projects/indistarter/files/

If you use a EQmod mount it can be useful to install EQmodGUI to easily control the main options. This also give
you a virtual handpad to move the mount.
Download for Linux and macOS are available from https://sourceforge.net/projects/eqmodgui/files/

The Indigo server variant may work by using the INDI protocol compatibility but is untested.

http://www.indilib.org/
http://www.indilib.org/devices/
http://www.indilib.org/download.html
https://launchpad.net/~mutlaqja/+archive/ubuntu/ppa
https://raw.githubusercontent.com/pchev/ccdciel/master/scripts/indi/build_indi.sh
https://www.indilib.org/support/tutorials/162-indi-web-manager.html
https://github.com/pchev/indistarter/wiki
https://github.com/rlancaste/INDIWebManagerApp/releases
https://sourceforge.net/projects/indistarter/files/
https://github.com/pchev/indistarter/wiki
https://sourceforge.net/projects/indistarter/files/
https://github.com/pchev/eqmodgui
https://sourceforge.net/projects/eqmodgui/files/
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Install Python

CCDciel include a Python scripting interface.

For simple script it is sufficient to use the default Python included with Linux or installed by CCDciel on Windows.
In this case you can ignore the end of this page..

But if you use a Mac or want a more advanced usage that need to install specific astronomy modules, you can
follow the instructions below

Windows

Download the Python installer from https://www.python.org/downloads/windows
Get the last stable installer corresponding to your system, for example Windows installer (64-bit)
Run the downloaded installer and click on “Install Now”, follow the next steps to the end.

Open a command line prompt to use pip to install the additional modules you need.
For example:

py -m pip install astropy astroplan matplotlib numpy requests pyserial tk

In CCDciel preference change the Python command to py.exe

https://www.python.org/downloads/windows
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macOS

Old Mac version used to provide a Python version 2, this is not suitable for our use. New macOS do not provide
anything. In all case you need to install Python 3 as describe below.

Download the Python installer from https://www.python.org/downloads/macos, Get the last stable
universal installer.
Open the downloaded installer, follow the steps to the end.
Open a command line prompt to create a virtual environment:

python3 -m venv ~/.venvs/astro

Activate the environment:

source ~/.venvs/astro/bin/activate

From the same activated shell install the modules you need:

pip3 install astropy astroplan matplotlib numpy pyserial tk

In CCDciel preference change the Python command to:
/Users/{username}/.venvs/astro/bin/python3

Linux

On Linux Python and many modules are already installed with the system.
If you want more, the best is to create a virtual environment to install the additional modules.

Create the virtual environment:

python3 -m venv ~/.venvs/astro

Activate the environment:

source ~/.venvs/astro/bin/activate

From the same activated shell install the modules you need:

pip3 install astropy astroplan matplotlib numpy pyserial tk

In CCDciel preference change the Python command to:
/home/{username}/.venvs/astro/bin/python3

https://www.python.org/downloads/macos
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ASTAP

ASTAP, the Astrometric STAcking Program, astrometric solver and FITS viewer, is a free stacking and plate
solver program for deep sky images. The plate solving capabilities can be accessed by CCDCIEL

ASTAP runs natively on Windows, Linux (i386 and amd64), Raspberry PI (armhf and arm64) and MacOS. It will
require about 500 MB disk space.

Installation instructions and information is available at:
http://www.hnsky.org/astap.htm
For plate solving you have to install both the program and the “G17 star database”.

Then configure the program path in CCDciel. For windows this is typical c:\Program Files\astap . For Linux this is
typical /opt/astap . For MacOS use /Applications/astap.app/Contents/MacOS .

Two ASTAP settings are accessible in CCDciel:

Radius search: Search radius in degrees. If there is no match, the program will move the search field
around in a square spiral and increasing the distance from the initial position up to the radius specified. A
radius of 30 degrees could be searched in a few minutes. Blind solving is possible by setting this option
above 180 degrees. Scanning the whole sky can be achieved in typical 380 seconds but in most cases
offset shall be much shorter and solving much quicker.
Binning: For large images (>3000 pixels wide) it is beneficial to set binning to reduce image size and
increase signal to noise ratio prior to plate solving. If your image is around 4000 pixels wide set this
binning to 2. If your image is 5000 pixels wide set this option to 2 or 3.

In MS-Windows, the execution of the ASTAP solver will be shown by a small ASTAP tray icon on the right side of
the status bar. If you move the mouse to the ASTAP tray icon, the hint will show the search radius reached.

If the search spiral has reached a distance more of then 2 degrees from the the start position then an ASTAP
popup notifier will show the actual search distance and solver settings. Clarifications are given at the ASTAP
webpage.

Tray icons are default off in the latest Win10 version. To set the ASTAP tray icon on, start a solve in CCDCIEL, go
to Windows “Settings”, “Taskbar”, “Turn system icons on or off” and set the ASTAP tray icon permanent
“on”

Images will require a minimum of about 30 focused stars up to more then 1000 stars. Exposure time as short as
5 or 10 seconds will be in most cases sufficient. Oval stars due to tracking errors or severe optical distortion will
be ignored and solving could fail. If you have small amount of stars in the image, you could activate in ASTAP
the option “small steps” for more reliable stacking. That is normally not required.

In case the plate solving fails a more detailed log is available in ASTAP for fault finding. Execute the ASTAP
program manually and test the plate solving by loading an image in ASTAP. Open the “Stack” menu (ctrl+A),
open the “Alignment” tab and have a look to section “ASTROMETRIC settings.”. You can set the maximum
number of stars (500) and tolerance (0.005). Exit the program via menu file, exit will save these settings.

More information is available at ASTAP documentation

http://www.hnsky.org/astap.htm
http://www.hnsky.org/astap.htm#astrometric_alignment
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Astrometry.net

Astrometry.net can be used to solve the image you just take with your camera. Astrometric solving will give the
exact astronomical position of the image center, its orientation and size.

CCDciel requires a local copy of the Astrometry.net software including the indexes on your computer. It can also
run Astrometry.net on a remote host using the provided script.

At page http://astrometry.net/use.html you can find detailed instructions how to install the software and
indexes.

Linux

On Linux astrometry.net is probably packaged by your distribution. This is the easiest and preferred way to
install the software.
For example on Debian or Ubuntu just do:

 sudo apt-get install astrometry.net

Then to install some indexes:

 sudo apt-get install astrometry-data-2mass-08-19 astrometry-data-2mass-07

macOS

For macOS a good solution is to install astrometry.net using Homebrew.
Follow the instructions to install Homebrew itself.
Then to install astrometry.net type the following in a terminal:

brew install astrometry-net

To install the indexes you need in a directory in your Documents folder run in a terminal:

mkdir Documents/astrometry
cd Documents/astrometry
curl -O http://broiler.astrometry.net/~dstn/4200/index-42[08-19].fits

Repeat with “index-4207-[00-11].fits” if you need more indexes.
Next edit the file /usr/local/etc/astrometry.cfg, search a line that begin with “add_path” and replace the path by
“/Users/[your user name]/Documents/astrometry”.
In the CCDciel Preferences at the astrometry tab, enter /usr/local/bin in the field “command path”.

Another option if you already have astrometry.net packaged with another application is to use the custom script
option.
In the CCDciel Preferences at the astrometry tab:

Check Use custom script
Enter the script name: /Applications/CCDciel/scripts/astrometry-macos.sh
You can modify the script to set the application path, by default it is /Applications/Astrometry.app

http://astrometry.net/use.html
https://brew.sh/
https://brew.sh/#install
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Windows

A number of Windows package include a fully automated install of Cygwin and astrometry.net and it is best to
get one of them. CCDciel do not use this applications but the astrometry.net they install. Cygwin is a tool
required to run a compiled version of Astrometry.net under Windows.

The following list indicate tested application and give the Cygwin path you must configure in the astrometry
preferences.
At the time of writing all these application use the same 2010 version 0.38 of Astrometry.net.

ANSVR, set Cygwin path to C:\Users\[your user name]\AppData\Local\cygwin_ansvr
Install up to step 10 as indicated in the web based instruction.
Astrotortilla, set Cygwin path to C:\cygwin
All sky plate solver, set Cygwin path to C:\Users\[your user name]\AppData\Local\Astrometry
Windows subsystem for Linux, let you use a more recent version of astrometry.net but it require you
install the 64 bits version of CCdciel.

https://adgsoftware.com/ansvr/
https://sourceforge.net/projects/astrotortilla/
http://www.astrogb.com/astrogb/All_Sky_Plate_Solver.html
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Windows subsystem for Linux

With Windows 10 or 11 64bit you can also install the Windows subsystem for Linux. This let you use a more
recent version of astrometry.net, the same as with Ubuntu or another available distribution.

But this require a 64 bits build of CCDciel because the Linux environment cannot be initialized from a 32 bits
program.
If you want to try the instruction below you have to install the 64bit version of CCDciel first.
You must be sure all your ASCOM drivers work with a 64bit application.

Follow the instructions to activate the Windows subsystem for Linux on your computer and install the Ubuntu
variant.

After the installation is complete, open the Ubuntu window to execute the following Linux commands:

First you need to update the list of packages:

sudo apt update

Then upgrade the libraries to the latest version:

sudo apt upgrade

Finally install astrometry.net:

sudo apt install astrometry.net

Download the index files depending on your image scale, for example down to 16 arc minutes you need the
indexes 06, 07, 08-19.

sudo apt install astrometry-data-2mass-06 astrometry-data-2mass-07
sudo apt install astrometry-data-2mass-08-19

Alternatively you can also use the index that are already installed on the Windows system by editing the
configuration file:

sudo nano /etc/astrometry.cfg

For example to use the index installed by Astrotortilla in C:\cygwin\usr\share\astrometry\data add a row:

add_path /mnt/c/cygwin/usr/share/astrometry/data

You must let the Cygwin path blank in the astrometry preferences so CCDciel use the wsl.exe command to run
the solver.

https://learn.microsoft.com/en-us/windows/wsl/
https://learn.microsoft.com/en-us/windows/wsl/install
http://astrometry.net/doc/readme.html
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ELBRUS

Elbrus star locator can be used to solve the image you just take with your camera.

Look at the program page for instruction http://www.astrosurf.com/pulgar/elbrus/elbrusin.htm

Before you can use it the Elbrus program must be calibrated for your images. Then select File / E-Wait for
message.

Also be sure to set the parameter: “Add the WCS in the FITS header”.

This is a Windows only software but I find it easy to install and use on Linux with Wine.
On the astrometry preference you can set both the DOS and Unix path to the image data to help with this use.

To install Wine on Linux or macOS see Wine web pages.

On Linux the best way is to install the wine packages provided by your distribution.

http://www.astrosurf.com/pulgar/elbrus/elbrusin.htm
https://www.winehq.org/
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PlateSolve 2

PlateSolve 2 can be used to solve the image you just taken with your camera. Astrometric solving wil give the
exact astronomical position of the image center, its orientation and size.

Look at the program page for instruction http://planewave.com/downloads/software/

Download and install the program and download and extract on of the two available star catalogs e.g. the
UCAC3 in a sub folder. Configure the star catalog in the PlateSolve2 program. Then configure the program path
in CCDciel.

You could test its operation manually by loading an image in PlateSolve2. It requires an position and image
dimensions if not contained in the image header.

Linux and Mac

This is a Windows only software but it run on Linux with Wine.

Use winetricks to install the required VB6 dependency:

winetricks vb6run

To install Wine on Linux or macOS see Wine web pages.

On Linux the best way is to install the wine packages provided by your distribution.

http://planewave.com/downloads/software/
https://www.winehq.org/
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Apache reverse proxy

The Apache reverse proxy can be used to secure the connection when you access resources over the Internet.
This concern the CCDciel Status page and the ASCOM Remote devices.

You need a Apache web server running on a device accessible from the Internet, use the NAT configuration of
your Internet router to forward the port 443 to this device.

Setup a default SSL Apache configuration, setup Let's Encrypt to get a certificate,

CCDciel status page

Install the module proxy_http in your Apache web server and add the following to a SSL virtual host
configuration:

      <Proxy *>
              Require all granted
      </Proxy>
      <Location /ccdciel/>
           AuthName "protected area"
           AuthType Basic
           AuthUserfile /.../.htpasswd
           Require user myuser
           ProxyPass http://192.168.1.10:3277/
           ProxyPassReverse http://192.168.1.10:3277/
      </Location>

Where “/…/.htpasswd” is the password file, “myuser” a user name in this file, “192.168.1.10” the IP address of
the observatory computer running CCDciel.
Use the htpasswd command to generate the password file.
You can now access this page with the URL: https://myhome.server.dynamic.ip/ccdciel/ , give the password for
myuser … et voila.

ASCOM Remote Server

Use a configuration similar to above:

      <Location /api/>
           AuthName "protected area"
           AuthType Basic
           AuthUserfile /.../.htpasswd
           Require user myuser
           ProxyPass http://192.168.1.104:11111/api/
           ProxyPassReverse http://192.168.1.104:11111/api/
      </Location>

The password file and user is the same as above, “192.168.1.104” is the IP address of the computer running the
ASCOM Remote Server on port 11111.
To use this connection, setup the ASCOM remote protocol to https, the host to the IP of the web server, the port
to 443 and the user/password defined in the .htpasswd file.

The ASCOM remote password is stored in the CCDciel configuration in the .credential file. It is not stored in clear

https://httpd.apache.org/docs/2.4/en/ssl/ssl_howto.html
https://letsencrypt.org/
https://httpd.apache.org/
https://httpd.apache.org/docs/current/en/programs/htpasswd.html


CCDciel documentation

216

text but it is better if you protect this file in some way, for example: chmod 600. And most important do not
reuse the same password elsewhere.
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Compilation of the source code

CCDciel is written in Pascal language using the Lazarus IDE and can be compiled with the Free Pascal Compiler.
By following this steps you can compile, modify and debug the program from the Lazarus IDE.

Install the compiler and IDE

You can download the last version of the IDE from:
https://www.lazarus-ide.org/index.php

For Windows a single setup install both the compiler and IDE. On Linux or Mac you need to install the three
packages for the compiler, the compiler source and the IDE.

Look also for any specific requirement for your platform. On Mac for example you must install the Xcode
command line tools first.

You can learn more in the Lazarus documentation
https://wiki.lazarus.freepascal.org/Lazarus_Documentation

Install CCDciel source code

The best solution to install the source code is using Git.
On Linux install the git package from your distribution.
On Windows install the program from https://git-scm.com/downloads

Open a command shell in the directory you want to install the source code and type:

git clone https://github.com/pchev/ccdciel.git

If you want to submit change to the source code later I suggest you start your own fork on Github instead. This
make very easy to submit pull request when need.

Install the required components

Before you can open the project in the IDE you must install the components used by CCDciel. You must skip this
step if you already install the packages for Cartes du Ciel.

Start the Lazarus IDE, select the menu Package / Open package file (.lpk)
Navigate to ccdciel/component/ and open the file ccdcielcomponents.lpk
Click the button Compile, wait it finish. Select Use / Install, validate and accept to rebuild the IDE.

After the IDE restart you are ready to use the CCDciel source code.

Compile CCDciel

Open the Lazarus IDE, select the menu Project / Open project…
Navigate to ccdciel/src/, open the file ccdciel.lpi
Select the menu Run / Compile

You can change the compilation option using the “Build mode” button. Most useful is to select Debug.

https://www.lazarus-ide.org/index.php
https://wiki.lazarus.freepascal.org/Lazarus_Documentation
https://git-scm.com/downloads
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Running and debugging the program

Before to run the program from the IDE you must tell it where it will find the required data files.
This suppose you also install the latest package for the program executable.
Select the menu Run / Run Parameters
In the field “Working directory” type the following depending on the system:
- Windows : C:\Program Files\CCDciel
- Mac: /Applications/CCDciel
- Linux: /usr/bin

Then select the menu Run / Run

Automatic build and packages creation

The program can also be compiled and build automatically using the scripts in the main directory.

Compilation can be done with ./configure + make. See the build*.sh scripts for more information.
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Documentation index

Tutorial

Start by this tutorial to quickly get an idea how the program work.

The program screen
Connecting the equipment
Global configuration
Focusing
Simple capture
Plate solving
Automated sequence
Video tutorial
FAQ

Reference Manual

This give detailed information on every program aspect. The pages follow the order of the main menu.

Menu File
Menu Edit with the devices and preferences setting
Menu Tools
Menu Image same as the image right click menu
Menu Display to show the different tool box
Menu Help
Status bar
CCDciel status web page.
Scripting
JSON-RPC interface for Python and other software.
Pascal interface for Pascal scripting.
Command line options
Image preprocessing

Installation

To install the software look at the page corresponding to your computer.

Installation on Ubuntu, Debian
Installation on Linux
Installation on Windows
Installation on macOS
Installation of Hyperleda database (all computer)
Compilation of the source code
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External dependencies

You must install this softwares to take full advantage of CCDciel, at least one in each category:

Equipment driver
ASCOM or INDI

Plate solving
ASTAP
Astrometry.net
Star Locator Elbrus
PlateSolve 2

Auto-guider
PHD2 or Lin_guider

Planetarium
Cartes du Ciel
Hallo Northern SKY, need a version more recent than 4.1.5

Image preprocessing
Siril

Python scripting
Install Python for extended scripting capabilities

Credit

Tools

CCDciel make use of the following development tools:

Free Pascal compiler
Lazarus IDE and library
BGRABitmap component
Synapse library
WCSTools library
LibRaw library

Developer

Patrick Chevalley
Han Kleijn

The source code is available from GitHub

License

Copyright (C) 2015-2025 Patrick Chevalley, http://www.ap-i.net/ccdciel
This program is free software; you can redistribute it and/or modify it under
the terms of the GNU General Public License as published by the Free Software
Foundation; either version 3 of the License, or (at your option) any later version.

https://www.gnu.org/licenses/gpl.html

https://openphdguiding.org/
https://sourceforge.net/projects/linguider/
https://www.ap-i.net/skychart/fr/start
http://www.hnsky.org/software.htm
https://www.siril.org
https://www.freepascal.org/
http://www.lazarus-ide.org
http://wiki.freepascal.org/BGRABitmap
https://www.ararat.cz/synapse
http://tdc-www.harvard.edu/wcstools/
https://www.libraw.org/
https://github.com/pchev/ccdciel
https://www.gnu.org/licenses/gpl.html
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